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BrightAuthor is a software application that allows you to create and publish digital-signage presentations for BrightSign players. You can play
BrightAuthor presentations on all BrightSign models. Your presentations can include various types of content:

Images

Videos

Live video: Supported on the XD1230, XD1132, 4K1142, and XT1143

Audio

HTML5 pages

IP Streaming audio/video

Text

Date and time

RSS, MRSS, and Twitter feeds

BrightSign Network features: Dynamic Playlists, Live Data feeds (RSS), Live Media feeds (MRSS)

SignChannel

What Types of Presentation Can I Create?

You can create three types of presentation in BrightAuthor:

Non-Interactive: A playlist of media (images, video, audio) that plays in a continuous loop. You can play non-interactive presentations on
all BrightSign models.

Interactive: A presentation that transitions between media based on input from a user via button board, touchscreen, remote control, or
similar input device. All models support at least one type of interactive event. The event types supported by a player model depend on
the connectors and inputs that player has (for example, players with a USB port support touch screen and button board events, and
players with an Ethernet port support UDP events).

BrightWall™: A non-interactive playlist of media (video files or live video) that is closely synchronized across multiple players. BrightWall
presentations are ideal for video-wall applications.

What Types of Screen Layout Can I Use?

You can choose from a variety of ready-to-use layout templates. You can also create your own template. Layout templates fall into two basic
categories:

Full Screen: The media (images, video, HTML) occupies the entire screen (this can be used for audio-only presentations as well).

Multi-Zone: The presentation contains content in separate regions of the screen. The screen can include multiple Clock, Text, Ticker, and
Images zones, as well as (depending on the player model) multiple Video Only zones.

 

 

Requirements

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

To create presentations with BrightAuthor and publish them to your player, you will need the following:

Windows PC

BrightSign player

Display

Note
A subscription is required to use SignChannel. Go to  for details.http://www.signchannel.com/

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
http://www.signchannel.com/


Storage device

Card reader/writer (optional if using USB storage)

Input device (optional)

 

Windows PC – Any Windows PC that meets or exceeds the following  requirements:minimum 

2.3 GHz CPU

2 GB RAM required (4 GB recommended)

100 MB available hard disk space for program files (additional disk space required if storing content and/or presentations on your hard
disk)

One of the following operating systems:

Windows Vista (32 or 64 bit)

Windows 7 (32 or 64 bit)

Windows 8 (32 or 64 bit)

Windows 10 (32 or 64 bit)
 

BrightSign Player – Any of the following models:

XT243, XT1143

4K242, 4K1042, 4K1142

XD233, XD1033

XD232, XD1032, XD1132

XD230, XD1030, XD1230

HD223, HD1023

HD222, HD1022

HD120, HD220, HD1020, HD970, AU320

LS423

LS322, LS422
 

Display – Any monitor, TV, or touchscreen with one of the following types of inputs:

HDMI

VGA (on all model lines except 4Kx42)

Component (supported with a VGA converter on all model lines except 4Kx42)
 

Storage Device – Any of the following:

microSD card (for XTx43, XDx33, HDx23, LS423 models) or SD card (for all other models)

USB Flash Drive (supported on models with a USB port)

SSD (XTx43, XDx33 models only)

mSATA drive (4K models only)

 

Card Reader/Writer – Only required if using an SD card. The card reader/writer must be connected to your PC and must be compatible with your
storage card.
 

Input Device – Required for interactive presentations only. Depending on the model, BrightSign players support one or more of the following
types of input device:

Touchscreen equipped with a supported touch controller. See this   for a list of all supported touch controllers. link

BrightSign   USB button panels BP200 and BP900

Many brands of USB keyboards 

Many brands of USB mice or trackballs 

Many brands of USB bar code scanners

Quadravox Serial Button Board

AMX, Crestron, and similar control devices

Any GPIO (open/close contact switch) button, signal, or LED (your custom board or LED display)

We recommend formatting your storage device using FAT32. Formatting your card using NTFS allows you to play media files that are
4GB or larger in size, but the player will not be able to receive network updates or generate logs.

http://support.brightsign.biz/entries/262256-whattouchscreens-can-i-use-with-the-brightsign
https://www.brightsign.biz/digital-signage-products/accessories/usb-4-buttons-panels
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PC (via UDP or serial)

IR input/output devices using the NEC or Pronto Hex remote control protocols.

Getting Started
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Previous Versions 

ON THIS PAGE

Step 1: Install BrightAuthor

Step 2: Launch BrightAuthor

Step 3: Set up your BrightSign player

Step 4: Add your Content

Step 5: Create your Presentations

Step 6: Publish your Presentations

If you're new to BrightAuthor, follow the below steps to get started.

STEP 1: INSTALL BRIGHTAUTHOR

Download the latest software and install it on your PC:

Go to the  page.BrightSign Downloads

Locate the model series of your player.

Click the link to download the current official release of BrightAuthor. To download a beta release (if there currently is one),BrightAuthor 
click the  link and select the   of BrightAuthor.More Downloads Beta Release
Unzip the contents of the downloaded file..zip 

Double-click the setup  file to begin the installation..exe

Follow the onscreen instructions to install BrightAuthor on your PC.

STEP 2: LAUNCH BRIGHTAUTHOR

Double-click the icon on your desktop.BrightAuthor 
(Optional) If prompted, sign in to BrightSign Network (account required). See the  for moreBrightSign Network publishing instructions
details.

STEP 3: SET UP YOUR BRIGHTSIGN PLAYER

Depending on how you want to publish your presentations, create the  for your BrightSign player.appropriate setup files

Insert an SD card or USB flash drive containing the setup files into the player.

Connect your player to a display and power it on.

STEP 4: ADD YOUR CONTENT

BrightAuthor presentations can include video, audio, image, and HTML files. See the following links to learn more about supported content types:

Video: Supported formats, codecs, bitrates, etc.

Audio: Supported formats, sampling rates, etc.

Images: Supported formats

HTML: Developer's guide

Tip
View this  to get an overview of using BrightAuthor.tutorial video

Note
BrightAuthor requires the latest version of Microsoft .Net Framework. If this component is not already on your PC, BrightAuthor installs it
during the installation. However, if BrightAuthor needs to install Microsoft .Net Framework, the installation may take up to 45 minutes to
complete and you may need to restart your PC to complete the installation process.

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
http://www.brightsign.biz/downloads/overview/
http://support.brightsign.biz/entries/143091-What-video-formats-and-codecs-do-BrightSign-players-support-
http://support.brightsign.biz/entries/143768-What-audio-formats-do-BrightSign-players-support-
http://support.brightsign.biz/entries/143089-What-image-formats-do-BrightSign-players-support-
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
http://docs.brightsign.biz/display/DOC/HTML5+Development
http://brightsignbiz.s3.amazonaws.com/videos/step-by-step/Training%202.1%20Player%20Basics.mp4?custom=true&width=520&height=330
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STEP 5: CREATE YOUR PRESENTATIONS

Now you’re ready to start using BrightAuthor to create presentations. To get started, create a . You can then go onsimple full-screen presentation
to create more complex  and  presentations.multi-zone interactive

STEP 6: PUBLISH YOUR PRESENTATIONS

After creating presentations, use one of the  to deliver them to your BrightSign players. publishing options

 

Setting up BrightSign Players

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

Before you can publish presentations, you must first set up your BrightSign player(s). Follow these steps to set up a player:

Navigate to .Tools > Setup BrightSign Unit
Configure your unit for one of the four publishing options described below.

Save the setup files to a storage device (SD card or USB flash drive).

Insert the storage device into the BrightSign player and power it up. 

Once the storage device is inserted, your BrightSign player is ready to receive and play presentations.

PUBLISHING OPTIONS

There are four publishing options, depending on how you want to publish presentations to your players:

BrightSign Network: Use the  cloud-based content-management system (CMS) to remotely schedule presentations,BrightSign Network
distribute content, assign players to groups, and monitor the health of players.

Local File Networking: Publish presentations and schedules to players over your local network.

Simple File Networking: Publish presentations and schedules remotely using your own web server.

Standalone: Publish presentations directly to your player using an SD card or USB drive. Use this method if your player doesn’t have a
network connection or if you do not plan to update the presentation frequently.

If you’re using the BrightSign Network, Local Networking, or Simple File Networking to publish your presentations, you must connect your
player(s) to the local network via Ethernet or WiFi. Alternatively, you can set up players for use as standalone units that are not connected to a
network. With this option, you will need to manually update the player storage (SD card or USB flash drive) each time you want to update
presentations. For more details on the publishing process, see the   section.Publishing Presentations

 

BrightSign Network Setup

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

Note
The storage device  during playback—BrightSign players have no internal storage and, therefore, cannotmust remain inside the player 
download or play content without a storage device connected.

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
https://www.brightsign.biz/digital-signage-products/brightsign-network
http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
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Wired/Wireless

Diagnostics

Firmware

Splash Screen

Unit Configuration

Beacons

Logging

Remote Snapshot

RF Channel Scan Data (optional)

Screen Color

Creating and Installing the Setup Files

You must have a BrightSign Network Account to set up players for the BrightSign Network (BSN). Contact  or your BrightSignBrightSign Sales
vendor to purchase BSN subscriptions.

Sign in to BSN

To create BrightSign Network setup files, you must first sign in to BSN in BrightAuthor. Once you have your BSN account credentials, follow these
steps:

Navigate to > . If you don't see this option, navigate to Edit > Preferences > Networking and checkTools  Sign In to BrightSign Network
the  box.Enable BrightSign Network 
Enter your and .Account, User name, Password
(Optional) Check the box if you don't want to perform these steps every time you openRemember account and user name 
BrightAuthor.

Click .Sign In
Navigate to  > .Tools Setup BrightSign Unit

Tip
This  outlines the basic steps for setting up a player for the BrightSign Network.tutorial video

http://brightsignbiz.s3.amazonaws.com/videos/09_setup_brightsign_network.mp4


Name Specification

Name: Enter a name for the player.

Description:(Optional) Enter a description for the player.

Customization: Select one of the following:

Append unit ID: Appends the serial number of the player to the end of the player name.

Use name only: Does not append anything to the player name.

Network Properties

Enable Wireless: Check this box to connect the player to the local network using a wireless connection. In order to use a wireless
connection, you must purchase a  for your BrightSign player. If the player is connecting to a secured network, enter theWireless Module
following:

SSID: Enter the SSID of the wireless network.

Security key: Enter the password for the wireless network.

Network Connection Priority: Use the up and down arrows to prioritize either the Wired or Wireless connection. The BrightSign player
will always attempt to download and upload using the first option, and will only use the second option if the first is unavailable.

Time zone: Select the time zone where the player is located.

Time server:(Optional) Specify the server (and protocol) that the player should use to synchronize its clock. Players use the BrightSign
Network time server by default.

Advanced Network Setup

Click the  button to customize advanced settings for your networked player.Advanced Network Setup

Unit Configuration

Use the tab to specify the following:Unit Configuration 

Specify hostname: Check this box to specify a custom hostname for the player on the network. By default, the player serial number is
used to generate a unique hostname.

Use Proxy: Check this box if you want the player to use a proxy server.

Address: Enter the address of the proxy. If you need to provide a user name and password for the proxy, use this format: <user

https://www.brightsign.biz/digital-signage-products/accessories/wireless-module
http://support.brightsign.biz/entries/453495-How-do-I-change-the-Time-Server-NTP-HTTP-on-a-player-


name>:<password>@<proxy server address> (e.g. “admin:root@myproxy.com”).

Port: Enter the port number of the proxy.

Proxy Bypass: Use the button to add host names to the proxy bypass list. Host names that are checked will beAdd Host 
accessed directly, rather than using the specified proxy server. Entering a host name such as "example.com" will exempt
"example.com", "example.com:80", and "www.example.com" from the proxy setting. This feature includes bypass options for the 

 (content downloads, log uploads) and   (Dynamic Playlists, Live Media Feeds,BrightSign Network BrightSign Network Feeds
Live Text Feeds) by default.

Limit content downloads: Check this box to restrict player content downloads to a certain time of day. This is helpful if you want to limit
network traffic during peak hours.

Start of Range: The beginning of the time frame during which content downloads can occur.

End of Range: The end of the time frame during which content downloads can occur.

Limit health updates: Check this box to limit when the player sends health updates to the BrightSign Network. This is helpful if you know
a player will be powered off or otherwise disabled during a certain time of day.

Start of Range: The beginning of the time frame during which health updates can be sent.

End of Range: The end of the time frame during which health updates can be sent.

Copy content from the current published schedule: Check this box to copy the current scheduled presentation(s) of the group to the
storage device along with the setup files. Use this option if you don’t want the player downloading large content files from the BrightSign
Network right after it is set up.

Wired/Wireless

Use the and  tabs to specify the following:Wired Wireless

Data Types Enabled: Use these checkboxes to determine the data types that can be transferred using the connection. You can
enable/disable downloads ( , , ), as well as uploads ( , ).Content Text Feeds Media Feeds Health Log Updates
Connection Settings: Indicate whether the IP address is auto-generated (via DHCP) or static. If you’re using a static IP address, enter
the parameters in the fields.

Rate Limit Network Download Traffic: Set rate limitations for downloading content. The options are divided into three categories: Outsi
, , and . The "content download window"de content download window During content download window During initial downloads

described by the first two options corresponds to the interval set in the tab.Limit content downloads Unit Configuration 
Unlimited download rate: Sets no limit on downloads.

Default limit: Sets the default limit (2000 Kibit/s) on downloads.

Specify limit: Sets a customized limit. Enter a limit in the text field (in Kbit/s).

Diagnostics

Use the  tab to specify the following:Diagnostics

Enable network diagnostics: Check this box to have the player display the network diagnostics screen during setup.

Test Ethernet: The player will indicate whether or not it was able to attain an IP address over Ethernet.

Test Wireless: The player will indicate whether or not it was able to attain an IP address over wireless.

Test Internet Connection: The player will indicate whether or not it was able to communicate with a remote server.

Firmware

Click the  button to include a firmware update with the setup files. The firmware update will be performed after youSpecify Firmware Update
insert the storage device containing the setup files into the player and power it up. Locate the section corresponding to your BrightSign model and
select one of the following:

Production Release: The current official release of BrightSign firmware

Beta Release: The current beta release of BrightSign firmware

Minimum Compatible Release: The minimum firmware version that supports presentations created by your version of BrightAuthor. The
minimum compatible firmware will likely not support all features provided by a contemporary version of BrightAuthor.

Select specific file: Use the button to select a  firmware update file from your hard drive. The other options will downloadBrowse .bsfw
the update file from BrightSign when the setup files are created.

Splash Screen

Standard Splash Screen: The player will display the BrightSign logo when booting up.

Custom Splash Screen: The player will display a custom logo when booting up. Click  to locate and select the image you wishBrowse
to use. See  for image size and format restrictions.this FAQ

Unit Configuration

http://support.brightsign.biz/entries/95672357-How-do-I-use-a-custom-splash-screen-


Select the  option. Then configure the following:Networked with the BrightSign Network

Enable diagnostic web server:(Optional) Check this box to enable the . You can include a username andDiagnostic Web Server
password in the text fields below for added security.

Enable local web server:(Optional) Check this box to enable the . You can include a username and password in theLocal Web Server
text fields below for added security.

Enable Update Notifications:(Optional) Check this box to have the player automatically refresh the  whUser Variables webpage
enever variable values change on the player.

Group: Select this option to include the player in a standard BSN group. Use the dropdown list to select a BSN group for the player.
Groups allow you to publish presentation schedules to multiple players. See the   page for morePublishing with BrightSign Network
details.

BrightWall Group: Select this option to include the player in a BSN BrightWall group. Use the dropdown list to select a BrightWall group
for the player. Each BrightWall group includes one or more BrightWall(s) that share a common configuration file, and each BrightWall in a
BrightWall group plays the same presentation. 

BrightWall Name: Use the dropdown list to assign the player to a BrightWall within the BrightWall group. If you haven’t created
the BrightWall yet, click  and enter the . Note that a new BrightWall will utilize the configurationAdd BrightWall BrightWall name
file that is assigned to the BrightWall group.

Screen Number: Specify the section of the BrightWall to which the player belongs. Screens are
numbered by row, starting from the top-left section of the BrightWall (the example diagram to the
right shows the numbering of a 4x3 BrightWall).

Content Check Frequency: Specify how often the player should communicate with the BSN servers to
determine if there is new scheduled content to download.

Update Health Frequency: Specify how often the player should send health status updates to the BSN
servers. This determines how up-to-date the  are.Player Status colors

Beacons

This section allows you to configure BLE beaconing devices connected to the player.

Name: Enter a name for the beacon.

Type: Use the dropdown list to select the beaconing mode/format:

iBeacon: A simple beaconing format

UUID: A string representation of a UUID, which can be in 16-bit, 32-bit, or 128-bit format. A 16-bit UUID must be exactly
four hex digits with no punctuation;  a 32-bit UUID must be exactly eight hex digits with no punctuation; and a 128-bit
UUID must be punctuated exactly as follows: "cd7b6f81-f738-4cad-aebf-d2a2ea36d996".

Major: An integer specifying the 2-byte Major value (0 to 65535)

Minor: An integer specifying the 2-byte Minor value (0 to 65535)

TxPower: An integer value specifying the Tx power level in dBm at 0 meters. The default value is -19, which
corresponds to a level of -60dBm at 1 meter. The recommended calibration practice is to measure at 1 meter and add
41: For example, -65dBm RSSI leads to a value of -24.

Eddystone URL: The   formatEddystone-URL

URL: The URL to encapsulate in the advertisement packet. 

TxPower: An integer value specifying the Tx power level in dBm at 0 meters. The default value is -19, which
corresponds to a level of -60dBm at 1 meter. The recommended calibration practice is to measure at 1 meter and add
41: For example, -65dBm RSSI leads to a value of -24.

: The   formatEddystone UID Eddystone-UID

: A 6-byte value expressed as 12 hexadecimal digitsNamespace

: A 10-byte value expressed as 20 hexadecimal digitsInstance

: An integer value specifying the Tx power level in dBm at 0 meters. The default value is -19, whichTxPower
corresponds to a level of -60dBm at 1 meter. The recommended calibration practice is to measure at 1 meter and add
41: For example, -65dBm RSSI leads to a value of -24.

Logging

Use the check boxes to enable/disable logs and specify log upload settings. You can view logs in the  tab of the BSN WebUI or inCurrent Usage
the  folder on the player storage.currentLog

Enable playback logging: Records playback start and end times, zone names, media types, and file names.

Enable event logging: Records timestamps, state names, zone names, event types, and event data.

Tip
You can create BrightWall groups in the  section. Manage > Status

http://docs.brightsign.biz/display/DOC/Diagnostic+Web+Server
http://support.brightsign.biz/entries/21994646-What-do-the-status-colors-next-to-players-and-groups-mean-
https://github.com/google/eddystone/tree/master/eddystone-url
https://github.com/google/eddystone/tree/master/eddystone-uid
http://docs.brightsign.biz/display/DOC/Current+Usage+Tab
http://docs.brightsign.biz/display/DOC/Status#Status-creating_a_brightwall_group
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Enable state logging: Records current and last state names, timestamps, and media types.

Enable diagnostic logging: Records timestamps, firmware and script versions, and the current presentation.

Enable Variable logging: Records the current and default values of all  in the presentation. This log is only generatedUser Variables
when logs are uploaded to the BSN servers.

Upload logs: Check either of the following:

On startup: Uploads log files each time the player is powered on.

At specific time each day: Uploads log files daily at the specified time. Use the dropdown lists to pick a time.

Remote Snapshot

Check the  box to enable the Remote Snapshot feature, which allows you to remotely monitor the contents of theEnable remote snapshot
presentation display.

Remote snapshot every [ ] minutes: Specify how often the player should take a snapshot of the presentation display.

Save up to [ ] images (1 - 100) on local storage: Specify how many JPEG snapshot images can be stored on the local storage of the
player.

JPEG quality level [ ] (0 - 100): Specify the quality level (and thus the file size) of each image file.

Display snapshots in portrait mode: Check this box to have the player rotate the snapshots to portrait mode before saving and
uploading them.

RF Channel Scan Data (optional)

Use this field to publish  settings to an XD1230 player. This option is useful if you need to publish identical channel scan settingsRF channel scan
to multiple XD1230 players. See  for more details.Publishing Channel Scan Results

Screen Color

Click  to specify what screen color the player should display after it has successfully completed the setup process. When the playerChoose
displays this color, it is ready to receive content.

Creating and Installing the Setup Files

Now that you've configured the setup files, you need to publish them to your player:

Click .Create Setup Files
Browse to and select an SD card (recommended) or USB flash drive. Ensure the setup files are written to the of the storageroot folder 
device.

Click .OK
Turn off the BrightSign player by unplugging the power adapter (or Ethernet cable if the player is being powered by PoE).

Insert the SD card or USB flash drive into the player.

Turn on the BrightSign player  by reconnecting the power.

 

Local File Network Setup

Tip
See  to learn how to read player logs.this FAQ

Note
The Remote Snapshot feature is not available for the LS422, HD220, or HD1020.

Note
We recommend formatting your SD card or USB flash drive using FAT32. Formatting your card using NTFS allows you to play media
files that are 4GB or larger in size, but the player will not be able to receive network updates or generate logs.

Important
 The storage device must remain in the player at all times while playing presentations. 

http://docs.brightsign.biz/display/DOC/Advanced+Features#AdvancedFeatures-publishing_channel_scan_results
http://support.brightsign.biz/hc/en-us/articles/218067077-How-do-I-interpret-BrightSign-player-logs-
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Creating and Installing the Setup Files

Local File Networking allows you to publish presentations to your BrightSign player over the local network. To set up a player for Local File
Networking, navigate to Tools > Setup BrightSign Unit.

Name Specification

Tip
This  outlines the basic setups for setting up a player for Local File Networking.tutorial video

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
http://brightsignbiz.s3.amazonaws.com/videos/step-by-step/Training%203.2.3%20Local%20Network%20Setup.mp4?custom=true&width=520&height=330


Name: Enter a name for the player

Description:(Optional) Enter a description for the player.

Customization: Select one of the following:

Append unit ID: Appends the serial number of the player to the end of the player name.

Use name only: Does not append anything to the player name.

Network Properties

Enable Wireless: Check this box to connect the player to the local network using a wireless connection. In order to use a wireless
connection, you must purchase a  for your BrightSign player. If the player is connecting to a secured network, enter theWireless Module
following:

SSID: Enter the SSID of the wireless network.

Security key: Enter the password for the wireless network.

Network Connection Priority: Use the up and down arrows to prioritize either the  or connection. The BrightSign player Wired Wireless 
will always attempt to download and upload using the first option, and will only use the second option if the first is unavailable.

Time zone: Select the time zone where the player is located.

Time server:(Optional) Specify the server (and ) that the player should use to synchronize its clock. Players use the BrightSignprotocol
Network time server by default.

Advanced Network Setup

Click the  button to customize advanced settings for your networked player.Advanced Network Setup

Unit Configuration

Use the tab to specify the following:Unit Configuration 

Specify hostname: Check this box to specify a custom hostname for the player on the network. By default, the player serial number is
used to generate a unique hostname.

Use Proxy: Check this box if you want the player to use a proxy server.

Address: Enter the address of the proxy. If you need to provide a user name and password for the proxy, use this format: <user
name>:<password>@<proxy server address> (e.g. “admin:root@myproxy.com”).

Port: Enter the port number of the proxy.

Proxy Bypass: Use the  button to add host names to the proxy bypass list. Host names that are checked will beAdd Host 
accessed directly, rather than using the specified proxy server. Entering a host name such as "example.com" will exempt
"example.com", "example.com:80", and "www.example.com" from the proxy setting. This feature includes bypass options for the 

 (content downloads, log uploads) and   (Dynamic Playlists, Live Media Feeds,BrightSign Network BrightSign Network Feeds
Live Text Feeds) by default.

Wired/Wireless

Use the and  tabs to specify the following:Wired Wireless

Data Types Enabled: Use these checkboxes to determine the data types that can be transferred using the connection. You can
enable/disable downloads ( , , ), as well as uploads ( , ).Content Text Feeds Media Feeds Health Log Updates
Connection Settings: Indicate whether the IP address is auto-generated (via DHCP) or static. If you’re using a static IP address, enter
the parameters in the fields.

Diagnostics

Use the  tab to specify the following:Diagnostics

Enable network diagnostics: Check this box to have the player display the network diagnostics screen during setup.

Test Ethernet: The player will indicate whether or not it was able to attain an IP address over Ethernet.

Test Wireless: The player will indicate whether or not it was able to attain an IP address over wireless.

Test Internet Connection: The player will indicate whether or not it was able to communicate with a remote server.

Firmware

Click the  button to include a firmware update with the setup files. The firmware update will be performed after youSpecify Firmware Update
insert the storage device containing the setup files into the player and power it up. Locate the section corresponding to your BrightSign model and
select one of the following:

Production Release: The current official release of BrightSign firmware

https://www.brightsign.biz/digital-signage-products/accessories/wireless-module
http://support.brightsign.biz/entries/453495-How-do-I-change-the-Time-Server-NTP-HTTP-on-a-player-


Beta Release: The current beta release of BrightSign firmware

Minimum Compatible Release: The minimum firmware version that supports presentations created by your version of BrightAuthor. The
minimum compatible firmware will likely not support all features provided by a contemporary version of BrightAuthor.

Select specific file: Use the button to select a  firmware update file from your hard drive. The other options will downloadBrowse .bsfw
the update file from BrightSign when the setup files are created.

Splash Screen

Standard Splash Screen: The player will display the BrightSign logo when booting up.

Custom Splash Screen: The player will display a custom logo when booting up. Click  to locate and select the image you wishBrowse
to use. See  for image size and format restrictions.this FAQ

Unit Configuration

Select the  option. Then configure the following:Networked with Local File Networking

Enable diagnostic web server:(Optional) Check this box to enable the . You can include a username andDiagnostic Web Server
password in the text fields below for added security.

Enable local web server: This box must be checked to use Local File Networking. You can add a username and password in the text
fields below for added security.

Enable Update Notifications:(Optional) Check this box to have the player automatically refresh the  whUser Variables webpage
enever variable values change on the player.

Beacons

This section allows you to configure BLE beaconing devices connected to the player.

Name: Enter a name for the beacon.

Type: Use the dropdown list to select the beaconing mode/format:

iBeacon: A simple beaconing format

UUID: A string representation of a UUID, which can be in 16-bit, 32-bit, or 128-bit format. A 16-bit UUID must be exactly
four hex digits with no punctuation;  a 32-bit UUID must be exactly eight hex digits with no punctuation; and a 128-bit
UUID must be punctuated exactly as follows: "cd7b6f81-f738-4cad-aebf-d2a2ea36d996".

Major: An integer specifying the 2-byte Major value (0 to 65535)

Minor: An integer specifying the 2-byte Minor value (0 to 65535)

TxPower: An integer value specifying the Tx power level in dBm at 0 meters. The default value is -19, which
corresponds to a level of -60dBm at 1 meter. The recommended calibration practice is to measure at 1 meter and add
41: For example, -65dBm RSSI leads to a value of -24.

Eddystone URL: The   formatEddystone-URL

URL: The URL to encapsulate in the advertisement packet. 

TxPower: An integer value specifying the Tx power level in dBm at 0 meters. The default value is -19, which
corresponds to a level of -60dBm at 1 meter. The recommended calibration practice is to measure at 1 meter and add
41: For example, -65dBm RSSI leads to a value of -24.

: The   formatEddystone UID Eddystone-UID

: A 6-byte value expressed as 12 hexadecimal digitsNamespace
: A 10-byte value expressed as 20 hexadecimal digitsInstance
: An integer value specifying the Tx power level in dBm at 0 meters. The default value is -19, whichTxPower

corresponds to a level of -60dBm at 1 meter. The recommended calibration practice is to measure at 1 meter and add
41: For example, -65dBm RSSI leads to a value of -24.

Logging

Use the check boxes to enable/disable logs and specify log upload settings. You can view logs in the  folder on the player storage.currentLog

Enable playback logging: Records playback start and end times, zone names, media types, and file names.

Enable event logging: Records timestamps, state names, zone names, event types, and event data.

Enable state logging: Records current and last state names, timestamps, and media types.

Enable diagnostic logging: Records timestamps, firmware and script versions, and the current presentation.

Enable Variable logging: Records the current and default values of all  in the presentation. This log is only generatedUser Variables
when logs are uploaded to custom log handler URL.

Tip
See  to learn how to read player logs.this FAQ

http://support.brightsign.biz/entries/95672357-How-do-I-use-a-custom-splash-screen-
http://docs.brightsign.biz/display/DOC/Diagnostic+Web+Server
https://github.com/google/eddystone/tree/master/eddystone-url
https://github.com/google/eddystone/tree/master/eddystone-uid
http://support.brightsign.biz/hc/en-us/articles/218067077-How-do-I-interpret-BrightSign-player-logs-
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Remote Snapshot

Check the  box to enable the Remote Snapshot feature, which allows you to remotely monitor the contents of theEnable remote snapshot
presentation display.

Remote snapshot every [ ] minutes: Specify how often the player should take a snapshot of the presentation display.

Save up to [ ] images (1 - 100) on local storage: Specify how many JPEG snapshot images can be stored on the local storage of the
player.

JPEG quality level [ ] (0 - 100): Specify the quality level (and thus the file size) of each image file.

Display snapshots in portrait mode: Check this box to have the player rotate the snapshots to portrait mode before saving and
uploading them.

RF Channel Scan Data (optional)

Use this field to publish  settings to an XD1230 player. This option is useful if you need to publish identical channel scan settingsRF channel scan
to multiple XD1230 players. See  for more details.Publishing Channel Scan Results

Screen Color

Click  to specify what screen color the player should display after it has successfully completed the setup process. When the playerChoose
displays this color, it is ready to receive content.

Creating and Installing the Setup Files

Now that you've configured the setup files, you need to publish them to your player:

Click .Create Setup Files
Browse to and select an SD card (recommended) or USB flash drive. Ensure the setup files are written to the of the storageroot folder 
device.

Click .OK
Turn off the BrightSign player by unplugging the power adapter (or Ethernet cable if the player is being powered by PoE).

Insert the SD card or USB flash drive into the player.

Turn on the BrightSign player  by reconnecting the power.

Simple File Network Setup

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

Note
 The Remote Snapshot feature is not available for the LS422, HD220, or HD1020.

Note
We recommend formatting your SD card or USB flash drive using FAT32. Formatting your card using NTFS allows you to play media
files that are 4GB or larger in size, but the player will not be able to receive network updates or generate logs.

Important
The storage device must remain in the player at all times while playing presentations.

http://docs.brightsign.biz/display/DOC/Advanced+Features#AdvancedFeatures-publishing_channel_scan_results
http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting


ON THIS PAGE

Name Specification

Network Properties

Advanced Network Setup

Unit Configuration

Wired/Wireless

Diagnostics

Firmware

Splash Screen

Unit Configuration

Beacons

Logging

Remote Snapshot

RF Channel Scan Data (optional)

Screen Color

Creating and Installing the Setup Files

A player set up for Simple File Networking will retrieve content and schedule updates from your server at regular intervals. The setup files
generated here provide settings for your network and point the player to the web server that it will use for updates. To set up a player for Simple
File Networking, navigate to File > Setup BrightSign Unit.

Name Specification

Name: Enter a name for the player

Description:(Optional) Enter a description for the player.

Tip
This  outlines basic steps for setting up a player for Simple File Networking. video tutorial

http://brightsignbiz.s3.amazonaws.com/videos/15_Simple_File_Network.mp4


Customization: Select one of the following:

Append unit ID: Appends the serial number of the player to the end of the player name.

Use name only: Does not append anything to the player name.

Network Properties

Enable Wireless: Check this box to connect the player to the local network using a wireless connection. In order to use a wireless
connection, you must purchase a  for your BrightSign player. If the player is connecting to a secured network, enter theWireless Module
following:

SSID: Enter the SSID of the wireless network.

Security key: Enter the password for the wireless network

Network Connection Priority: Use the up and down arrows to prioritize either the  or connection. The BrightSign player Wired Wireless 
will always attempt to download and upload using the first option, and will only use the second option if the first is unavailable.

Time zone: Select the time zone where the player is located.

Time server:(Optional) Specify the server (and ) that the player should use to synchronize its clock. Players use the BrightSignprotocol
Network time server by default.

Advanced Network Setup

Click the  button to customize advanced settings for your networked player.Advanced Network Setup

Unit Configuration

Use the tab to specify the following:Unit Configuration 

Specify hostname: Check this box to specify a custom hostname for the player on the network. By default, the player serial number is
used to generate a unique hostname.

Use Proxy: Check this box if you want the player to use a proxy server.

Address: Enter the address of the proxy. If you need to provide a user name and password for the proxy, use this format: <user
name>:<password>@<proxy server address> (e.g. “admin:root@myproxy.com”).

Port: Enter the port number of the proxy.

Proxy Bypass: Use the  button to add host names to the proxy bypass list. Host names that are checked will beAdd Host 
accessed directly, rather than using the specified proxy server. Entering a host name such as "example.com" will exempt
"example.com", "example.com:80", and "www.example.com" from the proxy setting. This feature includes bypass options for the 

 (content downloads, log uploads) and   (Dynamic Playlists, Live Media Feeds,BrightSign Network BrightSign Network Feeds
Live Text Feeds) by default.

Limit content downloads: Check this box to restrict player content downloads to a certain time of day. This is helpful if you want to limit
network traffic during peak hours.

Start of Range: The beginning of the time frame during which content downloads can occur.

End of Range: The end of the time frame during which content downloads can occur.

Wired/Wireless

Use the and  tabs to specify the following:Wired Wireless

Data Types Enabled: Use these checkboxes to determine the data types that can be transferred using the connection. You can
enable/disable downloads ( , , ), as well as uploads ( , ).Content Text Feeds Media Feeds Health Log Updates
Connection Settings: Indicate whether the IP address is auto-generated (via DHCP) or static. If you’re using a static IP address, enter
the parameters in the fields.

Rate Limit Network Download Traffic: Set rate limitations for downloading content. The options are divided into three categories: Outsi
, , and . The "content download window"de content download window During content download window During initial downloads

described by the first two options corresponds to the interval set in the tab.Limit content downloads Unit Configuration 
Unlimited download rate: Sets no limit on downloads.

Default limit: Sets the default limit (2000 Kibit/s) on downloads.

Specify limit: Sets a customized limit. Enter a limit in the text field (in Kbit/s).

Diagnostics

Use the  tab to specify the following:Diagnostics

Enable network diagnostics: Check this box to have the player display the network diagnostics screen during setup.

Test Ethernet: The player will indicate whether or not it was able to attain an IP address over Ethernet.

Test Wireless: The player will indicate whether or not it was able to attain an IP address over wireless.

Test Internet Connection: The player will indicate whether or not it was able to communicate with a remote server.

https://www.brightsign.biz/digital-signage-products/accessories/wireless-module
http://support.brightsign.biz/entries/453495-How-do-I-change-the-Time-Server-NTP-HTTP-on-a-player-


Firmware

Click the  button to include a firmware update with the setup files. The firmware update will be performed after youSpecify Firmware Update
insert the storage device containing the setup files into the player and power it up. Locate the section corresponding to your BrightSign model and
select one of the following:

Production Release: The current official release of BrightSign firmware

Beta Release: The current beta release of BrightSign firmware

Minimum Compatible Release: The minimum firmware version that supports presentations created by your version of BrightAuthor. The
minimum compatible firmware will likely not support all features provided by a contemporary version of BrightAuthor.

Select specific file: Use the button to select a  firmware update file from your hard drive. The other options will downloadBrowse .bsfw
the update file from BrightSign when the setup files are created.

Splash Screen

Standard Splash Screen: The player will display the BrightSign logo when booting up.

Custom Splash Screen: The player will display a custom logo when booting up. Click  to locate and select the image you wishBrowse
to use. See  for image size and format restrictions.this FAQ

Unit Configuration

Select the  option. Then configure the following:Networked with Simple File Networking

Enable diagnostic web server:(Optional) Check this box to enable the . You can include a username andDiagnostic Web Server
password in the text fields below for added security.

Enable local web server:(Optional) Check this box to enable the . You can include a username and password in theLocal Web Server
text fields below for added security.

Enable Update Notifications:(Optional) Check this box to have the player automatically refresh the  whUser Variables webpage
enever variable values change on the player.

URL for the web folder: Specify the location from which the player will download content updates. Do not use trailing slashes in your
URL; some web servers do not support trailing slashes.

Content Check Frequency: Set how often you want the player to check your server for updates.

Simple File Networking Authentication:(Optional) Enter a and to enable digest authentication between theUser name password 
BrightSign player and the server.

Enable basic authentication: Check this box to have the player pass credentials to the web server in unsecured packets. Use
this option only if it is absolutely required by the configuration of your web server.

Beacons

This section allows you to configure BLE beaconing devices connected to the player.

Name: Enter a name for the beacon.

Type: Use the dropdown list to select the beaconing mode/format:

iBeacon: A simple beaconing format

UUID: A string representation of a UUID, which can be in 16-bit, 32-bit, or 128-bit format. A 16-bit UUID must be exactly
four hex digits with no punctuation;  a 32-bit UUID must be exactly eight hex digits with no punctuation; and a 128-bit
UUID must be punctuated exactly as follows: "cd7b6f81-f738-4cad-aebf-d2a2ea36d996".

Major: An integer specifying the 2-byte Major value (0 to 65535)

Minor: An integer specifying the 2-byte Minor value (0 to 65535)

TxPower: An integer value specifying the Tx power level in dBm at 0 meters. The default value is -19, which
corresponds to a level of -60dBm at 1 meter. The recommended calibration practice is to measure at 1 meter and add
41: For example, -65dBm RSSI leads to a value of -24.

Eddystone URL: The   formatEddystone-URL

URL: The URL to encapsulate in the advertisement packet. 

TxPower: An integer value specifying the Tx power level in dBm at 0 meters. The default value is -19, which
corresponds to a level of -60dBm at 1 meter. The recommended calibration practice is to measure at 1 meter and add
41: For example, -65dBm RSSI leads to a value of -24.

Important
The URL for the web folder must be identical to the URL you use when publishing presentations. See the Simple File Networking

 for details. Ipublishing page f you're having trouble getting players to communicate with your web server, see this FAQ for
.troubleshooting tips

http://support.brightsign.biz/entries/95672357-How-do-I-use-a-custom-splash-screen-
http://docs.brightsign.biz/display/DOC/Diagnostic+Web+Server
https://github.com/google/eddystone/tree/master/eddystone-url
http://support.brightsign.biz/hc/en-us/articles/218067517-Simple-File-Network-troubleshooting
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: The   formatEddystone UID Eddystone-UID

: A 6-byte value expressed as 12 hexadecimal digitsNamespace
: A 10-byte value expressed as 20 hexadecimal digitsInstance
: An integer value specifying the Tx power level in dBm at 0 meters. The default value is -19, whichTxPower

corresponds to a level of -60dBm at 1 meter. The recommended calibration practice is to measure at 1 meter and add
41: For example, -65dBm RSSI leads to a value of -24.

Logging

Use the check boxes to enable/disable logs and specify log upload settings. You can view logs in the  folder on the player storage.currentLog

Enable playback logging: Records playback start and end times, zone names, media types, and file names.

Enable event logging: Records timestamps, state names, zone names, event types, and event data.

Enable state logging: Records current and last state names, timestamps, and media types.

Enable diagnostic logging: Records timestamps, firmware and script versions, and the current presentation.

Enable Variable logging: Records the current and default values of all  in the presentation. This log is only generatedUser Variables
when logs are uploaded to custom log handler URL.

Upload logs: Check either of the following:

On startup: Uploads log files each time the player is powered on.

At specific time each day: Uploads log files daily at the specified time. Use the dropdown lists to pick a time.

Relative URL for log handler: Specify the location on the server where you want logs to be uploaded and parsed.

Remote Snapshot

Check the  box to enable the Remote Snapshot feature, which allows you to remotely monitor the contents of theEnable remote snapshot
presentation display.

Remote snapshot every [ ] minutes: Specify how often the player should take a snapshot of the presentation display.

Save up to [ ] images (1 - 100) on local storage: Specify how many JPEG snapshot images can be stored on the local storage of the
player.

JPEG quality level [ ] (0 - 100): Specify the quality level (and thus the file size) of each image file.

Display snapshots in portrait mode: Check this box to have the player rotate the snapshots to portrait mode before saving and
uploading them.

RF Channel Scan Data (optional)

Use this field to publish  settings to an XD1230 player. This option is useful if you need to publish identical channel scan settingsRF channel scan
to multiple XD1230 players. See  for more details.Publishing Channel Scan Results

Screen Color

Click  to specify what screen color the player should display after it has successfully completed the setup process. When the playerChoose
displays this color, it is ready to receive content.

Creating and Installing the Setup Files

Now that you've configured the setup files, you need to publish them to your player:

Click .Create Setup Files
Browse to and select an SD card (recommended) or USB flash drive. Ensure the setup files are written to the of the storageroot folder 
device.

Click .OK
Turn off the BrightSign player by unplugging the power adapter (or Ethernet cable if the player is being powered by PoE).

Insert the SD card or USB flash drive into the player.

Tip
See  to learn how to read player logs.this FAQ

Note
The Remote Snapshot feature is not available for the LS422, HD220, or HD1020.

https://github.com/google/eddystone/tree/master/eddystone-uid
http://docs.brightsign.biz/display/DOC/Advanced+Features#AdvancedFeatures-publishing_channel_scan_results
http://support.brightsign.biz/hc/en-us/articles/218067077-How-do-I-interpret-BrightSign-player-logs-


6.  Turn on the BrightSign player  by reconnecting the power.
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Creating and Installing the Setup Files

Standalone players are not connected to a network and must be updated manually. To change presentations/schedules, you must remove the
storage card (or USB flash drive), update it on your computer, and reinsert it into the player. Updating standalone units is the only case in which
you should remove the storage card after setting up the unit.

To set up a player for standalone use, navigate to  .Tools > Setup BrightSign Unit
 

note
We recommend formatting your SD card or USB flash drive using FAT32. Formatting your card using NTFS allows you to play media
files that are 4GB or larger in size, but the player will not be able to receive network updates or generate logs.

Important
The storage device must remain in the player at all times while playing presentations. 

Tip
If your player has a USB flash drive slot, we recommend that you use an SD card when setting up the unit and keep it in the player as
the internal storage. You can then update the content on the SD card via a USB flash drive. See the   forLocal Storage publishing page
details. 

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
http://docs.brightsign.biz/display/DOC/Local+Storage#LocalStorage-publish_for_usb_update


Name Specification

Name: Enter a name for the player

Description:(Optional) Enter a description for the player.

Customization: Select one of the following:

Append unit ID: Appends the serial number of the player to the end of the player name.

Use name only: Does not append anything to the player name.

Network Properties

Enable Wireless: Check this box to connect the player to the local network using a wireless connection. In order to use a wireless
connection, you must purchase a  for your BrightSign player. If the player is connecting to a secured network, enter theWireless Module
following:

SSID: Enter the SSID of the wireless network.

Security key: Enter the password for the wireless network

Network Connection Priority: Use the up and down arrows to prioritize either the  or connection. The BrightSign player Wired Wireless 
will always attempt to download and upload using the first option, and will only use the second option if the first is unavailable.

Time zone: Select the time zone where the player is located.

Time server:(Optional) Specify the server (and ) that the player should use to synchronize its clock. Players use the BrightSignprotocol
Network time server by default.

Advanced Network Setup

Click the  button to customize advanced settings for your networked player.Advanced Network Setup

Unit Configuration

Use the tab to specify the following:Unit Configuration 

Specify hostname: Check this box to specify a custom hostname for the player on the network. By default, the player serial number is
used to generate a unique hostname.

Use Proxy: Check this box if you want the player to use a proxy server.

Address: Enter the address of the proxy. If you need to provide a user name and password for the proxy, use this format: <user
name>:<password>@<proxy server address> (e.g. “admin:root@myproxy.com”).

https://www.brightsign.biz/digital-signage-products/accessories/wireless-module
http://support.brightsign.biz/entries/453495-How-do-I-change-the-Time-Server-NTP-HTTP-on-a-player-


Port: Enter the port number of the proxy.

Proxy Bypass: Use the  button to add host names to the proxy bypass list. Host names that are checked will beAdd Host 
accessed directly, rather than using the specified proxy server. Entering a host name such as "example.com" will exempt
"example.com", "example.com:80", and "www.example.com" from the proxy setting. This feature includes bypass options for the 

 (content downloads, log uploads) and   (Dynamic Playlists, Live Media Feeds,BrightSign Network BrightSign Network Feeds
Live Text Feeds) by default.

Wired/Wireless 

Use the and  tabs to specify the following:Wired Wireless

Data Types Enabled: Use these checkboxes to determine the data types that can be transferred using the connection. You can
enable/disable downloads ( , , ), as well as uploads ( , ).Content Text Feeds Media Feeds Health Log Updates
Connection Settings: Indicate whether the IP address is auto-generated (via DHCP) or static. If you’re using a static IP address, enter
the parameters in the fields.

Diagnostics

Use the  tab to specify the following:Diagnostics

Enable network diagnostics: Check this box to have the player display the network diagnostics screen during setup.

Test Ethernet: The player will indicate whether or not it was able to attain an IP address over Ethernet.

Test Wireless: The player will indicate whether or not it was able to attain an IP address over wireless.

Test Internet Connection: The player will indicate whether or not it was able to communicate with a remote server.

Firmware

Click the  button to include a firmware update with the setup files. The firmware update will be performed after youSpecify Firmware Update
insert the storage device containing the setup files into the player and power it up. Locate the section corresponding to your BrightSign model and
select one of the following:

Production Release: The current official release of BrightSign firmware

Beta Release: The current beta release of BrightSign firmware

Minimum Compatible Release: The minimum firmware version that supports presentations created by your version of BrightAuthor. The
minimum compatible firmware will likely not support all features provided by a contemporary version of BrightAuthor.

Select specific file: Use the button to select a  firmware update file from your hard drive. The other options will downloadBrowse .bsfw
the update file from BrightSign servers when the setup files are created.

Splash Screen

Standard Splash Screen: The player will display the BrightSign logo when booting up.

Custom Splash Screen: The player will display a custom logo when booting up. Click  to locate and select the image you wishBrowse
to use. See  for image size and format restrictions.this FAQ

Unit Configuration

Select the  option. Then configure the following:Standalone

Enable diagnostic web server:(Optional) Check this box to enable the . You can include a username andDiagnostic Web Server
password in the text fields below for added security.

Enable local web server:(Optional) Check this box to enable the . You can include a username and password in theLocal Web Server
text fields below for added security.

Enable Update Notifications:(Optional) Check this box to have the player automatically refresh the  whUser Variables webpage
enever variable values change on the player.

USB Content Update Password: Enter a password in the field to enable password protection for . This featureUSB content updates
helps to ensure that a player will not be assigned incorrect schedules or data when updated via USB.

Beacons

This section allows you to configure BLE beaconing devices connected to the player.

Name: Enter a name for the beacon.

Type: Use the dropdown list to select the beaconing mode/format:

iBeacon: A simple beaconing format

http://support.brightsign.biz/entries/95672357-How-do-I-use-a-custom-splash-screen-
http://docs.brightsign.biz/display/DOC/Diagnostic+Web+Server
http://docs.brightsign.biz/display/DOC/Local+Storage#LocalStorage-publish_for_usb_update


UUID: A string representation of a UUID, which can be in 16-bit, 32-bit, or 128-bit format. A 16-bit UUID must be exactly
four hex digits with no punctuation;  a 32-bit UUID must be exactly eight hex digits with no punctuation; and a 128-bit
UUID must be punctuated exactly as follows: "cd7b6f81-f738-4cad-aebf-d2a2ea36d996".

Major: An integer specifying the 2-byte Major value (0 to 65535)

Minor: An integer specifying the 2-byte Minor value (0 to 65535)

TxPower: An integer value specifying the Tx power level in dBm at 0 meters. The default value is -19, which
corresponds to a level of -60dBm at 1 meter. The recommended calibration practice is to measure at 1 meter and add
41: For example, -65dBm RSSI leads to a value of -24.

Eddystone URL: The   formatEddystone-URL

URL: The URL to encapsulate in the advertisement packet. 

TxPower: An integer value specifying the Tx power level in dBm at 0 meters. The default value is -19, which
corresponds to a level of -60dBm at 1 meter. The recommended calibration practice is to measure at 1 meter and add
41: For example, -65dBm RSSI leads to a value of -24.

: The   formatEddystone UID Eddystone-UID

: A 6-byte value expressed as 12 hexadecimal digitsNamespace
: A 10-byte value expressed as 20 hexadecimal digitsInstance
: An integer value specifying the Tx power level in dBm at 0 meters. The default value is -19, whichTxPower

corresponds to a level of -60dBm at 1 meter. The recommended calibration practice is to measure at 1 meter and add
41: For example, -65dBm RSSI leads to a value of -24.

Logging

Use the check boxes to enable/disable logs and specify log upload settings. You can view logs in the  folder on the player storage.currentLog

Enable playback logging: Records playback start and end times, zone names, media types, and file names.

Enable event logging: Records timestamps, state names, zone names, event types, and event data.

Enable state logging: Records current and last state names, timestamps, and media types.

Enable diagnostic logging: Records timestamps, firmware and script versions, and the current presentation.

Enable Variable logging: Records the current and default values of all  in the presentation. This log is only generatedUser Variables
when logs are uploaded to a custom log handler URL.

Remote Snapshot

Check the  box to enable the Remote Snapshot feature, which allows you to remotely monitor the contents of theEnable remote snapshot
presentation display.

Remote snapshot every [ ] minutes: Specify how often the player should take a snapshot of the presentation display.

Save up to [ ] images (1 - 100) on local storage: Specify how many JPEG snapshot images can be stored on the local storage of the
player.

JPEG quality level [ ] (0 - 100): Specify the quality level (and thus the file size) of each image file.

Display snapshots in portrait mode: Check this box to have the player rotate the snapshots to portrait mode before saving and
uploading them.

RF Channel Scan Data (optional)

Use this field to publish  settings to an XD1230 player. This option is useful if you need to publish identical channel scan settingsRF channel scan
to multiple XD1230 players. See  for more details.Publishing Channel Scan Results

Screen Color

Click  to specify what screen color the player should display after it has successfully completed the setup process. When the playerChoose
displays this color, it is ready to receive content.

Creating and Installing the Setup Files

Tip
See  to learn how to read player logs.this FAQ

Note
The Remote Snapshot feature is not available for the LS422, HD220, or HD1020.

https://github.com/google/eddystone/tree/master/eddystone-url
https://github.com/google/eddystone/tree/master/eddystone-uid
http://docs.brightsign.biz/display/DOC/Advanced+Features#AdvancedFeatures-publishing_channel_scan_results
http://support.brightsign.biz/hc/en-us/articles/218067077-How-do-I-interpret-BrightSign-player-logs-
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Now that you've configured the setup files, you need to publish them to your player:

Click .Create Setup Files
Browse to and select an SD card (recommended) or USB flash drive. Ensure the setup files are written to the of the storageroot folder 
device.

Click .OK
Turn off the BrightSign player by unplugging the power adapter (or Ethernet cable if the player is being powered by PoE).

Insert the SD card or USB flash drive into the player.

Turn on the BrightSign player  by reconnecting the power.

Creating Presentations

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

This section describes how to create presentations. There are three types of presentation you can create in BrightAuthor. They are listed here in
descending order of complexity:

Full-screen presentations: A looping playlist of media–images, videos, HTML pages, etc.–that occupies the entire presentation display. 

Multi-zone presentations: Content can occupy different zones on the screen, allowing you to display multiple images, videos, and other
pieces of content in a customizable layout.

Interactive presentations: Playback, whether full-screen or multi-zone, is responsive to interactive events such as button presses, GPIO
input, or UDP commands.

Besides image, video, audio, and HTML files, presentations can also feature a number of BrightAuthor  , such as Live Text, Media RSSstates
feeds, and HDMI input.

Full-Screen Presentations

BrightAuthor Version 4.6

Version 4.4

Previous Versions 
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Editing Media Playback Options

Next Steps

In a full-screen presentation, your images and videos occupy the entire screen. To create a new presentation project, navigate to File > New
Presentation. 

If you don’t see New Presentation under File, make sure you have the Edit, Publish, or Manage tab selected.

Creating a New Project

Specify the following in the  window:New Project

Note
We recommend formatting your SD card or USB flash drive using FAT32. Formatting your card using NTFS allows you to play media
files that are 4GB or larger in size, but the player will not be able to receive network updates or generate logs.

Important
The storage device must remain in the player at all times while playing presentations.

Tip
This  outlines the basic steps for creating a full-screen presentation.tutorial video

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
http://brightsignbiz.s3.amazonaws.com/videos/02_full_screen.mp4


Save as: Enter a name for the presentation project.

Where: Click  to select the folder where you want to save the presentation project.Browse
BrightSign model: Select the target player model for the presentation. This will determine the options available when creating the
presentation in the  tab.Edit
Connector type: Select the video connector type that connects the player to the display: HDMI, VGA, or . Component

Screen resolution: Choose a resolution that matches the native resolution of your monitor. You can view all available screen resolutions
in this .FAQ

Video zone configuration: Determine how video resources will be divvied up in the presentation:

Standard: You can have one or two video zones (depending on whether your player model supports dual decode), and these
zones can play video files up to the maximum resolution (either HD or 4K) supported by your player model.

Mosaic: You can have more than two video zones. The maximum number of video zones depends on the Maximum content
setting in the  tab: The smaller the maximum resolution, the more video zones you can add.resolution  Edit > Layout

Enable 4.2.0 10-bit output:(4Kx42 models only) Check this box to output a 4.2.0 10-bit 4Kp60 or 4Kp50 video signal to the connected
display. See the  for more details on supported 4K color spaces and bit depths.video encoding FAQ

Monitor Orientation: Choose one of the following:

Landscape: Content is not rotated.

Portrait – bottom on left: Content is rotated counter-clockwise 90 degrees. Select this option if the bottom of the monitor is on
the left when it is portrait oriented.

Portrait – bottom on right: Content is rotated clockwise 90 degrees. Select this option if the bottom of the monitor is on the right
when it is portrait oriented.

Note
You can output a composite signal to a converter by selecting the "HDMI" or "Component"   and choosing one of theConnector type
available composite video modes. See this   for more information on generating component and composite signals.FAQ

Note
Choosing a portrait mode will rotate all images, videos, and HTML. However, for HDx20 and LSx22 models, content is not rotated on
the player. Instead, you will need to rotate video or images in the source application (e.g. Photoshop, Adobe After Effects) before
publishing them to the player.

http://support.brightsign.biz/entries/22929977-can-i-use-component-and-composite-video-with-brightsign-players
http://support.brightsign.biz/entries/275113-what-video-output-resolutions-are-supported-by-brightsign-players
http://docs.brightsign.biz/display/DOC/Customizing+Zone+Layouts#CustomizingZoneLayouts-adding_mosaic_video_zones
http://support.brightsign.biz/entries/143091-What-video-formats-and-codecs-do-BrightSign-players-support-
http://support.brightsign.biz/entries/22929977-can-i-use-component-and-composite-video-with-brightsign-players
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Monitor overscan: Select an overscan setting to determine how the content fills the display screen. 
No overscan – use full screen: Displays content to the edge of the video signal.

Overscan – action safe: Restricts the display area to a size that is compatible with most displays.

Overscan – title safe: Restricts the display area to a size that is much smaller than the generated video signal.

Click  when you are finished configuring the presentation. The window will open. Click the template, then click Create Template Full screen Cho
.ose

Adding Content to the Presentation Playlist

To add content to your presentation, first designate a folder on your computer as your Media Library. This will make it easy to drag and drop
image, video, and audio files into your playlist from a scrollable list of thumbnails.

Under Media Library, select the tab.files 
Click to open the file browser.

Navigate to the folder where your content is stored.

Click .OK

Add media files to your presentation by dragging files from the  to the playlist area. You can do the following when adding media Media Library
files:

Select a series of adjacent media files – Hold the key as you select the files in the Media Library.Shift 
Select a group of non-adjacent files – Hold the  key as you select the files in the Media Library.Ctrl  
Refresh the Media Library – Click . This will update the Media Library with any changes to the corresponding folder on your computer.

Move up to the parent directory of the current folder – Click .

Move to a sub-directory of the current folder – Click a file thumbnail in the Media Library.

Overscan is necessary with some older television screens that cut off content at the edges of the screen.

Note
If your content folder contains large files, it may take a while for the thumbnail images to appear.

Tip
You can also drag and drop media files directly into the playlist from a Windows Explorer window.



Editing the Presentation Playlist

Once you've added media files to the playlist, you can modify it by doing any of the following:

Remove an item from the playlist – Click an item in the playlist area and press the  or  key.Delete Backspace
Change the order in which an item plays – Click and drag an item to a new position in the playlist.

Rename the playlist – Click in the upper-right corner of the playlist area.Edit 
Change the playlist view – Click the list/tile icon in the top-right of the playlist area to change the playlist
view. Switching to a list view allows you to see the parameters of all media items and states in the
playlist.

Replace media files in the playlist – Go to > . The  wind File Replace media files Replace Media Files
ow allows you to replace files within media states without having to drag and drop individual files. This
is useful if you need to update a large number of media files in your playlist or if you want to ensure the
playlist order is preserved.

Replacement Media Folder: Click  to select the folder that contains the files you want to add. This can be the sameBrowse
folder as your Media Library, or another folder.

Preserve state names: Check this box to preserve the names of the media states in the playlist. If this box is unchecked, the
current media states will automatically take on the names of the new media files.

Presentation Media Files: For each file listed under , select a new file using the dropdown list beneath Current Media Files Rep
.lacement Media File

Editing Media Playback Options

To edit the playback settings of a media item, double-click the thumbnail in the playlist area (or right-click and select ), then choose theEdit
settings you want to apply to the selected item:

Image files: Specify the following:

Time on Screen: The amount of time (in seconds) that the image displays on screen before transitioning to the next item.

Transition: The transition effect that occurs from the previous
media item to this image.

Transition Duration: The duration (in seconds) of the
transition effect .

Video files: Specify the of the video.Volume 
Audio files: Specify the  of the audio track.Volume

To edit settings for multiple items, press the  key and select items in theCtrl
playlist. On the menu bar, select , and then choose the Edit > Selected Items
settings you want to apply to the selected items. Note that the selected items
must all be the same media or state type for this to work.

Next Steps

Now that you've created your full screen presentation, save it by navigating to  (make sure you have the  tabFile > Save [project name] Edit
selected). Then, do any of the following:

Publish the presentation – Click the  tab and select your publishing method. See the  section for morePublish Publishing Presentations
instructions.

Export the presentation – Navigate to . This saves the presentation project as a package that can beFile > Export [project name]
opened by BrightAuthor instances on other computers.

Save the presentation using a new name or location – Navigate to .File > Save [project name] As
Create another presentation – Navigate to .File > New Presentation

 

Multi-Zone Presentations
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Next Steps

In a multi-zone presentation, BrightAuthor divides the screen into rectangles called zones, allowing you to create a different playlist for each zone.
BrightAuthor provides a number of multi-zone templates. You can choose one of the system templates or create your own (see the Customizing
Zone Layouts page for more details). You can also edit the zone layout at any time after selecting a template.

In multi-zone presentations, the  restricts the media and state types that can be included in the zone. The color-coded key at the bottomzone type
of the window shows the available zone types. The following list describes the available content types for each zone type:Template 

Images: Displays images and HTML. You can include multiple Images zones in a presentation.

Ticker: Displays RSS feeds or pre-defined text strings. You can include multiple Ticker zones in a presentation.

Clock: Displays the time or date. You can include multiple Clock zones in a presentation.

Video or Images: Displays images, video, and HTML (can also play audio files).

Video Only: Displays video.

Audio Only: Plays audio. You can include multiple Audio Only zones in a presentation.

Enhanced Audio: Plays audio in a . You can include only one Enhanced Audio zone in a presentation.cross-faded playlist

Background Image: Places an image or media feed in the background of your presentation. All other zones appear on top of this zone. 

Video Zone Restrictions

BrightSign XT, 4K, and XD models can decode two videos simultaneously, while HD and LS models can only decode a single video. Also, the
Background Image zone uses a video decoder to display an image. This leads to the following zone restrictions:

XTx43, 4Kx42, XDx33, XDx32, XDx30: You can include two Video or Images zones, two Video Only zones, one of each, or one of these
and a Background Image zone.

HDx23, HDx22, LS423, LSx22, HDx20: You can include a single Video or Images zone, Video Only zone, or Background Image zone.

Creating a New Project 

To create a new multi-zone presentation, navigate to .File > New Presentation

Tip
This  outlines the basic steps for creating multi-zone presentations. tutorial video

http://brightsignbiz.s3.amazonaws.com/videos/03_multi_zone.mp4


Save as: Enter a name for the presentation project.

Where: Click  to select the folder where you want to save the presentation project.Browse
BrightSign model: Select the target player model for the presentation. This will determine the options available when creating the
presentation in the  tab.Edit
Connector type: Select the video connector type that connects the player to the display: HDMI, VGA, or . Component

Screen resolution: Choose a resolution that matches the native resolution of your monitor. You can view all available screen resolutions
in this .FAQ

Video zone configuration: Determine how video resources will be divvied up in the presentation:

Standard: You can have one or two video zones (depending on whether your player model supports dual decode), and these
zones can play video files up to the maximum resolution (either HD or 4K) supported by your player model.

Mosaic: You can have more than two video zones. The maximum number of video zones depends on the Maximum content
setting in the   tab: The smaller the maximum resolution, the more video zones you can add.resolution  Edit > Layout

Enable 4.2.0 10-bit output:(4Kx42 models only) Check this box to output a 4.2.0 10-bit 4Kp60 or 4Kp50 video signal to the connected
display. See the  for more details on supported 4K color spaces and bit depths.video encoding FAQ

Monitor Orientation: Choose one of the following:

Landscape: Content is not rotated.

Portrait – bottom on left: Content is rotated 90 degrees. Select this option if the bottom of the monitor is on the left when
portrait oriented.

Portrait – bottom on right: Content is rotated 270 degrees. Select this option if the bottom of the monitor is on the right when
portrait oriented.

Monitor overscan: Select an overscan setting to determine how the content fills the display screen. 
No overscan – use full screen: Displays content to the edge of the video signal.

Overscan – action safe: Restricts the display area to a size that is compatible with most displays.

Overscan – title safe: Restricts the display area to a size that is much smaller than the generated video signal.

Click  when you are finished configuring the presentation. The window will open.Create Template 

Selecting a Template

Use the  dropdown list to choose between "System Templates" and "User Defined Templates" (see the  section toView Customizing Zone Layouts
learn more about creating User Defined Templates). Select a multi-zone template you wish to use and click —Remember that you canChoose
edit the zone layout at any time after choosing a template.

Adding Content to Zones

Note
Note: You can output a composite signal to a converter by selecting the "HDMI" or "Component" Connector type and choosing one of
the available composite video modes. See this   for more information on generating component and composite signals.FAQ

Note
Choosing a portrait mode will rotate all images, videos, and HTML. However, for HDx20 and LSx22 models, content is not rotated on
the player. Instead, you will need to rotate video or images in the source application (e.g. Photoshop, Adobe After Effects) before
publishing them to the player.

Tip
Tip: Overscan is necessary with some older television screens that cut off content at the edges of the screen.

http://support.brightsign.biz/entries/22929977-can-i-use-component-and-composite-video-with-brightsign-players
http://support.brightsign.biz/entries/275113-what-video-output-resolutions-are-supported-by-brightsign-players
http://docs.brightsign.biz/display/DOC/Customizing+Zone+Layouts#CustomizingZoneLayouts-adding_mosaic_video_zones
http://support.brightsign.biz/entries/143091-What-video-formats-and-codecs-do-BrightSign-players-support-
http://support.brightsign.biz/entries/22929977-can-i-use-component-and-composite-video-with-brightsign-players
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To add content to your zones, first designate a folder on your computer as your Media Library. This will make it easy to drag and drop image,
video, and audio files into a zone playlist from a scrollable list of thumbnails.

Under Media Library, select the tab.files 
Click to open the file browser.

Navigate to the folder where your content is stored.

Click .OK

Use the dropdown menu under  to select a zone, then add media files to the zone by dragging files from the  to the playlistZone  Media Library
area. You can do the following when adding media files:

Select a series of adjacent media files – Hold the key as you select the files in the Media Library.Shift 
Select a group of non-adjacent files – Hold the  key as you select the files in the Media Library.Ctrl  
Refresh the Media Library – Click . This will update the Media Library with any changes to the corresponding folder on your computer.

Move up to the parent directory of the current folder – Click .

Move to a sub-directory of the current folder – Click a file thumbnail in the Media Library.

 

Editing the Zone Playlist

Once you've added media files to a zone, you can modify it by doing any of the following:

Remove an item from the playlist – Click an item in the playlist area and press the  or  key.Delete Backspace
Change the order in which an item plays – Click and drag an item to a new position in the playlist.

Rename the playlist – Click in the upper-right corner of the playlist area.Edit 
Change the playlist view – Click the list/tile icon in the top-right of the playlist area to change the playlist
view. Switching to a list view allows you to see the parameters of all media items and states in the
playlist.

Replace media files in the playlist – Go to > . The  wind File Replace media files Replace Media Files
ow allows you to replace files within media states without having to drag and drop individual files. This
is useful if you need to update a large number of media files in your playlist or if you want to ensure the
playlist order is preserved.

Replacement Media Folder: Click  to select the folder that contains the files you want to add. This can be the sameBrowse
folder as your Media Library, or another folder.

Preserve state names: Check this box to preserve the names of the media states in the playlist. If this box is unchecked, the
current media states will automatically take on the names of the new media files.

Presentation Media Files: For each file listed under , select a new file using the dropdown list beneath Current Media Files Rep
.lacement Media File

Note
Note: If your content folder contains large files, it may take a while for the thumbnail images to appear.

Tip
You can also drag and drop media files directly into the playlist from a Windows Explorer window.



Editing Media Playback Options

To edit the playback settings of a media item, double-click the thumbnail in the playlist area (or right-click and select ), then choose theEdit
settings you want to apply to the selected item:

Image files: Specify the following:

Time on Screen: The amount of time (in seconds) that the image displays in a zone before transitioning to the next item.

Transition: The transition effect that occurs from the previous media item to this image.

Transition Duration: The duration (in seconds) of the transition effect.

Video files: Specify the of the video.Volume 
Audio files: Specify the  of the audio track.Volume

To edit settings for multiple items, press the  key and select items in the playlist. On the menu bar, select , and thenCtrl  Edit > Selected Items
choose the settings you want to apply to the selected items. Note that the selected items must all be the same media or state type for this to work.

Next Steps

Now that you've created your multi-zone presentation, save it by navigating to  (make sure you have the  tabFile > Save [project name] Edit
selected). Then, do any of the following:

Publish the presentation – Click the  tab and select your publishing method. See the   section for morePublish Publishing Presentations
instructions.

Export the presentation – Navigate to . This saves the presentation project as a package that can beFile > Export [project name]
opened by BrightAuthor instances on other computers.

Save the presentation using a new name or location – Navigate to .File > Save [project name] As
Create another presentation – Navigate to .File > New Presentation
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Saving the Zone Layout as a Template

If the system zone templates do not meet your needs, you can manually edit the zone layout of your presentation. You can then save it as a
user-defined template for use with future presentations. Once you have created a presentation project via File > New Presentation, click Layout 
(below the Edit tab) and customize the zones by doing any of the following:

Rename the zone – Enter a new name for the zone in the Name field.

Add a zone – Click  . Enter a  , select the  , and then click  .Add zone Zone name Zone type OK
Delete a zone – Click the zone and press the  key on your keyboard.Delete 
Change the position of a zone manually – Click and hold a zone. Then drag it to the desired position.

Change the position of a zone using coordinates – Enter the  information. The  and values correspond to the horizontal andPosition X Y 

Tip
See this  for an overview of zone layouts. tutorial video
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vertical position (in pixels) of the top-left corner of the zone. Using coordinates to specify the position allows for exact alignment with other
zones.

Resize a zone manually – Click and hold one of the marks around the edge of a zone. Then drag it to create the desired zone size and
shape.

Resize a zone using pixel values – Specify the  information. The  and values correspond to the width and height of the zone (inSize W H 
pixels).

Make zones equal in size – Press and select the zones you want to resize. On the menu bar, click  > andCtrl Format Make same size 
select a resize option.

Align multiple zones – Press  and select the zones you want to align. On the menu bar, click > and select an alignmentCtrl Format Align 
option.

Center one or more zones – Select a single zone or press  and select the zones you want to center. On the menu bar, click >Ctrl Format 
and select or .Center in form Horizontally Vertically

Layering Zones

You can place multiple zones in the same screen area and use transparency and z-ordering options to creating layering effects. For example, you
can place a Ticker or Clock zone on top of a Video Only zone and then edit the transparency of the Ticker or Clock zone (in the )Zone Properties
to control how much of the underlying video shows through.

There can be three layers (or "planes") in a multi-zone presentation. Each of these planes can be ordered in relation to the others:

Graphics Plane: This plane includes all Ticker, Clock, and Images zones (as well as the Video or Images zone if it's currently displaying
an image or HTML page). Note that the layering of graphics zones with respect to each other can be unpredictable, and may change if
the player firmware is updated or some other presentation setting is changed.

Video Plane 1: This plane consists of a Video Only or Background Image zone (or a Video or Images zone if it's currently displaying
video). The Background Image zone uses the video decoder to display an image, so it counts as a video plane. 

Video Plane 2: This plane consists of a second Video Only or Video or Images zone (if it's displaying video).

Note
The preview image is always displayed as landscape. If you're creating a portrait-mode presentation, refer to the portrait image on the
left to see a more accurate representation of the screen layout.

Tip
If you want to place an image behind a graphics element, use a Background Image zone to display the image.
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Use the following options to edit the layering of the three planes:

Video Position Z: (XT, XD, and 4K models only): Edit the z-ordering of one video plane in relation to another.

Front: Places the zone in front of another Video Only zone or Video or Images zone.

Back: Places the zone behind another Video Only zone or Video or Images zone.

Graphics plane z position: Edit the z-ordering of the graphics plane in relation to the video plane(s).

Front: Places the graphics plane (including all Ticker, Clock and Images zones) in front of the video plane(s).

Between: Places the graphics plane between two video planes. If there is only one video plane, the graphics plane will appear
behind it.

Back: Places the graphics plane behind the video plane(s).

Adding Mosaic Video Zones 

If you set the to  when , you will need to perform extra steps when adding VideoVideo zone configuration  Mosaic creating your presentation
Only or Video or Images zones:

Delete any video zones that were created with the presentation template.

Click  and select a Video Only or Video or Images zone.Add Zone 
Select a  . This will determine the maximum resolution of video files you can add to the zone, as well asMaximum Content Resolution
the maximum number of video zones you can add to your presentation. The maximum number of zones will also depend on the player
model.

Use the  button to create additional video zones as desired. For each additional zone, you can select smaller maximumAdd Zone 
resolutions, but you cannot change the initial maximum resolution unless you remove all video zones from the presentation.

Saving the Zone Layout as a Template

Once you've created a zone layout, you can save it as a user-defined template. To save the layout as a template, click (in theSave Template 
lower-left portion of the screen). Enter a name for the template, and then click .OK

To use the customer template when creating a new presentation, click the  dropdown list in the upper-right corner of the  windowView Template
and elect  to view your templates.User Defined Templates
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Creating an Interactive Presentation

Choosing a Home Screen

Defining Interactive Events

Defining Multiple Events

Customizing the Interactive Playlist

You can use BrightAuthor to create interactive presentations. Interactive presentations respond to interactive events, such as input from buttons
or other GPIO devices, or from devices connected to a BrightSign communication port. The supported communication methods vary by BrightSign
model:

USB devices (such as touch screens, mice, keyboards, barcode scanners, IR remote controls): XT1143, 4K1042, 4K1142,
XD1033, XD1032, XD1132, XD1030, XD1230, HD1023, HD1022, HD1020, LS423, LS322, LS422

Networked devices: All 4K, XD, and LS models, as well as the HD223, HD1023, HD222, HD1022, HD220, HD1020, and AU320

RS232 serial devices: XT1143, 4K1042, 4K1142, XD1033XD1032, XD1132, XD1030, XD1230, HD1023, HD1022, HD1020, and AU320

GPIO devices: All models except the LS423

Infrared (IR) devices: All XT, 4K, and XD models

Creating an Interactive Presentation

Follow these steps to create an interactive playlist in a presentation:

Open or create a presentation project. If you haven’t created a presentation before, see the  section for details.Full-Screen Presentations

Under , click theMedia Library

button and select a folder that contains the files you want to include in your
presentation.

Select a zone you want to make interactive.

Make the zone interactive: In the upper-right portion of the screen beside Playlis
, click .t type Interactive

Drag the desired content into the playlist area. This can include media from the tab and states from the tab.files other 

Choosing a Home Screen

The Home Screen is the first media file in an interactive playlist. It is where the interactive presentation begins (within a particular zone). Home
Screens usually include one of the following:

An attract video that loops until the user provides input

A list of options from which the user can choose the next action (e.g. an )Interactive Menu

By default, the first item you drag into an interactive playlist will become the Home Screen. It is identified by the 

icon. You can change the Home Screen at any time by double-clicking the desired file in the playlist and checking the bHome Set as initial state 
ox.

Tip
This  outlines the basic steps for creating an interactive presentation. tutorial video

Note
Multi-zone presentations can include both non-interactive and interactive zones.

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
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Defining Interactive Events

Interactive events link files in the playlist and determine what must occur before one file transitions to another. In the user interface, files are
referred to as “states,” where the current file is the “current state,” and the file transitioned to is the “next state.” We refer to creating and linking
interactive events between states will be referred to as “defining events”.

The easiest way to define events is to use the , which is located at the top of the playlist area.Events Toolbar

In the , click the interactive event icon that corresponds to the type of event you want to define. For example, to defineEvent Toolbar
what happens when a user presses button 1 on a GPIO button board, click .

Click (and hold) the file name below the thumbnail image of the current state.

Drag the hand pointer to the thumbnail image of the media file you want to play next (i.e. the next state). 

You can also define events using the  tab:events

Select the  tab under .events Media Library
Drag the event icon onto the thumbnail of a state. This will be the state that the event transitions away from.

An Event window will automatically open. Here, you can specify the state that the event will transition to. See the Editing Interactive
 section for more details.Events

Interactive events can start with any item and correspond to any other item in the playlist. For example, you can set the first interaction to display
an image when the user presses button 1 from the Home screen. By defining a new event with the same event icon, you can set a second
interaction to display another media file when the user presses button 1 again.

Important
Make sure your defined events work in a loop. In the playlist shown below, a user can transition from the Home Screen to the other
images by pressing button 1 or button 2. After a set period of time (indicated by the timeout events), the presentation will return to the
Home Screen.
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Defining Multiple Events

You can define more than one event at a time. This is useful if you want multiple states to transition to a single state using the same event type.

Right-click and drag the cursor within the playlist area to select multiple states. Alternatively, you can pres and hold  to select multipleCtrl
states.

With the states selected, define the interactive event from one media file, and it will then be created for all selected files.

Customizing the Interactive Playlist

In the upper-right portion of the screen, you can use the control to adjust your view of the playlist area. When you switch between multipleZoom 
interactive zones, BrightAuthor will remember the zoom setting last used for each zone.

If you don’t see the event you want in the playlist toolbar, click the arrow to the left of the  control. Here, you can add or remove event iconZoom
buttons from your toolbar.
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You can further adjust how your media files transition from state to state by double-clicking Event icons (or right-clicking and then clicking ).Edit
For example, if you create an event with the Timeout Event icon, the media file displayed in your presentation will transition to the next state after
a certain period of time. You can adjust this time period by double-clicking the Timeout Event icon between the two media files and changing the
duration in the window.Timeout Event 

Double-clicking an event icon opens the Event window, which is the same window that automatically opens when you drag an event icon from the
tab onto the playlist. The Event window will present options specific to the type of interactive event chosen, along with the followingevents 

options:

Transition to new state: The presentation will transition to a new state when the interactive event occurs. Use the dropdown list to
specify which state in the playlist will be next.

Return to prior state: The presentation will revert to the previous media file when the interactive event occurs.

Remain on current state: The state will not change when the interactive event occurs. This option is useful when you need to perform
actions that are not immediately visible, such as sending a UDP command, altering the value of a user variable, or lowering the volume.
These actions are performed by attaching commands to an event; see the   page for more details.Commands
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You can edit individual files in an interactive playlist by right-clicking the file icon and selecting . The window will open.Edit Media Properties 

State name: The current state name as it appears in the interactive playlist. You can edit the name in this field.

Current file: The filename of the current file associated with the state. This field cannot be edited.

Select different file: Use the dropdown menu to select a different media file to associate with the state. This is useful for preserving
events and commands that were defined for the original file. The change  until the  button is pressed (even ifwill not go into effect Update
you click ). If you need to replace all instances of a particular media file within your presentation, navigate to OK > File Replace Media

.Files
Transition:(Image states only) Use the dropdown list to select a special transition effect that will occur when the image appears on the
display.

Transition duration:(Image states only) Specify how long the transition effect will take to complete. This duration should be less than the
amount of time the image is displayed on screen.

Loop media: (Video states only) Choose this option to loop the video indefinitely when no Media End event is attached to the state.

Hold last video frame: (Video states only) Choose this option to display the last frame of the video after it ends when no Media End
event is attached to the state.

 Click the  tab to store the image in the cache, set display mode for video files (2D, 3D side-by-side, 3D top-over-bottom), or addAdvanced
commands.
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All states can be copied, exported, and imported. Copying or exporting a state (or set of states) will also copy all commands and notes attached to
that state. This process will only preserve events that transition among the set of copied/exported states.

Copying: With a state selected, right-click the state and select , navigate to , or press Ctrl+C. You can also copyCopy Edit > Copy
multiple states by holding down Ctrl while selecting the desired states.

Pasting: Right-click a playlist or Super State canvas and select , navigate to , or press Ctrl+V. Note that a pasted statePaste Edit > Paste
will appear at the same canvas position as the original state; if the original state has not moved, it may be difficult to tell that the paste
action occurred.

Exporting: With a state selected, right-click the state and select  or navigate to . You can also place multiple statesExport Edit > Export
into a single export file by holding down Ctrl while selecting the desired states. The exported state(s) will be saved as a single file with a .

 extension in the specified directory.bse

Importing: Right-click a playlist or Super State canvas and select , or navigate to . You will beImport States  Edit > Import States
prompted to select the file containing the state(s) you wish to export..bse 

COMMANDS
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ON THIS PAGE

Adding Commands to an Event

Adding Commands to a State or Media File

Command Types

Set Audio

Connector Volume

Zone Volume

Send 

Link 

Video

BrightControl

Other

Commands allow you to add extended functionality to your presentations. Commands can help you control displays and devices (Display On,
GPIO On, etc.) or perform additional actions when interactive events are performed (Pause Video, Set Volume, etc.).

You can add commands to interactive events or to states. If you add a command to the , the command will be performed wheninteractive event
that event occurs. If you want to add a command to a state, you will need to choose between an  (executed upon entering theEntry Command
state) or an  (executed upon leaving the state). Some Commands (such as Switch Presentation) can only be added to interactiveExit Command
events.

Tip
 You can delete a defined event (or file) at any time by clicking the icon/thumbnail and pressing  on your keyboard.Delete 
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Adding Commands to an Event

Follow these steps to add a command to an interactive event:

Double-click the event icon in the playlist area.

Click the tab.Advanced 
Click .Add Command
Use the dropdown list under to choose the category of the command.Commands 
Use further dropdown lists and fields to set additional .Command Parameters

Adding Commands to a State or Media File

Follow these steps to add a command to a state or media file:

Double-click the media file thumbnail in the playlist area.

Click the tab. Advanced 
In the or  section, click .Entry Commands Exit Commands Add Command
Use the dropdown list to specify a command. 

Use further dropdown lists and fields to set additional parameters for the command. 

Command Types

This section outlines available command categories and types.

Set Audio

Changes the audio settings of a zone. Note that triggering the Set Audio command while an audio/video file is playing will cause playback to
freeze (though the player will still respond to  like Timeout, UDP Input, etc). You can also use the Set Audio command whileInteractive Events
displaying an image file, or you can attach the Set Audio command to an interactive event that transitions to or from an audio/video file.

Zone: Specifies the zone to which the audio settings will apply.

Audio Output: Enables or disables the Analog Stereo, HDMI, and SPDIF audio outputs.

Pass through: Supplies the un-decoded audio signal through the HDMI/SPDIF connector. Use this option if the presentation
audio (for example, AC3 Dolby Digital) is being decoded on an external device.

Stereo: Supplies the decoded audio signal through the HDMI/SPDIF connector.

Audio Mixing: Specifies which part of the audio signal to send.

Stereo: Sends both left and right audio signals.

Left: Sends the left audio signal only.

Right: Sends the right audio signal only.

Connector Volume

Changes the audio volume of a specific connector.

Set: Specifies the volume level. Select the Audio (i.e. analog), HDMI, or SPDIF connector in the dropdown list and enter a volume value
between 0 and 100 in the field.

Increment: Specifies how much the volume level increases with each interaction. Select the Audio (i.e. analog), HDMI, or SPDIF
connector in the dropdown list.

Decrement: Specifies how much the volume level decreases with each interaction. Select the Audio (i.e. analog), HDMI, or SPDIF
connector in the dropdown list.

Mute: Turns the connector audio output off. Use the checkboxes to select among the Audio (i.e. analog), HDMI, and SPDIF connectors.

Unmute: Turns the connector audio output on. Use the checkboxes to select among the Audio (i.e. analog), HDMI, and SPDIF
connectors.



Zone Volume

Sets the volume for a zone. Note that the settings take precedence over the  settings when both are active in aConnector Volume Zone Volume
presentation.

Set: Specifies an absolute volume level for a zone. Use the dropdown menu to select the zone to which this command applies and enter
a volume value between 0 and 100.

Increment: Specifies how much the volume level increases with each interaction. Use the dropdown menu to select the zone to which
this command applies and enter an increment amount.

Decrement: Specifies how much the volume level decreases with each interaction. Use the dropdown menu to select the zone to which
this command applies and enter a decrement amount.

Send 

Sends information using the following interfaces:

Send Zone Message: Triggers a  event with the same command parameter as the Send Zone Message command.Zone Message

UDP: Sends a message to a networked device using the UDP protocol. Use the  tab toFile > Presentation Properties > Interactive
specify the destination address and port for UDP messages.

Send IR Remote: Sends a command via the 3.5mm IR Out port (XT, 4K, and XD models only).

Send IR Remote (Pronto): Sends a command using Pronto Hex Code (PHC) via the 3.5mm IR Out port (XT, 4K, and XD models only).

Serial string (EOL): Sends the specified string to the specified serial port. This command adds a carrier return at the end of the string.

Serial string (no EOL): Sends the specified string to the specified serial port. This command does not add a carrier return at the end of
the string.

Serial byte: Sends the specified byte to the specified serial port. The byte must be entered in decimal format (0-255).

Serial bytes (comma separated): Sends the specified bytes to the specified serial port in comma-separated format.

Send Plugin Message: Sends the specified string to a  attached to the presentation. Use the dropdown menu tocustom script plugin
select a desired script plugin. Please see the  tech note for more information on creating custom scripts that canParsers and Plugins
receive plugin messages.

Link 

Connects presentation zones or synchronizes BrightSign players.

Synchronize: Specifies the  trigger.Synchronization

Zones: Specifies the  trigger.Link Zones

GPIO

Sends a GPIO command.

On: Turns on the specified GPIO output.

Off: Turns off the specified GPIO output.

Set State: Enables you to turn each GPIO line on or off.

Video

Changes the video playback settings:

Pause video: Pauses video playback.

Resume video: Resumes video playback.

Enable monitor power save mode: Turns the monitor's power saving mode on.

Disable monitor power save mode: Turns the monitor's power saving mode off.

BrightControl

Sends commands to monitors and other digital signage displays:

Display On: Turns the display on.

Note
Most standard RS-232 serial devices enumerate on port 0. If you are connecting a USB-serial device, it will enumerate on port 2.

Tip
This  describes how to use Link Zones commands to create a synchronized presentation.tutorial video

http://docs.brightsign.biz/display/DOC/BrightAuthor+Plugins+and+Parsers
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Display Off: Turns the display off.

Send Ascii String: Sends a CEC command. The provided string will be converted to hexadecimal format before being sent to the
display. 

Set Philips Volume: Sets the Philips TV volume.

Other

Sends various commands that are not contained within the above categories.

Pause: Pauses presentation playback for a specified number of milliseconds.

Reboot: Reboots the BrightSign player.

Set Variable: Sets a new value for the specified .User Variable

Increment Variable: Increases the value of the specified User Variable by 1.

Decrement Variable: Decreases the value of the specified User Variable by 1.

Reset Variable: Resets the specified  to its current default value.User Variable

Reset Variables: Resets all  to their current default values and all Media Counters to zero.User Variables

Switch to Presentation: Switches to a different presentation. Before using this command, you must add additional presentation(s) to the 
 tab in the  window. The following settings of must be identical for both presentations:Switch Presentations Presentation Properties

BrightSign Model, Connector Type, Screen Resolution, Monitor Orientation, and Monitor Overscan.

Specify Presentation: Choose the presentation to switch to from the dropdown list.

Specify via user variable: Choose the User Variable that will determine which presentation to switch to. The value of the User
Variable must be identical to the name given to the target presentation in the  tab.Switch Presentations

Update Data Feed: Updates the content of the specified Data Feed.

Resize Zone: Repositions and/or resizes the specified zone. Select the zone you wish to modify. Then enter an and  coordinateX Y
(corresponding to the top-left corner of the zone), as well as  and (width and height) values for the zone.W H 
Hide Zone: Hides the specified zone from view.

Show Zone: Shows the specified zone if it is hidden.

CONDITIONAL TARGETS
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Conditional targets allow you to change the settings of an event transition depending on the value of a . You can set multipleUser Variable
conditional targets for a single event, and you can specify new commands to occur when the conditional target is met. With this feature, you can
change the behavior of a presentation based on a wide array of interactive and networked conditions.

Follow these steps to add a conditional target to an event:

Select the tab while creating or editing an event.Advanced 
Click the button.Set Conditional Targets 

Important
 BrightControl CEC command strings cannot contain spaces.

Note
The Increment Variable and Decrement Variable commands have the following special rules:

If the command is used on a number with a decimal value, the number will be converted to an integer by removing the decimal
(i.e. the number is always rounded down).

If the command is used on a string, the value will be converted to a zero. Then the increment/decrement action will be
performed on the zero. Negative numbers are also possible.

Note
 The Hide Zone and Show Zone commands do not affect Audio Only, Enhanced Audio, or Background Image zones.

Note
Conditional Targets are only available if you have created one or more User Variables in the File > Presentation Properties >

window.Variables 
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Click in the  window (you can also click a preexisting Conditional Target to edit it).Add Conditional Target Conditional Targets
In the first dropdown menu, select the User Variable that will trigger the Conditional Target.

In the second dropdown menu, select the conditional operator that will compare the current value of the variable against the value set in
the field to the right. The transition behavior and Commands you specify in this window will only occur when the entire statement—the
variable, the operator, and the target value—is true. These are the conditional operators that are currently available:

Between

Less than (<)

Less than or equal (<=)

Equals (=)

Greater than or equal (>=)

Greater than (>)

Determine what will happen if the
Conditional Target is met:

Transition to new state: The
presentation will transition to
a new state. Use the
dropdown list to specify a
new state.

Return to prior state: The
presentation will return to the
previous state.

Remain on current state:
The state will not change.

Select the Advanced tab to add Commands to the Conditional Target. Commands will trigger when the target is met. See the Command
s page for more information.

Click  to save the conditional target.OK
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Web Browser

UDP, Serial Input, and Plugin Message Events

There are several ways to change the values of User Variables in an interactive presentation. See the  page Variables for more information about
creating User Variables and setting default values.

Web Browser

You can view and update User Variables using a web browser. To do this, your computer must be connected to the same local network as the
BrightSign player, and you must enable the Local Web Server on the player:

Navigate to .Tools > Setup BrightSign Unit
Check the box.Enable local web server 
Enter a user name and password for the web server if desired.

Set the rest of the options in the  window and complete the unit configuration process (see the BrightSign Unit Setup Setting up
 for more information).BrightSign Players

Wait for the player to complete the entire boot process.

Use the address bar of a web browser to navigate to device IP port 8008. For example, if the IP address of your BrightSign player is
192.168.1.2, then you would enter 192.168.1.2:8008. You will be provided with a web page that lists all User Variables and allows you to
modify them.

Note
In the target value field, you can enter either a fixed integer or the name of another user variable (e.g. “when Variable A is equal to 42”
or “when Variable A is equal to Variable B”). For user variables, you must enter the name of a target variable between two sets of dollar
signs (e.g. “$$my_variable$$”).

Tip
If you do not know the IP address of your player, you can obtain it by powering up the player without an SD card inserted: The IP

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
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UDP, Serial Input, and Plugin Message Events
You can change the value of User Variables using the input from a UDP Input, Serial Input, or Plugin Message event:

Create a new UDP Input, Serial Input, or Plugin Message (or edit an existing one).

If using a UDP Input event, type <any> into the field. The field can contain either the wildcard designator by itself orSpecify UDP input 
additional text with the wildcard designator (e.g. "message_<any>").

If you are using a Serial Input or Plugin Message event, enter the <*> wildcard designator into the  or  Specify serial input Plugin messa
 . The field can contain either the wildcard designator by itself or additional text with the wildcard designator (e.g. "message_<*>").ge field

Check the box labeled .Assign input to variable
Select if you want to choose a fixed User Variable in the BrightAuthor presentation. Use the dropdown listSpecify fixed variable 
to choose which User Variable the UDP input will modify. The UDP/serial string must be input in the form of <variable value>.

Select if you want the UDP/serial input string to dynamically specify which User Variable is beingInput specifies variable 
modified. The UDP/serial string must be input in the form of <variable name> : <variable value>.

Check the box labeled Assign wildcard to variable to specify the value of a User Variable using the <any> or <*> wildcard designator.
Select the User Variable to modify using the dropdown menu to the right.

Press to save the settings.OK 

Creating Playlists and Feeds
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You can use the  tab to generate media playlists and text feeds that are hosted on the BSN servers. You can edit these playlists/feeds inCreate
BrightAuthor or the BrightSign Network WebUI, and the changes will be automatically distributed to all players that use them.

Dynamic Playlists

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

ON THIS PAGE

Creating a Dynamic Playlist

Updating a Dynamic Playlist

Adding a Dynamic Playlist to your Presentation

Use Dynamic Playlists to easily update media playlists in multiple presentations. For example, if you need to add a set of daily announcements to
multiple presentations, and you don’t want to update each presentation separately, you can add a single Dynamic Playlist to all of your
presentations. When you update the Dynamic Playlist, every presentation that includes the Dynamic Playlist receives the new content. In this way,
a single update can reach multiple presentations.

Creating a Dynamic Playlist

address, along with other information about the unit, will be displayed on screen once the unit boots.

Note
 If you select  , you can modify more than one User Variable with a single event. Use the following UDP/SerialInput specifies variable
string: "<variable name> : <variable value> !! <variable name> : <variable value>"

Note
It is possible to check both   and   boxes for more complex functionality. For example,Assign input to variable Input specifies variable
you use   to assign the entire UDP string to one variable, while at the same time using Specify fixed variable Assign wildcard to

to assign a subset of that string to another variable.variable 

Note
A BrightSign Network subscription is required to create Dynamic Playlists and Live Data Feeds. 

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
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Follow these steps to create and upload a Dynamic Playlist:

Click the tab and select .Create Dynamic Playlist
On the menu bar, click > .File New Dynamic Playlist
Choose the  or option for the Dynamic Playlist.Image or Video Audio Only 
Add files to your Media Library by clicking the  button and selecting a folder that contains the files you want to include in yourBrowse
Dynamic Playlist.

Drag the desired media files to the playlist area.

Click the button in the upper-right portion of the screen.Upload to Network 
You will be prompted to save the playlist. Click . The window will open. Type a name for your playlist and click The Yes Save As Save. S

window will open. Click The playlist will now be uploaded onto the BrightSign Network.ave Complete OK. 

Updating a Dynamic Playlist

You can change the content of the Dynamic playlist at any point by opening the playlist ( > ) from the tab.File Open Dynamic Playlist Create 
Once you've edited the playlist, click to update it. All players using the Dynamic Playlist will be updated in real time.Upload to Network 

Adding a Dynamic Playlist to your Presentation

Follow these steps to add a Dynamic Playlist to a presentation:

Navigate to the  tab.Edit
Click the tab under other Media Library
Drag a item into the playlist area.Media RSS 
When prompted to select a Data Feed, click .Add Data Feed
Enter a . This does not need to be the same name given to the Dynamic Playlist.Feed name
Under , select  and choose the playlist from the dropdown menu.Feed specification Dynamic Playlist
Under , select .Data feed content usage MRSS Feed
Use the  dropdown menu to determine how often the player should check in with the BrightSign Network servers toUpdate Interval
update the Dynamic Playlist.

Click . OK

 

Live Data Feeds

BrightAuthor Version 4.6
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ON THIS PAGE

Creating a Live Data Feed

Adding a Live Data Feed to Your Presentation

Similar to an RSS feed, a Live Data Feed consists of an indexed list of Titles and Values: Each Title has an associated Value. Live Data Feeds
can have numerous applications in a presentation. They can be used as updatable text feeds in Ticker zones or as individual text widgets in a Liv
e Text state. They can even be used to remotely update the values of User Variables.

Creating a Live Data Feed

Tip
You can create Dynamic Playlists in the  as well.  BSN WebUI

Note
Dynamic Playlists containing audio can be added to Audio Only, Enhanced Audio, Video or Image, and Video Only zones, while
Dynamic Playlists containing image/video content can be added to Images, Video or Images, or Video Only zones.

Tip
You can create Live Data Feeds in the  as well. BSN WebUI

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
http://docs.brightsign.biz/display/DOC/Create+Tab#CreateTab-creating_dynamic_playlists
http://docs.brightsign.biz/display/DOC/Create+Tab#CreateTab-creating_live_data_feeds
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Follow these steps to create and upload a Live Data Feed.

Click the  tab and select .Create Live Data Feed
On the menu bar, navigate to > .File New Data Feed
Click the  button to create a new feed entry.Add Item
Enter a  for the feed entry. The title, as well as the index number, allows you to pick a specific entry to display when using RSS feedsTitle
in .Live Text

Enter a  for the feed entry. This is the portion of the feed that will be displayed on screen.Value
Use the up and down arrows to reorder the list of entries. You can also use the  button to delete an entry.X
When you are finished adding entries, click the  button in the upper-right portion of the screen (you must beUpload to network
connected to the BrightSign Network). You will be prompted to save the feed as an XML file before uploading it to the network. The name
you give to this XML file will be the name associated with this feed on the BrightSign Network.

You can save a copy of the feed any time by navigating to  or . You can later retrieve the feed byFile > Save New Feed File > Save New Feed As
navigating to .File > Open Live Data Feed

Adding a Live Data Feed to Your Presentation

Follow these steps to add a Live Data Feed to you presentation:

While in the  tab, navigate to .Edit File > Presentation Properties > Data Feeds
Click .Add Data Feed
Enter a . This does not need to be the same name given to the Live Data Feed.Feed name
Under , select and choose the feed from the dropdown menu.Feed Specification Live Data Feed 
Under , select .Data feed content usage Text
Use the  dropdown menu to determine how often the player should check in with the BrightSign Network servers toUpdate Interval
update the Live Data Feed.

Click .OK

You can now add the text of the Live Data Feed to your presentation via  and  states.Live Text RSS Feed

Tagged Playlists

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

Tagged Playlists allow you to create BrightSign Network playlists based on . You can use this feature to define a flexiblecustomizable media tags
set of rules to dynamically build a playlist based on a wide range of intuitive conditions.

Example
You are managing networked BrightSign players at a dozen different retail locations. Each player requires some unique media to match
its retail location, and some locations, depending on the region, have more media files in common than others. Instead of creating a
dozen different presentations (and managing each presentation separately), you can create a single Tagged Playlist with location,
region, and event tags (or any other tags you need; they're completely customizable) to ensure the right media gets played in the right
place at the right time.

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
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Click the   tab.Create
Select  in the secondary task bar.Tagged Playlist 
Under  , select whether you want the playlist to match  tags or  tag:Media Rules all  any 

All: For a media file to be included in this Tagged Playlist, it must match  conditions you define in the  section.all  Media Rules 
The more conditions you add, the more  the playlist will tend to be.exclusive 

Any: For a media file to be included in this Tagged Playlist, it only needs to match one of the conditions you define in the Media
section. The more conditions you add, the more  the playlist will tend to be.Rules  inclusive 

Click  to add a tagging condition:Add Media Rule
Tag Name: Select a tag from the dropdown menu. The list includes all media tags you've defined in your BSN library, as well as
a set of default media attribute tags (FileName, FileSize, UploadDate, etc.) that apply to all media files. 

Condition: Select a rule to match media with the specified tag: 

is: Tagged media that equals the specified   will be matched.Value
is not: Tagged media that does not equal the specified   will be matched.Value
contains all: Tagged media that contains all of the specified values for the tag will be matched. If a tag for a media file
contains additional values beyond the matched list of values, that media file will still be matched. Separate each tag
value using a comma without spaces (e.g. "NewDeals,DailyDeals,Promotions").

contains any: Tagged media that contains any of the specified values for the tag will be matched. Separate each tag
value using a comma without spaces (e.g. "appetizers,drinks,specials").

contains: Tagged media that has one or more values containing the specified sequence of (case-insensitive) characters
will be matched: For example, specifying a  of "deal" will match "deals", "Deals", and "New_Deals" values.Value 
does not contain: Tagged media that has no values containing the specified sequence of (case-insensitive) characters
will be matched: For example, specifying a   of "day" will exclude "DayOfWeek", "Monday", and "0days" values.Value
begins with: Tagged media that has one or more values beginning with the specified sequence of (case-insensitive)
characters will be matched: For example, specifying a  of "day" will match "DayOfWeek", but not "Monday".Value 
ends with: Tagged media that has one or more values ending with the specified sequence of (case-insensitive)
characters will be matched: For example, specifying a  of "day" will match "Monday", but not "DayOfWeek".Value 
is less than:(file size only) Media with a file size (in bytes) smaller than the specified value will be matched.

is greater than:(file size only) Media with a file size (in bytes) larger than the specified value will be matched.

is in the range:(file size, upload date, last modified date only) Media with a file size (in bytes), upload date, or last
modified date within the range of values will be matched.

is not in the range:(file size, upload date, last modified date only) Media with a file size (in bytes), upload date, or last
modified date outside the range of values will be matched.

is after:(upload date, last modified date only) Media that was uploaded or   after the specified date will belast modified
matched.

Note
You may want to tag media files before creating a Tagged Playlist. This will allow you to view which media files are included in the
Tagged Playlist while you define the tagging rules.

http://docs.brightsign.biz/display/DOC/Library+Tab#LibraryTab-last_modified_date
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is before:(upload date, last modified date only) Media that was uploaded or   before the specified date willlast modified
be matched.

in the last:(upload date, last modified date only) Media that was uploaded or   in the amount of time beforelast modified
the specified date will be matched. Specify an amount of time (in days, months, or years), along with the target date.

not in the last:(upload date, last modified date only) Media that was not uploaded or   in the amount of timelast modified
before the specified date will be matched. Specify an amount of time (in days, months, or years), along with the target
date.

Value: Enter a value to match with the tag value using one of the above conditions.

Use the dropdown list to determine how media files should be automatically ordered in the playlist. Use the firstContent Order Tag 
dropdown menu to select a tag: The values of this tag will be used as the ordering criteria. Use the second dropdown menu to determine
if the order should be ascending ( ) or descending ( ) alphabetically/numerically.ASC DESC
Click the  button to see how changing the media rules modifies the contents of the Tagged Playlist.Update Preview 
Reorder the playlist if needed by dragging and dropping media files. If newly tagged media is included in the playlist later on, it will be
added to the end of the playlist using the   settings outlined above.Content Order Tag
Select to save the playlist to your BSN account.File > Save 
Enter a  and click .Tagged playlist name  OK

You can also use the  menu to rename the Tagged Playlist ( ), retrieve a Tagged Playlist from your BSN account forFile  Save [playlist name] As..
editing ( ), or create a new Tagged Playlist ( ).Open Tagged Playlist New Tagged Playlist

Presentation States

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

In its simplest form, a presentation can contain image, video, and/or audio files. However, BrightAuthor also features a number of presentation sta
 that allow you to expand the functionality and versatility of your projects. For example, if you want to have dynamic, remotely updatable mediates

in your playlist, you can add a Media RSS Feed state to your playlist and point it at a hosted feed URL.

To add a state to your presentation, click the  tab under Media Library and drag the desired state into the playlist area.other 

Tip
Use the  tab to add a Tagged Playlist to a BrightAuthor presentation. Presentation Properties > Data Feeds

Note
You can add any state to an interactive playlist, but some states cannot be used in non-interactive playlists because they require
interactive input.

http://docs.brightsign.biz/display/DOC/Library+Tab#LibraryTab-last_modified_date
http://docs.brightsign.biz/display/DOC/Library+Tab#LibraryTab-last_modified_date
http://docs.brightsign.biz/display/DOC/Library+Tab#LibraryTab-last_modified_date
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Non-interactive states can be used in both interactive and non-interactive playlists. The following are non-interactive states:

Media RSS Feed

Local Playlist

RSS Feed and Static Text

Twitter

SignChannel

HTML5

Video Stream

Mjpeg Stream

Audio Stream

Live Video

RF In (ATSC)

Tuner Scan

 

 

MEDIA RSS FEED

BrightAuthor Version 4.6
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Previous Versions 

You can use Media RSS Feed states to display the content in  or MRSS feeds. An MRSS feed can be hosted on a third-partyDynamic Playlists

Note
 Though HTML5 states are not interactive, the HTML pages themselves feature full JavaScript interactivity: The JavaScript of a page
can interact with BrightSign hardware interfaces using .BrightScript-JavaScript objects

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
http://docs.brightsign.biz/display/DOC/Enabling+BrightScript-JavaScript+Objects
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server or the  (using the Live Media feature). MRSS feeds can be used to display image, video, audio, or  content.BrightSign Network HTML

Follow these steps to add an MRSS feed to your presentation:

Click the tab below .Other Media Library
Drag the  icon to the playlist area.Media RSS Feed 
Select a  from the dropdown list.  If you have not added a Data Feed to the presentation yet, click and followData Feed Add Data Feed 
these steps:

Enter a .Feed name
Under , do one of the following:Feed specification

To add an MRSS feed that's hosted on a third-party server, select and enter the URL for the MRSS feed.Url 

To add a BSN Live Media feed, select and choose the feed from the dropdown list.Live Media Feed 

To add a BSN Dynamic Playlist, select  and choose the feed from the dropdown list.Dynamic Playlist

Under Data feed content usage, select MRSS Feed.

Use the  dropdown menu to determine how often the player should check in with the server to update content inUpdate Interval
the feed.

Click  to add the MRSS feed to your presentation.OK
Click .OK

LOCAL PLAYLIST
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A Local Playlist allows you to customize which Dynamic Playlist is used in a presentation depending on the player. For example, if you are using
BrightSign players at a dozen different locations, and the locations require the same content except for variations in the content of the Dynamic
Playlists, you only need to create, edit, and update one presentation that uses a Local Playlist rather than a dozen that use different Dynamic
Playlists.

To add a Local Playlist to your presentation, click the tab in the . Then drag and drop the Local Playlist icon where you wouldOther Media Library
normally add a Dynamic Playlist.

State name: Enter a unique name for the Local Playlist state.

Default playlist: Specify a default Dynamic Playlist for players to use. If a player enters the Local Playlist sate and does not have a
Dynamic Playlist assigned to it, it will use the default Dynamic Playlist instead. If the default is set to  and a player is set to None Use

, then the player will skip the Local Playlist state and play the next item in the presentation playlist.default playlist
Playlist: Assign a Dynamic Playlist to each player connected to your BrightSign Network Account.

Important
If you are using the Media RSS Feed in an Audio Only or Enhanced Audio zone, ensure that the MRSS feed contains audio files only.

Tip
To use a Local Playlist, you first need to sign in to the BrightSign Network and add Dynamic Playlists to your presentation (via File >

).Presentation Properties > Data Feeds

https://www.brightsign.biz/digital-signage-products/brightsign-network
http://docs.brightsign.biz/display/DOC/Displaying+HTML+with+MRSS+Feeds
http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
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RSS FEED AND STATIC TEXT
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Ticker zones can be used to display dynamic text (RSS feeds) or static text feeds. You can also use a  state to display text over anLive Text
image or video.

RSS Feeds

RSS feeds are updated each time the BrightSign player connects to the specified RSS URL. An RSS Feed state can display either Live Text Data
or a third-party RSS feed. Follow these steps to add an RSS Feed to your presentation:

Select a Ticker zone in your presentation.

Click the tab and drag the  icon onto the playlist.RSS New RSS Feed
Select a  from the dropdown list.Data Feed

If you have not added the RSS feed to the presentation yet, click . Do the following:Add Data Feed
Enter a .Feed name
Under , select and enter the URL for the RSS feed.Feed Specification Url 
Under , select .Data feed content usage Text
Click  to ensure the RSS URL is working correctly.Validate
Use the  dropdown menu to determine how often the player should check in with the BrightSign Network serversUpdate Interval
to update the Live Data Feed.

Click  to add the to your presentation.OK Data Feed 
Click .OK

Text Feeds

Text Feeds are static text files located on the local storage of the player. Follow these steps to add a Text Feed to your presentation:

Create a  file (using Notepad or a similar program) that contains the text you wish to display..txt

Insert a line break between each text item in the .txt file.

Save the text file and place it in your Media Library folder.

Select a Ticker zone in your presentation.

Click the  tab in the .Text Media Library
Drag the text file into the playlist.

 

TWITTER
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You can use your Twitter account to create a data feed from a remote source. Twitter feeds can only be used in a Ticker zone. To add your
Twitter feed to a presentation, select a Ticker zone, click the  tab, and drag the   icon onto the playlist.RSS Twitter

Twitter User Name: Enter your Twitter user name and click . When prompted to authorize BrightSign to use your TwitterAuthenticate
account, enter your Twitter account login information and click .Authorize app
Update Interval: Use the dropdown list to specify how often the player should check your Twitter feed for updates.

Only show the most recent number of tweets: Check this box if you want to limit the tweets displayed in the Ticker zone to only the
most recent. Specify in the field how many recent tweets can be displayed.

SIGNCHANNEL
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To add a SignChannel state, select a Video Only zone or a Video or Images zone. Under the tab, drag the icon to the playlist  Other SignChannel 
area.

Tip
This  shows the basics of adding a Twitter state to a Ticker zone. tutorial video

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
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You can use the BrightSign XT, 4K, XD, HDx23, and HDx22 models to display HTML web pages, including video, image, text, and JavaScript
elements. For a full explanation of how to create and publish HTML content for BrightSign players, please see the  section.HTML5 Development

State name: Specify a name for the HTML state.

HTML5 Site: Select an HTML site from the dropdown menu. To populate this list with sites, navigate to File > Presentation Properties >
.HTML Sites

Enable external data: Check this box if your HTML page uses assets from multiple locations.

Enable mouse and touch events: Check this box if you want to enable interaction with the HTML5 page (clicking on links, interacting
with JavaScript elements, etc.). 

Display cursor: Check this box to display a cursor whenever a USB mouse is connected to the player.

Custom fonts: Click to add custom TrueType Font ( ) files to the HTML page. When the presentation is published, the fontAdd Font .ttf
file(s) will act as though they are located in the same file directory as the  file (i.e. they can be accessed with the standardindex.html
font-family attribute in HTML/CSS). If no custom fonts are specified, text in an HTML page is displayed using the default system font.

Enable native video plane playback: Check this box to enable  on all  elements contained within the page. ThisHWZ mode <video>
increases the frame rate and quality of HTML video playback, but can also cause problems with CSS page transforms and other page
elements. By default, it will place the video on top of all other video and graphics in the presentation.

Specify user stylesheet: Specifies a user stylesheet for the HTML page associated with the state. Use the button to select the Browse .
file you wish to utilize as the user stylesheet. Every HTML5 state can have a different user stylesheet, even if the states are beingcss 

used to display the same HTML5 page.

VIDEO STREAM
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This state allows you to play an IP stream. All networked players can play streaming video. See  to learn more about supported videothis FAQ
formats and codecs for IP streaming.

Note
You can only use one zone per presentation to display SignChannel content.

Important
BrightSign models are not designed to be used as general-purpose web browsers. Many web pages have elements that will not display
correctly on a BrightSign player. Make sure to thoroughly test a web page before using it as digital signage.

Note
HTML video content will play even if it is embedded in an Images zone.

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
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State Name: Specify a unique name for the stream state.

URL for video stream: Enter a valid URL for the stream. The URL can also include a number of optional parameters:

Specify a  to replace all or part of the URL. To include the Value of the variable in the URL, enter the variableUser Variable
Name between two sets of dollar signs (e.g. " ").http://www.example.com/streams/$$my_URLvar$$

Append the "?latency=[value_in_ms]" parameter to modify the default latency (see  for more details).this FAQ

Append the "?buffersize=[size_in_bytes]" parameter to modify the default streaming buffer size (see  for more details).this FAQ

Time on screen: Specify the duration (in seconds) that the stream will be played. This option is only available in non-interactive
presentations. To customize the duration of a stream in an interactive presentation, use a  or  event.Timeout Media End

MJPEG STREAM
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All networked players can play streaming Mjpeg video. See  to learn more about supported video streaming formats and codecs.this FAQ

State Name: Specify a unique name for the stream state.

URL for video stream: Enter a valid URL for the stream. The URL can also include a number of optional parameters:

Specify a  to replace all or part of the URL. To include the Value of the variable in the URL, enter the variableUser Variable
Name between two sets of dollar signs (e.g. " ").http://www.example.com/streams/$$my_URLvar$$

Append the "?latency=[value_in_ms]" parameter to modify the default latency (see  for more details).this FAQ

Append the "?buffersize=[size_in_bytes]" parameter to modify the default streaming buffer size (see  for more details).this FAQ

Rotation: Specify the clockwise rotation of the streaming video.

Time on screen: Specify the duration (in seconds) that the stream will be played. This option is only available in non-interactive
presentations. To customize the duration of a stream in an interactive presentation, use a  or  event.Timeout Media End

AUDIO STREAM
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All networked players can stream audio from a remote source. For more information on supported formats, codecs, and bitrates, please see the A
.udio Streaming Support FAQ

State Name: Specify a unique name for the stream state.

URL for video stream: Enter a valid URL for the stream. The URL can also include a number of optional parameters:

Specify a  to replace all or part of the URL. To include the Value of the variable in the URL, enter the variableUser Variable
Name between two sets of dollar signs (e.g. " ").http://www.example.com/streams/$$my_URLvar$$

Append the "?latency=[value_in_ms]" parameter to modify the default latency (see  for more details).this FAQ

Append the "?buffersize=[size_in_bytes]" parameter to modify the default streaming buffer size (see  for more details).this FAQ

Time to play: Specify the duration (in seconds) that the stream will be played. This option is only available in non-interactive
presentations. To customize the duration of a stream in an interactive presentation, use a  or  event.Timeout Media End

LIVE VIDEO
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The 4K1142, XD1132, and XD1230 models support Live Video through the HDMI Input port. To add a Live Video state, select a Video or Images
or Video Only zone, click the tab, and drag the icon to the playlist area.Other Live Video 

Volume: Specify the volume of the video input (between 0 and 100).

Time on screen: Specify the amount of time the video input is displayed on screen.

Overscan: Check this box to display the video input beyond the edges of the zone. Use this option if the source video signal is using an
overscan setting.

Note
Unlike other video types, there is no limit on the amount of Mjpeg streams you can display on screen. However, adding more than a
certain number of windows (depending on the player model and stream quality) will begin to reduce the framerate of the videos.

Note
 We do not recommend displaying a Live Video state at the same time as an   state (in two different video zones, for example).RF In
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RF IN (ATSC)

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

This state displays live video that is passed to the BrightSign player through the RF Input. This feature is available only on the  . BeforeXD1230
you can display video from the RF Input, you must first perform a channel scan on the player while it is connected to the cable source: You can do
this prior to publishing the presentation (via the  interface) or during the presentation (via the  state).RF Channel Scan Tuner Scan

If you’ve already performed a channel scan on the player, you can use the “ScannedChannels.xml” file generated by the scan on the SD card to
enable the Channel name and Select different virtual channel options:

Click the button next to .Browse Specify RF channel scan file
Locate the SD card or USB flash drive you used to perform a channel scan on the player.

Open the “ScannedChannels.xml” file located in the root directory.

Specify the following:

Select channel: Determine which channel will be played upon entering the RF In state:

First scanned channel: Displays the first channel detected during the channel scan (i.e. the smallest detectable channel
number).

Channel name: Displays the channel with the specified name. To use this option, you must first specify a
“ScannedChannels.xml” file in the  field.Specify RF channel scan file
Virtual channel: Displays the channel based on its virtual number:

Current virtual channel: Manually enter the virtual number of the channel. You should only use this number if you are
familiar with the channel map of the cable source.

Select different virtual channel: Select the virtual number of the channel based on the results of the channel scan. To
use this option, you must first specify a “ScannedChannels.xml” file in the Specify RF channel scan file field.

User variable: Displays the channel based on the value of a User Variable. The system software can recognize both channel
name and virtual channel number as the value of a User Variable. Before you can enable this option, you must first designate
one or more User Variables.

On entry to this state: Determine what should happen when playback enters the RF In state:

Remain on last tuned channel: The player remains on the same channel that was displayed the last time the presentation was
in the RF In state. The state will use your  settings if it is the first time the presentation is entering the RF In state.Select channel
Retune as specified above: Choose this option if you would like the player to retune using your  settings everySelect channel
time the presentation enters the RF In state.

Event that triggers channel up: Specify an event trigger that will flip up through channels.

Event that triggers channel down: Specify an event trigger that will flip down through channels.

Overscan: Check this box to display the video input beyond the edges of the zone. Use this option if the source video signal is using an
overscan setting.

Note
The RF In state was changed significantly in BrightAuthor version 3.7.0.12. If you have an RF In project from an earlier version of
BrightAuthor, you will need to recreate the presentation with a new version of BrightAuthor.
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TUNER SCAN
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You can use the Tuner Scan state to perform a channel scan of the cable source while an interactive presentation is running. Use a  evMedia End
ent to exit this state once the channel scan concludes. If you use another interactive event (e.g. Serial Input, UDP Input) to exit the Tuner Scan
state before it concludes, the scan will be canceled and the results will not be written to the player.

Channel Map: Select QAM, ATSC, or ATSC and QAM (consult your service provider for details).

Modulation Type: Select QAM 64, QAM 256, or QAM 64 and QAM 256 (consult your service provider for details).

First RF Channel (optional): You can choose to limit the range of the channel scan by selecting the first channel to scan.

Last RF Channel (optional): You can choose to limit the range of the channel scan by selecting the last channel to scan.

Interactive States

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

Interactive states can be used in interactive playlists only. The following are interactive states:

Media List, Video List, Image List, Audio List

Video Play File, Image Play File, Audio Play File

Live Text

Interactive Menu

Event Handler

Super State

 

Tip
 A   event will trigger on an RF In state only if the video bit rate of the tuner input drops to 0Mbs.Media End

Note
We do not recommend displaying an RF In state at the same time as a   state (in two different video zones, for example). Live Video

Note
Each channel takes approximately one second to scan. Specifying upper and lower limits will reduce the amount of time it takes to
perform the scan. You should only use these two options if you are familiar with the channel map of the cable source.
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MEDIA LIST, VIDEO LIST, IMAGE LIST, AUDIO LIST

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

The Media List, Video List, Image List, and Audio List states are convenient tools for defining interactive events with many files. They allow you to
compile your files into one group that appears as a single thumbnail in your playlist area. By default, each time the playlist transitions to a list
state, the next file in the list will play and exit the list after a timeout (images) or when the file finishes playing (video and audio). Alternatively, you
can set the list to shuffle files or cycle through every file in the list before exiting and transitioning to the next state.

You can edit properties of these states under > > . File Presentation Properties Media List

First, make sure your playlist is set to  . Then, drag a Media List, Video List, Image List, or Audio List icon onto the playlist area. YouInteractive
can then set the following parameters for your list:

Media list name: Create a unique name for the list.

Set as initial state: Check this box to make the list your Home Screen.

Advance to next item on Media End event:(Media Lists, Video Lists, Audio Lists) Check this box to have the list cycle to the next file
after an audio/video file ends. If you leave this box unchecked, the list will play one audio/video file each time it is transitioned to,
remaining on that file until the playlist transitions away from the list.

Advance to next item on Image Timeout:(Media Lists, Image Lists) Check this box to have the list cycle to the next file after an image
times out. If you leave this box unchecked, the list will display one image each time it is transitioned to and then transition away when the 

interval is reached.Image Timeout 

Image Timeout (seconds): (Media Lists, Image Lists) Specify the length of time each image remains on screen. You can also use
decimal values to specify the image timeout in milliseconds (for example, 1.500 = 1500msec).

Play from beginning on entry to state: Check this box to have the list start from the beginning each time it is transitioned to. This box is
only enabled if you have checked the above box (unless you are using an Enhanced AudioAdvance to next item on Media End event 
zone) or box. If you leave the  box unchecked,Advance to next item on Image Timeout  Play from beginning on entry to state
subsequent transitions to the list will play the next file in the list.

Start Index: Specify which item in the list should count as the beginning of the list. When the list plays from the beginning (see the Play
 option above), it will play from the item index specified here. When non-shuffled playback reaches thefrom beginning on entry to state

end of the list, it will loop back to the top of the list (i.e. start index 1), rather than the specified .Start Index
Shuffle playback: Check this box to randomize the order of media items in the list each time it is transitioned to.

Event to transition to next item: Select an interactive event that allows the user to transition to the next file in the list. After selecting the
event type, you must specify a trigger.

Event to transition to previous item: Select an interactive event that allows the user to transition to the previous file in the list. After
selecting the event type, you must specify a trigger.

Note
An Audio List in an  cycles through all files in the list by default, so the   eve Enhanced Audio zone Advance to next item on media end
nt option is not available for Enhanced Audio zones. In an Enhanced Audio zone, a Media End event attached to an Audio List will only
trigger once all files in the list have been played.

Note
Like the  event, commands for the trigger must be sent from another player on the local network.Synchronize Synchronize 
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Transition:(Media Lists, Image Lists) Specify the transition effect that will occur when the image timeout triggers.

Transition duration:(Media Lists, Image Lists) Specify how long the image-transition effect will take to complete. This duration should be
less than the amount of time the image is displayed on screen.

Send Zone Message (using file name as parameter) prior to showing each item: Check this box to send a  commandZone Message
every time there is a file transition in the list. The Zone Message string will consist of the filename (without the file extension) of the media
item that is being transitioned to.

Populate from media library: Select this option to populate the list using content stored on your computer.

Media Library: Click to select the folder that contains all the files you want to include in the list.Browse 
Media Files: Add individual files to the list by clicking the   button and using the dropdown list. Only files contained inAdd File 
the folder you selected above will be available in the dropdown list. Alternatively, you can click Add All Content From Media

 to add all compatible media files from the directory specified in the field. Once you've added the desiredLibrary Media Library 
files to the list, you can customize playback order using the up and down arrows. You can also remove individual files using the 

buttons, or remove all files using the button.X Delete All 
Populate from data feed: Select this option to populate the list using media files specified in an RSS feed (this feature does not support
MRSS feeds). You will first need to add the RSS feed to your presentation by navigating to .File > Presentation Properties > Data Feeds
When adding the Data Feed, you must set the to Data feed content usage  Content for Image List, Audio List, Video List, or PlayFile
. Upon playing the presentation, the player will retrieve the media from the download URLs specified in the  field of each item in theValue
Data Feed (i.e. the RSS  field).<description>

VIDEO PLAY FILE, IMAGE PLAY FILE, AUDIO PLAY FILE

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

Play Files allow you to combine media files into a single state in the playlist area. You can then use the interactive event that transitions to the
Play File to conditionally determine which file in the playlist should be played.

Play Files can only be transitioned to using input from BP900/BP200, UDP, Serial, Keyboard, or USB devices. The input data from the controller
will determine which media item in the Play File will be played: For example, you can use a Keyboard Input event to playback “Video 1” if the “A”
key is pressed, “Video 2” if the “B” key is pressed, "Video 3" if the "C" key is pressed, etc. Any type of event can transition out of a Play File state
and into a new state.

Note
If you leave event transitions on "None", audio/video files will transition at media end and images will transition at timeout. 

Note
For BP200/BP900 events, you must specify each   using both the panel enumeration and button number: For example, if you have aKey
single BP200/BP900 panel connected to the player and want button 3 to trigger an image, you would specify the   as "0-3"; on theKey
other hand, if you have a second BP200/BP900 panel connected to the player and want button 3 on the second panel to trigger the
image, you would specify the  as "1-3".Key 
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Make sure you use zones that match the Play File type you want to use. After setting your zone to  and dragging a Play File icon to theInteractive
playlist area, the Play File window will automatically open. Here you can set the parameters for your Play File list.

State name: Create a unique name for the Play File state.

Transition (Image Play Files only): Use the dropdown list to create a special effect when the playlist transitions to an item in the Play File
state.

Specify Local Files: Select this option if you would like to create the Play File using files from your computer. If you choose this option,
the Play File table will remain static when it is published to the player; the only way to change it is to republish the presentation. The Spec

 option (described below) allows for dynamic Play File tables.ify data feed
Display default media if input does not match any keys: Check this box to display the specified media file when the input
data does not match any existing keys in the Play File state. If this box is not checked, nothing will happen when the input data
does not match an existing key.

Use variable to specify key: Check this box to have a  specify the media-file key. The input data from theUser Variable
controller will be ignored, though input of some kind must be received to trigger the interactive event. For example, if a Keyboard
event is attached to a Play File state and this option is enabled, any key press will initialize a transition to the Play File state; the
value of the specified User Variable will then be checked against the keys in the Play File to determine which file, if any, should
be played.

Add File: Click this button to add media items to the Play File.

Files: This list displays files added to your Play File. Each file has a  and .Key File Path

Key: The value that will trigger playback if it is matched by the input from the interactive event. Because you define the
triggers with the keys in the Play File, you do not need to specify the triggers again when creating a transition to the Play
File. For example, if you define a USB Input event that links an item to the Play File, the option to  wilSpecify USB Input
l be disabled and replaced with "<any>". When a user performs an event via USB that matches a key, the corresponding
file will play.

Label: The label of the interactive button as it will appear in the BrightSign App.

Show in BrightSign App: Check this box if you want to display the media item as a button in  instancesBrightSign App
that connect to the player. The button will only appear in the app if a UDP Input event transitions to the Play File state.

File Path: The location of the media file on your computer. Click the  button to locate the file you wish to use.Browse

Display Mode (Video Play Files only): By default, files are set to 2D, but if you are using a 3D video, you can select 3D
 or  when adding your files.side-by-side 3D top-over-bottom

Import Table: Click this button to import a previously created Play File table ( file). Navigate to your saved table and click .csv Op
to add the files to your Play File list. This table must have the "Key", "File Path", "File Name", and "Video Display Mode" (ifen 

applicable) properly outlined. You can use a table that was exported from another Play File state with the  function,Export Table
or you can create a Play File table using .Notepad or Excel

Export Table: Click this button to create a file that includes information about the current Play File table. This file can then.csv 
be imported to other Play File states that use the same media type.

Specify data feed: Select this option if you would like to populate the Play File using media files specified in an RSS feed. You will first
need to add the RSS feed to your presentation by navigating to . You will also need to set theFile > Presentation Properties > Data Feeds

 for use with Play Files. When playing the presentation, the player will retrieve the media from the downloadData feed content usage
URLs specified in the  field of each item in the RSS feed, and the Play File will use the value in the  field to<description> <title>
determine the key that triggers the media item to play.

Note
If you attach a command that modifies the User Variable value (e.g. Set Variable, Increment Variable) to an event that transitions to the
Play File state, the media-file keys will still be compared against the old variable value. However, if the  option isDisplay default media 
enabled, the new User Variable value will be used instead.
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LIVE TEXT
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Customizing the Text Parameters

Layering Items

Live Text with Video 
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A Live Text state consists of an image overlaid with various text fields and/or media. You can layer both static text and updatable RSS and MRSS
content on top of images and customize the position/size of items in relation to the background. You can even use Live Text to overlay content on
top of a video in another zone.

To add a Live Text state to your presentation, drag the Live Text icon from the tab to the playlist area and set the following parameters:Other 

State name: Enter a unique name for the Live Text state.

Set as initial state: Check this box to make the Live Text state your Home Screen.

Background Image: Click to locate and select a background image for your Live Text.Browse 

Update Live Text Data: Click this button to have all Live Text Data fields display their current value.

Changing the Size/Positioning of a Live Text Item

Click the 

button to add a new text/media item to the Live Text canvas. You can then edit the size and positioning of the item:Add Item 

Size: Adjust the size of a text field or item.

W: The width of the text field or item

H: The height of the text field or item

Position: Adjust the position of a text field or item.

X: The position of the text field or item on a horizontal axis

Y: The position of the text field or item on a vertical axis.

Note
Image Mode settings that would normally crop displayed images (i.e. “Center Image” and “Scale to Fill and Crop”) are not applied to the
background image of a Live Text state. To get consistent performance between images and Live Text states, you will need to resize
images accordingly.
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Offset next: Check this box to set an initial position for new items in relation to the most recently created item. Input the offset distance
for the next text item in the and fields.X Y 

Selecting the Item Type

Use the dropdown menu to select the source of the content in the selected item:Type 

Fixed Text: Displays simple, static text. A text field will appear below , where you can type your customized text. As you type,Text Type
you can view the text in the preview image.

System Variable: Displays the device serial number, firmware version, script version, or other  value. Use the dropdownSystem Variable
list to determine which value you would like to display.

Live Text Data: Displays content from a  in the text field. The displayed Data Feed item will remain fixed and will not cycleData Feed
through feed items like an RSS ticker (use the RSS Feed type for this functionality). However, you can still update the text in real time by
modifying the feed on the server and changing the description associated with the item title or index.

Add Data Feed: Click this button to add a Data Feed to your presentation. You can use any feed type (RSS, Live Data Feed,
MRSS, Dynamic Playlist) as Live Text Data, but you must specify the  as when adding the DataData feed content usage Text 
Feed.

Data Feed Name: Select the desired Data Feed from the dropdown menu.

Item title: Specify the feed item to display using the Title/Name of the item.

Item index: Specify the feed item to display using the index number of the item.

Media Counter: Displays how many times a file in the presentation has played. Each Media Counter field must correspond to a specific
file. Use the dropdown list to pair the field with a file in the presentation. To use this feature, Media Counters must first beMedia Counter 
enabled: Navigate to >  >  and check the box labeled File Presentation Properties Variables Automatically create media counter

.variables
User Variable: Displays the current value of a User Variable. Use the dropdown list to specify a User Variable for the text field. To use
this feature, you must first .create a User Variable

RSS Feed: Displays content from an RSS feed. To edit the amount of time each RSS item is displayed, click  andSet Text Parameters
modify the  field.Time to Display Each Line

Note
 You can also click and drag the text fields in the preview area to adjust sizing and position.

Note
When you use the  , subsequent RSS text fields will automatically contain the next item in the index (i.e. the previous indexItem index
number + 1).
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a.  

Update RSS URL List: Click this button to create a list of  to use as RSS sources.Data Feeds

Display RSS title: Check this box to display the title of the RSS item.

Display RSS description: Check this box to display the description of the RSS item.

Media RSS Feed: Displays content from a Media RSS (MRSS) feed.

Update Media RSS URL List: Click this button to create a list of Data Feeds to use as MRSS sources.

Display Media RSS title: Check this box to display the title of the MRSS item.

Display Media RSS description: Check this box to display the description of the MRSS item.

Display Media RSS media: Check this box to display the media item associated with the MRSS item.

Custom fields: If your MRSS feed contains custom text fields, this section will allow you to show or hide the custom fields as
required.

Image: Select this option to display an image over the background image. Select Browse to locate an image file to use in this item.

Validate Live Text Data: Click this button to verify that the source URL for the selected Live Text Data item is valid.

Customizing the Text Parameters

Click the  button to customize the parameters for a selected field. Set Text Parameters

Alignment: Use the dropdown list to set whether the text is left aligned, right aligned, or centered.

Foreground text color: Click  to select a color for the text.Choose 
Background text color: Check this box to include a background color for text fields. Click  and set a default color for theChoose 
backgrounds.

Transparency: Drag the bar to set the transparency for the background text color. 

Font: Click   to locate and select a font for the text. You can use any TrueType font. Click   to reset the fontBrowse Reset to System Font
to the default.

Font size: Select   to fit the text to the height of the text field, or select  to enter a value for the font size (1 -Automatic Fixed point size 
500).  

Note that the default parameters of a text item will differ depending on how it is created:

The first text item will use the default text parameters set in the  window ( ).Edit Preferences Edit > Preferences > Live Text
If you create a text item while another text item is selected, the new text item will inherit the parameters of the selected text item.

If you create a text item without another text item selected, the new text item will inherit the parameters of the last created text
item.

Layering Items

Use the  buttons to determine the layering of your Live Text elements. The background image is always displayed behind all elements.Layer

Note
Transparency does not appear in the Live Text image preview or in Presentation Preview. You will need to publish the
presentation to a BrightSign player to view the level of transparency.

Important
The LS422, HD120, HD220, and HD1020 models support a limited number of Live Text items with custom font. If you need to
display many items simultaneously, either display them with the system font or upgrade to another player model: The XT, 4K,
XD, HDx23, and HDx22 models support any practical number of text items with custom font.

Note
If you choose to include a  , the   setting will be enabled, allowing you to edit the transparency ofBackground Text Color Transparency
the Background Text Color. If you choose not to include a  , characters in the text fields will appear over theBackground Text Color
elements beneath it.
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Sends the selected element behind all other elements.

Sends the selected element behind the element that is directly beneath it.

Sends the selected element in front of the element that is directly in front of it.

Sends the selected element to the front of all other elements.

Live Text with Video 

You can use a Live Text state to layer text and images over video. To do so, you must add the Live Text state to a Video or Images or Images
zone, and place it on top of a Video Only zone. To help you position text over the video, we recommend using a screenshot from the video you
want to use. Complete the following steps:

Under , click .Layout Add Zone
Click  to add a Video Only zone. Add Zone
Click again to add an Images or Video or Images zone.Add Zone 
Set the  of the Images zone to .Graphics plane z position Front
Resize the Images zone so that it completely covers the Video Only zone.

Click the  tab and select your Video Only zone.Playlist
Drag the desired video file from the  to the playlist area.Media Library
Make the zone .Interactive

Use the dropdown list to select the Images zone.

Make the zone .Interactive
Drag the icon from the tab to the playlist area.Live Text Other 

Click the  icon to open the window.Live Text Add Live Text 
Click beside .Browse Background Image
Locate and select the screenshot image file taken from the video file used in the Video Only zone.

Click .Add Text Item
Adjust the and of your text field by clicking and dragging over the preview image or inputting exact numbers in theSize Position 
corresponding fields.

Select your  and input the desired text.Text Type
Click  and edit text parameters as desired.Set Text Parameters
Click when finished.OK 

Repeat step 5 for each text field you wish to add.

When all text fields are in place, click next to  .Clear Background Image
Click .OK

Clearing the Background Image removes the image from the zone. The text fields will appear directly over the video. By temporarily including a
Background Image taken from the video, you can better position the text fields in relation to the video playing behind the Images zone.

INTERACTIVE MENU
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ON THIS PAGE

General

Menu Items                    

Navigation

Enter

Interactive Menus are DVD-style menus that users can navigate with interactive events. By linking media to items to the Interactive Menu, you can
allow users to interactively transition to a new state of their choice. Because Interactive Menus can serve as a bridge to many media items and
outline all selections available to the user, they make great Home Screens.

To create an Interactive Menu, add a Video or Images zone to your presentation. Set the zone to  and drag the Interactive Menu iconInteractive
from the tab to the playlist area. Other 

General

This tab allows you to select an image for your Interactive Menu and define how a user navigates it.

State name: Create a unique name for your Interactive Menu state.

Background Image: Click to select an image to use as the menu display. Browse 
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Set as initial state: Check this box to set the Interactive Menu as the Home Screen.

The  section is where you define how a user navigates among items in the menu. Click the dropdown menu for each option (Up,Navigation
Down, Left, Right, Enter, Back, Next clip, Previous clip) and select the interactive input that will trigger this action (GPIO Event, Serial input, etc.).
A second dropdown menu or text field will appear. Specify the button or input you want to correspond to the action.

Let’s say you want to define how to move in the menu, and you want to use the "U" key on the connected keyboard. In the  dropdown list,Up Up
select . A text field will appear below where you can specify a button. Type “U” in the text field. Now, when a user presses “U” onKeyboard Input
a keyboard, the cursor will move up along the menu items. If you don't wish to define an action, you can simply leave the dropdown list on the
default .None

 The following actions can be defined in the Navigation section:

Up, Down, Left, Right: These are the primary actions a user will perform to navigate from one menu item to the next.

Enter: When a user enters the defined input on a menu item, a media file you have chosen in the tab will play.Menu Items 
Back: The user can enter the defined input to return to the menu at any point.

Next clip: If a user is viewing a media file associated with a menu item, using the defined input will play the media file that corresponds to 
the next menu item.

Previous clip: If a user is viewing a media file associated with a menu item, using the defined input will play the media file that 
corresponds to the previous menu item.

Menu Items                    

This tab allows you to create menu items and specify how a user navigates around the menu.

Menu Item Number: Every menu item has a unique menu item number: The first item you create is 1, the second is 2, and so on. Here
you can navigate among the menu items you have created by clicking the and buttons. All other options belowPrevious Next 
correspond to the menu item you have selected.

Add Menu Item: Click to create a new menu item. The window will open.Add Menu Item 
Active Image: This image serves as a cursor to visually inform the user what menu item is currently selected.

Inactive Image: This image appears beside the menu item when the user has another menu item selected.

Important
The background image is not simply a background for menu items; it must contain all images and text you want displayed in
the menu.



Position: Adjust the position of your menu item by inputting specific numbers. Alternatively, you can click the active image in the preview
image and drag it to the desired position. The inactive image will appear in the same spot when the menu item is not selected.

X: The position of the menu item on the horizontal axis.

Y: The position of the menu item on the vertical axis.

Offset next: Check this box to specify an initial position for new menu items in relation to the most recent menu item.

X: The amount of offset on the horizontal axis.

Y: The amount of offset on the vertical axis.

Selected Image: Click to change the active image.Browse 
Unselected Image: Click to change the inactive image.Browse 
Store image in cache: Check this box to store the corresponding image in the player cache. This ensures that the image will load quickly
when switching between active/inactive states. Note that the player cache is limited—  for more details.see this FAQ

Navigation

The  section is where you determine how a user moves from one menu item to the next. Although the actions were previously defined Navigation
in the tab, this is where you specify how actions navigate among the specific menu items. The possible actions are , , , and General  Up Down Left

. Each action has a dropdown list that displays the menu item number for each created menu item. By default, is selected for each.Right None 

Selecting a number in the dropdown list will allow the user to navigate from the current menu item to the specified menu item by performing the
corresponding action. Let’s say you are editing menu item number 1. If you click the dropdown list for the  action and select 2, the user canDown
now navigate from Menu item 1 to Menu item 2 by pressing the button. Remember, the buttons correspond to whatever you previouslyDown 
defined in the  section of the tab.Navigation General 

Enter

The  section is where you determine what happens when a user presses the button on a particular Menu item. Select one of theEnter Enter 
following:

Play clip: Plays the specified media item when the user presses the button. Use the  button to select a media item. If youEnter Browse
select an image, the following options will be available:

Image timeout (seconds): Specify how long the image should be displayed before returning to the interactive menu.

Store image in cache: Check this box to store the image in the player cache. This will ensure that the image loads quickly. Note

Tip
If you want nothing to appear beside a menu item when it is not selected, choose an Inactive image that matches the
color of the background.

http://support.brightsign.biz/entries/20474768-How-many-images-can-I-preload-using-the-Image-Cache-feature-


that the player cache is limited—  for more details.see this FAQ

Transition to new state: Transitions out of the Interactive Menu state and into a new state when the user presses the button. UseEnter 
the dropdown list to select a state from the presentation playlist.

Return to prior state: Returns to the previous state (i.e. the state that transitioned to the Interactive Playlist) when the user presses the 
 button.Enter

Remain on current state: Does not change states when a user presses the button. However, you can add commands to specifyEnter 
changes that occur while remaining on the Interactive Menu. Click the tab to reveal the  menu. Advanced Commands

 

EVENT HANDLER
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In some scenarios, you might want your presentation to sit at a blank screen. The Event Handler fills the role of an empty placeholder in your
presentation. Here are a few cases where an Event Handler would be useful:

You want a blank screen for a Home Screen so no content will play until the presentation is activated.

You want to add a  that is performed before the first file in the presentation plays.command

You want the presentation to sit at a blank screen when finished, instead of looping.

Although Event Handlers contain no content, you can add commands and interactive events into and out of them. For example, if you set an
Event Handler state as the Home Screen and define a  event linked from the Event Handler state to the first presentation item, the displayBP900
will sit at a blank screen until a user presses the BP900 button, and then the first item will begin playing. Alternatively, if you set an Event Handler
as the Home Screen and add a  command to it, you can synchronize your presentations and/or displays before the first files beginSynchronize
playing.

To use an Event Handler, click the tab under Media Library and drag the icon into the playlist area.Other 

State Name: Enter a unique name for the Media Handler state.

Stop Playback: Check this box if you would like audio/video playback to end once a media file transitions to the Event Handler state. If
this box is left unchecked, audio/video playback will continue after a transition to the Event Handler state.

Set as initial state: Check this box to make the Event Handler the Home State of the presentation.

 

Define interactive events into and out of the Event Handler as you would with any other state. If you define a Media End event after a video and
link it to an Event Handler, the presentation will sit at a blank screen when the file finishes playing.

 

SUPER STATE
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If you need to create large, complex interactive playlists, you will likely run into two problems: You’ll find yourself having to create a large number
of redundant events, and it will become difficult to keep track of numerous branching states and conditions. Super States are implemented to
alleviate these problems and make complex interactive presentations manageable.
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The primary mechanic of the Super State is that it functions as both a state and a self-contained interactive playlist. A Super State can be
transitioned into and out of using any event, but clicking on it will reveal a new interactive playlist canvas contained within the original. There are
several behaviors that are unique to this state:

Each Super State contains a Home State: A transition to a Super State will point to the initial state within the Super State by default.
However, you can point the transition to any other state within the Super State by opening the event and selecting the desired state from
the  dropdown menu.Specify next state
Super States can be nested inside other Super States: You can use the breadcrumb trail above the playlist area to keep track of where
you are within the hierarchy of Super States.

Super States can have Entry and Exit Commands: Entry Commands are triggered when any state within the Super State is transitioned
to. If a Super State is contained within one or more other Super States, a transition to or from that Super State will trigger Entry/Exit
commands on all other Super States that will need to be moved through for the transition to reach its destination. Commands will be
executed in sequential order, depending on whether the transition is ascending or descending through a hierarchy of Super States.

You can copy, paste, export, and import Super States: All events, states, commands, and other Super States contained within the Super
State will be copied over as well.

 

Interactive Events
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Interactive events link states in the playlist and determine what must occur before one state transitions to another. See the Interactive
 page to learn how to add events to your interactive playlist.Presentations

User Defined Events
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ON THIS PAGE

Creating and Editing User Defined Events

Adding User Defined Events to your Playlist

Importing and Exporting User Defined Events

This feature allows you to save interactive events you use often so that you can access them more readily in the future. User Defined Events save
both the event type and event parameters. For example, if you frequently use a 5 second Timeout event, you can create a User Defined Event
with this specification. In the future, instead of having to set each Timeout event to 5 seconds, you can use your previously created User Defined
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Event.

Additionally, you can group multiple events into a User Defined Event. Any event within the User Defined Event will cause the desired transition.
This will save you time by eliminating the need for defining multiple events that perform the same transition.

Creating and Editing User Defined Events

To create or edit a User Defined Event, select the tab under  and click . The windowuser events Media Library Manage Manage User Events 
will open. This window contains a list of all previously created User Defined Events. Do any of the following:

Create a new User Defined Event: Click   . When prompted, type a unique name for your User Defined Event. Click  Add User Event Add
and use the dropdown list to select an interactive event. Repeat for each event you want included in the User Defined Event. Click Event 

when you are finished.OK 
Edit a User Defined Event: In the  window, click the name of the User Defined Event you wish to edit. Make the Manage User Events
desired changes in the window.User Event 
Organize User Defined Events: Click the arrows to arrange the order of the list by moving a User Defined Event up or down.

Delete User Defined Events: Click the  beside a name in the list to delete a single User Defined Event, or click to erase theX Delete All 
entire list.

Adding User Defined Events to your Playlist

To add a User Defined Event to your interactive playlist, select the tab under . Drag the desired event icon from theUser Events Media Library
list onto a state. In the  window, specify the desired transition behavior. You can also add  to a User Defined Event after it hasEvents commands
been assigned to a state.

Importing and Exporting User Defined Events

You can import and export your User Defined Events. Since User Defined Events are created on a per-presentation basis, the import/export
feature allows you to save your User Defined Events and transfer them to new presentations as needed.

To import or export, click  or . If you are importing, browse to the location where the eventsFile > Import User Events File > Export User Events
definition XML file is stored. If you are exporting, browse to a location where you want to export all User Defined Events currently defined for your
presentation.

 

 

Timeout
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The Timeout event displays a state for a predetermined period of time before an action occurs. In the  field, specifySpecify timeout (seconds)
the number of seconds the state should display before the action occurs.
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Media End
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The Media End event specifies the action that occurs when a video file or audio file reaches the end of playback. Media End events can also be
applied to the following states: Video List, Audio List, Video Playfile, Audio Playlist, Media RSS, and Signchannel.

BP900/BP200

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

The BP900 and BP200 events specify the action that occurs when a specific BP900 or BP200 button is pressed. The BP900 and BP200 button
 are LED-based touch devices that allow you to add interactivity to your BrightAuthor presentations. These button panels are compatiblepanels

with any BrightSign player that has a USB port.

Enumeration

There are a total of six event icons: BP900A, BP900B, BP900C, BP200A, BP200B, and BP200C. The letters A, B, and C correspond to USB
ports. If the event you are defining is for a button pad connected to USB port 1, use A. If it is for a button pad connected to the second port, use B.
Let’s say you are using an XD1132 and, therefore, have two available USB ports. If you want to connect two button boards, a BP900 and a
BP200, you would use the BP900A and BP200B icons to define events for each.

Defining BP900 and BP200 Events

Once you've added a BP900/BP200 event to your presentation, determine the parameters that will activate it:

Specify Button Number: Select a button on the button pad that you want the user to press to transition to the next state.

Important
Selecting  will enable only the button numbers used in other BP200 or BP900 events in the presentation (or numbersAny Button 
enabled in the   window): For example, if you have defined BP900 events for buttons 1 and 4,File > Presentation Properties > Buttons

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
https://www.brightsign.biz/digital-signage-products/accessories/usb-4-buttons-panels
https://www.brightsign.biz/digital-signage-products/accessories/usb-4-buttons-panels
http://docs.brightsign.biz/pages/createpage.action?spaceKey=DOC&fromPageId=983346#PresProperties_Buttons
http://docs.brightsign.biz/pages/createpage.action?spaceKey=DOC&fromPageId=983346#PresProperties_Buttons


Press (First Touch): Select this option to have the transition occur the moment the button is pressed.

Press Continuous: Select this option to have the transition occur only after the button is continually pressed for a certain interval of time.
Specify the repeat interval (in milliseconds).

Transition to new state: Select this option to have the presentation transition to a new state when the event occurs. Use the dropdown
list to specify a new state.

Return to prior state: Select this option to have the presentation return to the previous state when the event occurs.

Remain on current state: Select this option to have the state remain unchanged when the event occurs.

 

Rectangular Touch
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The Rectangular Touch event specifies the action that occurs when the user presses a region on a touch screen that is connected to the
BrightSign player.

Size: Use the size parameters to set an exact size for the touch region. Alternatively, you can click and drag the marks surrounding the
touch rectangle to change its size.

W: Enter the width of the touch region.

H: Enter the height of the touch region.

Position: Use the position parameters to set an exact position for the touch region. Alternatively, you can click and drag the rectangle to
a different area.

X: Enter the horizontal position (in pixels) of the top-left corner of the touch region.

Y: Enter the vertical position (in pixels) of the top-left corner of the touch region.

Save as User Event: Check this box to save this Rectangular Touch event as a . Enter the name of the new User Event in theUser Event
 field.Name

Add Touch Region: Click  to add another touch region to the event. All touch regions in a Rectangular Touch event will trigger the same
transition and commands. To define different touch transitions, add additional Rectangular Touch events to a state.

USB Input
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then a BP900 event set to  will trigger for buttons 1 and 4 only.Any Button 
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The USB Input event sets the action that occurs when a BrightSign player receives the specified input from a connected USB device.

In the field, enter the USB input string that will trigger the event.Specify USB input 

Keyboard Input
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The Keyboard Input event sets the action that occurs when a BrightSign player receives the specified input from a connected keyboard.

In the field, enter the keyboard input that will trigger the event.Specify keyboard input 

GPIO Event
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The GPIO Event specifies the action that occurs when a specific GPIO button is pressed or input is received. By default, the playlist toolbar
includes several GPIO buttons that you can use to define interactions.

Specify button number: Specify the number of the GPIO button. These numbers also correspond to the 8 bi-directional GPIO pins on
the DA15 connector. See the  section corresponding to your BrightSign player model for details.Hardware

Trigger Event on Button: Specify whether the event should trigger when the button is depressed ( ) or when it is released ( ). IfDown Up
you've selected , choose one of the following behaviors:Down

Press (First Touch): The event triggers the moment the button is depressed.

Press Continuous: The event triggers the moment the button is depressed, then continues triggering at the specified intervals
as long as the button is depressed.

Serial Input
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The Serial Input event specifies the action that occurs when the BrightSign player receives input from a device connected to a serial port.
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Specify port: Enter the port number of the input device. Most standard RS-232 serial devices enumerate on port 0. If you are connecting
a USB-serial device, it will enumerate on port 2. To configure the serial port, navigate to .File > Presentation Properties > Interactive
Specify serial input: Enter the serial input string that will trigger the event. You can also use the <*> wildcard to match some or all of the
serial input (i.e. entering "<*>" in this field will match any input, while entering "mycommand_<*>" will match any input message that
begins with "mycommand_").

Modifying User Variables

You can use the Serial Input event to modify the values of User Variables. To enable these options, click the  tab:Advanced

Assign input to variable?: Check this box to assign the content of the serial input to a User Variable.

Input specifies variable: The serial input string will dynamically specify which User Variable to modify. The serial input string
must be sent in the form of <variable name> : <variable value>.

Specify fixed variable: The serial input string will modify a fixed User Variable. Use the dropdown list to choose which User
Variable the serial input will modify. The serial input string must be sent in the form of <variable value>.

Assign wildcard to variable?: Check this box to specify the value of a User Variable using the <*> wildcard. Select the User Variable to
modify using the dropdown menu to the right. The field must contain the <any> wildcard, either by itself or withSpecify serial input 
additional text (e.g. "message_<any>").

Remote Input
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The Remote Input event sets the action that occurs when the BrightSign player receives the specified input from an IR remote control.

In the field, enter the remote control command value that will trigger the event. BrightAuthor supports the following NECSpecify remote input 
remote control codes:

WEST

EAST

NORTH

SOUTH

SEL

EXIT

PWR

MENU

SEARCH

PLAY

FF

RW

PAUSE

ADD

SHUFFLE

Tip
You can use the   option to modify more than one User Variable with a single event. Use the following serialInput specifies variable
input string: <variable name> : <variable value> !! <variable name> : <variable value>

Note
It is possible to check both   and   boxes for more complex functionality. For example,Assign input to variable Input specifies variable
you can use   to assign the entire serial input string to one variable, while at the same time using Specify fixed variable Assign

to assign a subset of that string to another variable. wildcard to variable 
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REPEAT

VOLUP

VOLDWN

BRIGHT

GPS
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The GPS event specifies the action that occurs when a BrightSign player, connected to a , enters or exits a definedcompatible USB GPS device
geographical region.

Event Direction: Determine how the event should trigger in relation to the defined region.

Enter Region: The event triggers when the device moves from outside the defined region to inside of it.

Exit Region: The event triggers when the device moves from inside the defined region to outside of it.

Region: Define the size and shape of the circular region.

Radius: Specify the radius of the circular region. Use the dropdown menu to specify the units in or .Miles Kilometers
Latitude (degrees): Define the center of the circular region as a latitudinal coordinate.

Longitude (degrees): Define the center of the circular region as a longitudinal coordinate.

Plugin Message
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The Plugin Message event specifies the action that occurs when a message is received from a  that is attached to thecustom script plugin
presentation. See the  tech note for more information on creating custom scripts that send plugin messages.Parsers and Plugins

Plugin name: Use the dropdown menu to determine which plugin the event can receive messages from. You can also use the <*>
wildcard to match some or all of the plugin message string (i.e. entering "<*>" in this field will match all plugin messages, while entering
"mycommand_<any>" will match any plugin message that begins with "mycommand_").

Plugin message: Enter the message string that will trigger the event.

Modifying User Variables

You can use the Plugin Message event to modify the values of User Variables. To enable these options, click the  tab:Advanced

Assign input to variable?: Check this box to assign the content of the plugin message to a User Variable.

Input specifies variable: The plugin message string will dynamically specify which User Variable to modify. The plugin message
string must be sent in the form of <variable name> : <variable value>.

Specify fixed variable: The plugin string will modify a fixed User Variable. Use the dropdown list to choose which User Variable
the plugin message will modify. The plugin message string must be sent in the form of <variable value>.

Tip
You can create more than one entry or exit region by adding multiple GPS events to a single state.
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Assign wildcard to variable?: Check this box to specify the value of a User Variable using the <any> wildcard. Select the User Variable
to modify using the dropdown menu to the right. The field must contain the <any> wildcard, either by itself or withPlugin Message 
additional text (e.g. "message_<any>").

UDP Input
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The UDP Input event specifies the action that occurs when the BrightSign player receives a UDP (User Datagram Protocol) message from
another device on the local network. Source devices can include, but are not limited to, tablets running the , other BrightSignBrightSign App
players, and PCs/Macs.

Specify UDP Input: Enter the UDP message string that will trigger the event. You can also use the <any> wildcard to match some or all
of the UDP message string (i.e. entering "<any>" in this field will match all UDP messages, while entering "mycommand_<any>" will
match any UDP message that begins with "mycommand_").

Label: Specify a label for the UDP command button in the BrightSign App. By default, the command label will be the same as the UDP
message string.

Show in BrightSign App: Check this box to have the command button corresponding to the UDP Input event appear in the BrightSign
App.

Modifying User Variables

You can use a UDP Input event to modify the values of User Variables. To enable these options, click the  tab:Advanced

Assign input to variable?: Check this box to assign the content of the UDP message to a User Variable.

Input specifies variable: The UDP message string will dynamically specify which User Variable to modify. The UDP message
string must be sent in the form of <variable name> : <variable value>.

Specify fixed variable: The UDP string will modify a fixed User Variable. Use the dropdown list to choose which User Variable
the UDP input will modify. The UDP string must be sent in the form of <variable value>.

Assign wildcard to variable?: Check this box to specify the value of a User Variable using the <any> wildcard. Select the User Variable
to modify using the dropdown menu to the right. The field must contain the <any> wildcard, either by itself or withSpecify UDP Input 
additional text (e.g. "message_<any>").

Synchronize

Tip
You can use the   option to modify more than one User Variable with a single event. Use the followingInput specifies variable
string: <variable name> : <variable value> !! <variable name> : <variable value>

Note
It is possible to check both   and   boxes for more complex functionality. For example,Assign input to variable Input specifies variable
you can use   to assign the entire message string to one variable, while at the same time using Specify fixed variable Assign wildcard

to assign a subset of that string to another variable. to variable 

Tip
You can use the   option to modify more than one User Variable with a single event. Use the following UDPInput specifies variable
string: <variable name> : <variable value> !! <variable name> : <variable value>

Note
It is possible to check both   and   boxes for more complex functionality. For example,Assign input to variable Input specifies variable
you can use   to assign the entire UDP string to one variable, while at the same time using Specify fixed variable Assign wildcard to

to assign a subset of that string to another variable. variable 
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The Synchronize event synchronizes playback with other BrightSign players on the same local network using UDP. This event is useful for
synchronizing playback according to user input. If you want frame-accurate video synchronization (e.g. for video walls), we recommend creating a

 instead.BrightWall presentation

This event triggers when a  with the same keyword as the Synchronize event is used on another player on the localSynchronize command
network. When the  window opens, enter the keyword that corresponds to the Synchronize command in the Synchronize Event Specify

field.synchronization keyword 

For Synchronize events to work, you must ensure UDP communication is configured correctly in .File > Presentation Properties > Interactive

Link Zones
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Use the Link Zones event, combined with the Link Zones command, when you require close, millisecond-level synchronization of content between
zones on the same player (as opposed to synchronizing across multiple players).

In the field, enter the message that is sent by the corresponding . Specify link keyword Link Zones command

Zone Message
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Use the Zone Message event, combined with the  command, to affect changes from one zone to another across multiple Send Zone Message syn
 players with multi-zone presentations.chronized

 In the Specify zone message field, enter the message that is sent by the corresponding Send Zone Message command.

Note
A separate Synchronize event and command must be defined for each transition you want synchronized.

Note
A separate Link Zones event and command must be defined for each zone transition you want synchronized.

Note
A separate Zone Message event and command must be defined for each zone transition you want synchronized.
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Time/Clock
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The Time/Clock event specifies the action that occurs at a specific time and date or at regular intervals on a recurring schedule.

Single date/time event: Select this option to specify a one-time-only event.

Date: Specify the date by entering it into the field or selecting it from the calendar view.

Time: Specify the time using the dropdown menu. If you want the event to occur at an exact minute, type the desired time
directly into the field.

Specify with user variable: Select this option if you want to use the value of a  to specify the date and time.User Variable
Choose a variable from the dropdown list. The value of the variable must be in this format: “yyyy-mm-ddThh:mm:ss”. For
example, if you would like the event to occur on December 20, 2016 at 3:45PM, then you would use the value
“2016-12-20T15:45:00”.

Daily timeout event: Select this option to specify a recurring event.

Once per day: Select this option to have the event occur once per day. Specify the  using the dropdown menu (or, if youTime
want the event to occur at an exact minute, type the desired time directly into the field).

Periodic throughout the day: Select this option to have the event occur at intervals throughout the day.

Interval between events (minutes): Determine the frequency of the event.

Active between: Use the dropdown menus to specify the period during which the event can occur. The first event will
occur at the beginning of the active period.

Set the days the timeout is active: Use the checkboxes to select which days the time/clock event is active.

Video Time Code

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

The Video Time Code event performs  at specific times during video file playback. If you want to trigger a transition at a certain point incommands
the video, use the  event instead.Timeout

Click the  button to add a new time-code command. Enter the interval for the command (in milliseconds), and thenAdd Time Code Timeout 
select the and from the corresponding lists.Command Parameters 

Audio Time Code

BrightAuthor Version 4.6

Version 4.4

Previous Versions 
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The Audio Time Code event performs  at specific times during audio file playback. If you want to trigger a transition at a certain pointcommands
during audio playback, use the  event instead.Timeout

Click the  button to add a new time-code command. Enter the interval for the command (in milliseconds), and thenAdd Time Code Timeout 
select the and from the corresponding lists.Command Parameters 

BrightWall Presentations

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

The BrightWall™ feature allows you to easily create, publish, and edit video-wall deployments. Video walls are created by synchronizing the
playback of a number of players, each connected to a different screen on the wall, over a local network connection. Simple looping video playlists
are the only presentation type supported by BrightWall. Images and interactive playlists are not supported: Use  to compare thethis FAQ
capabilities of different synchronization options.

The process of publishing BrightWall presentations differs from publishing standard presentations. See the   page for morePublishing a BrightWall
information. 

VIDEO REQUIREMENTS

For best results, we recommend using the   or  container for video files that make up a BrightWall presentation. Transport Stream ( ).mp4 .mov  .ts
files are also supported, but they must begin with a presentation timestamp (PTS) offset of zero. Program Stream (MPEG-PS) files   supporare not
ted.

Creating a BrightWall Presentation

BrightAuthor Version 4.6
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ON THIS PAGE

Creating a Configuration File

BrightWall Presentation Properties

Main

Audio

To create a new BrightWall presentation, navigate to Create > BrightWall™ (if the Create a new Video Wall window doesn’t

open automatically, click File > New BrightWall™). A BrightWall presentation requires a BrightWall Configuration file to set the platform,
dimensions, and layout of the video wall. Once you create a BrightWall Configuration file, you can use that file to quickly generate BrightWall
presentations with the same video-wall setup.

Save As: Enter the name of the new BrightWall project.

Where: Choose where to save the BrightWall . Note that the  is different from the that will actuallyproject file project file presentation files 
be published to the players.

Configuration file: If you have created a BrightWall Configuration file, you can use it to generate settings for the BrightWall project.

Create BrightWall Configuration: Click this button to create a new BrightWall Configuration file. Use this option if you haven’t created a
BrightWall Configuration file yet, or if you would like to create an additional BrightWall Configuration file with new settings.

Creating a Configuration File

Clicking the  button will open the  window, which provides the following options.Create BrightWall Configuration BrightWall Configuration

BrightSign Model: Choose the BrightSign player model that will display the video wall. All players that are part of the video wall must be
of the same model type.

Connector type: Choose the connector (HDMI, VGA, Component) that each player will use to connect to its display. All players that are
part of a video wall must use the same connector.

Note
It is possible to create a seamlessly looping video wall if the video files are formatted appropriately. See the   forSeamless Looping FAQ
more details.
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Screen resolution: Choose the resolution of each screen in the video wall. All video wall screens must have the same resolution. You
can view all available screen resolutions in this .FAQ

Monitor orientation: Choose one of the following:

Landscape: Content is not rotated.

Portrait – bottom on left: Video is rotated counter-clockwise 90 degrees. Select this option if the bottom of each monitor is on
the left when it is portrait oriented.

Portrait – bottom on right: Video is rotated clockwise 90 degrees. Select this option if the bottom of the each monitor is on the
right when it is portrait oriented. 

Monitor overscan: Select an overscan setting to determine how each video fills the display screen.

No overscan – use full screen: Displays video to the edge of the video signal.

Overscan – action safe: Restricts the image display to an area that is compatible with most displays.

Overscan – title safe: Restricts the image display to an area that is much smaller than the image generated by the video signal.

Number of rows: Specify the vertical length of the video wall (in number of screens).

Number of columns: Specify the horizontal length of the video wall (in number of screens).

Domain: Specify a domain number (between 0 and 127) for the video wall. This number must be unique for each video wall on the local
network. This will ensure that multiple video walls can run on the same local network without synchronization messages interfering with
each other.

Bezel Width and Height: Account for the bezel size of the monitors that make up the video wall. This allows for better alignment of
videos in the video wall. These measurements only apply to  BrightWall presentations. For  presentations, bezel widthStretched Regular
and height will need to be accounted for in the content creation application.

By percentage: Enter the bezel width and height as percentages. Use the following calculation to determine bezel percentages:

Width: The width of the bezel between active screens (i.e. the total of both left and right bezels) divided by the width of
an active screen. The result is multiplied by 100. For example, a video wall made up of screens with a width of 42 inches
and a 1 inch bezel on each side would be calculated as follows: (2”/42”)*100=5%

Height: The height of the bezel between active screens (i.e. the total of both top and bottom bezels) divided by the
height of an active screen. The result is multiplied by 100. For example, a video wall made up of screens with a height of
23.625 inches and a 1 inch bezel on each side would be calculated as follows: (2”/23.625”)*100=8%

By measurement: Enter the bezel width, bezel height, screen width, and screen height in millimeters (mm). BrightAuthor will
make the calculations automatically.

Save As: Click this button to save the BrightWall Configuration file. It will then be used as the Configuration File for the BrightWall
presentation.

 

Once you’ve created or selected a BrightWall Configuration file, click . The Create BrightWall Presentation BrightWall™ Presentation
 window will open.Properties

BrightWall Presentation Properties

Note
Individual screens only support video files in landscape mode.

Note
The portrait modes apply to Stretched BrightWall presentations only. If you select a portrait mode, you will be limited to
creating Stretched presentations with this BrightWall Configuration file.

Note
Bezel width and height percentages must be specified as integers (i.e. whole numbers that are positive).
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The   window is divided into two tabs:  and  .BrightWall™ Presentation Properties Main  Audio

Main

Type: Choose whether the BrightWall presentation is  or :Regular Stretched

Regular: Each panel of the BrightWall presentation is made up of a different video file. To create a single video surface out of
multiple screens, video assets will need to be tailored for the video wall using the source application (e.g. Adobe After Effects):
You will need to split the videos into their respective screens and adjust for bezel width before adding the assets to BrightAuthor.

Stretched: The video wall is made up of a single video. BrightAuthor automatically splits the video among the screens. This
option allows you to display video files, as well as , , and .Streaming Video Live Video RF Input

View mode: Choose the view mode of the presentation. In presentations, this option applies to videos on individual screens,Regular 
similar to the  option found in the  menu. In  presentations, this option applies to the entire wall. TheView Mode Zone Properties Stretched
following descriptions apply to  presentations only:Stretched

Scale to Fill: The video will be stretched over all screens in the video wall. If the aspect ratio of the video wall does not match
the ratio of the video content, the video will likely appear stretched or distorted.

Letterboxed and Centered: The video will not be stretched. Instead, it will appear at the center of the video wall at its original
resolution, which may cover one or multiple screens. Areas of the video wall that are not filled by the video will display the
background color of the presentation.

Fill Screen and Centered: The video will be stretched to the height or width of the video wall (whichever length is greater). If the
aspect ratio of the video wall does not match the ratio of the video content, the video will be cut off at the height or the width
(whichever length is lesser).

Display screen layout information when presentation starts: Check this box to have screens in the BrightWall display positioning
information for a few moments when the presentation starts scheduled playback. If this box is not checked, the presentation will begin
immediately without displaying positioning information.

Audio

Audio Output: Enables or disables the Analog, HDMI, and SPDIF audio outputs. In BrightWall presentations, only the master unit (i.e.
the player driving Screen 1) outputs audio, so these settings do not affect any of the slave units in the presentation.

Pass through: Supplies the un-decoded audio signal through the HDMI connector. Use this option if the zone audio (for
example, AC3 Dolby Digital) is being decoded on an external device.

Stereo: Supplies the audio as a stereo signal.

Audio Mixing: Enables the stereo, left-only, or right-only audio signal.

 

Editing a BrightWall Presentation
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ON THIS PAGE

Main

Configuration

Audio

To configure a BrightWall presentation, navigate to File > BrightWall™ Properties.

Main

Type: Choose whether the BrightWall presentation is  or :Regular Stretched

Regular: Each panel of the BrightWall presentation is made up of a different video file. To create a single video surface out of
multiple screens, video assets will need to be tailored for the video wall using the source application (e.g. Adobe After Effects):
You will need to split the videos into their respective screens and adjust for bezel width before adding the assets to BrightAuthor.

Stretched: The video wall is made up of a single video. BrightAuthor automatically splits the video among the screens. This
option allows you to display video files, as well as , , and .Streaming Video Live Video RF Input

View mode: Choose the view mode of the presentation. In presentations, this option applies to videos on individual screens,Regular 
similar to the  option found in the  menu. In  presentations, this option applies to the entire wall. TheView Mode Zone Properties Stretched
following descriptions apply to  presentations only:Stretched

Note
The  and   options will not remove letterboxing if it's part of the video file.Scale to fit  Fill screen and centered
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Scale to Fill: The video will be stretched over all screens in the video wall. If the aspect ratio of the video wall does not match
the ratio of the video content, the video will likely appear stretched or distorted.

Letterboxed and Centered: The video will not be stretched. Instead, it will appear at the center of the video wall at its original
resolution, which may cover one or multiple screens. Areas of the video wall that are not filled by the video will display the
background color of the presentation.

Fill Screen and Centered: The video will be stretched to fit the height or width of the video wall (whichever length is lesser). If
the aspect ratio of the video wall does not match the ratio of the video content, the video will be cropped.

Display screen layout information when presentation starts: Check this box to have screens in the BrightWall display positioning
information for a few moments when the presentation starts scheduled playback. If this box is not checked, the presentation will begin
immediately without displaying positioning information.

Configuration

Configuration file: Use the  button to locate and select a preexisting BrightWall Configuration file to use with the BrightWallBrowse
project.

Edit BrightWall Configuration: Edit the selected BrightWall Configuration file.

Create BrightWall Configuration: Create a new BrightWall Configuration file. See the  page for moreCreating a BrightWall Presentation
details.

Audio

Audio Output: Enables or disables the Analog, HDMI, and SPDIF audio outputs. In BrightWall presentations, only the master unit (i.e.
the player driving Screen 1) outputs audio, so these settings do not affect any of the slave units in the presentation.

Pass through: Supplies the un-decoded audio signal through the HDMI connector. Use this option if the zone audio (for
example, AC3 Dolby Digital) is being decoded on an external device.

Stereo: Supplies the audio as a stereo signal.

Audio Mixing: Enables the stereo, left-only, or right-only audio signal.

 

Adding Video to a BrightWall Presentation
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The process of creating a video playlist for a BrightWall will differ depending on whether you created a or presentation.Regular Stretched 

For a Regular BrightWall

Each screen in a video wall has a distinct playlist. You can switch among screens by selecting them in the  section.Screen

To create a regular BrightWall, you will need to add a different video file (or Streaming/Live Video state) to each screen. The  of aMedia Library
Regular BrightWall has special properties that help streamline playlist creation:

A video with a file name in the format appears only in the  of the screen corresponding to its“VideoName_Number” Media Library
number.

Adding a video with a file name to a screen will add all other videos with the same format to their respective“VideoName_Number” 
screen playlists. This behavior will only occur if the quantity of files corresponds to the number screens in the“VideoName_Number” 
BrightWall presentation.

Example
Your BrightWall project consists of four screens. The video is split into four files, each file representing ¼ of the entire wall:
“Intro_1.mpg”, “Intro_2.mpg”, “Intro_3.mpg”, and “Intro_4.mpg”. Only “Intro_1” will appear in the   of Screen 1. AddingMedia Library
“Intro_1” to Screen 1 will automatically add “Intro_2” to Screen 2, “Intro_3” to Screen 3, and “Intro_4” to Screen 4. If your BrightWall
project is expanded to six screens, then adding “Intro_1” will not affect the playlists of the other screens because there are only four
“Intro” video files.
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For a Stretched BrightWall

The entire video wall has the same playlist. Adding a video file, , , orStreaming Video Live Video
 to the playlist will split the video among the screens during playback.RF Input

 

Completing a BrightWall Presentation
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Before you can publish a BrightWall presentation, you will need to save it by navigating to  or . If you would like to publish aFile > Save Save As
BrightWall presentation using the BrightSign Network, click the  button once you’ve signed into your account. You can alsoUpload to network
export a BrightWall presentation for use on another computer by navigating to .File > Export

When you’re ready to publish to your video wall, navigate to the Publish tab and click the  option.BrightWall Presentations

Creating a BrightWall on BSN

BrightAuthor Version 4.6
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Previous Versions 

Creating a BrightWall and distributing a BrightWall presentation to it via the BrightSign Network requires several steps within BrightAuthor. Follow
these steps to create a BrightWall group, create a BrightWall within the BrightWall group, and publish your presentation to the BrightWall group:

Sign in to your BrightSign Network account by navigating to .Tools > Sign In to BrightSign Network
After creating your BrightWall presentation, click the button in the top-right. This will upload both the BrightWallUpload to network 
presentation and BrightWall configuration file to the BrightSign Network.

Navigate to the  tab.Manage > Status
Expand the section at the bottom of the screen.BrightWall Groups 
Click Add BrightWall

.Group
Enter a BrightWall group

and select a name Bright
. TheWall configuration

BrightWall configuration will
be applied to every
BrightWall created within
the group. Click  whenOK
finished.

Once you’ve created a
BrightWall group, you will
need to set up players as
part of the BrightWall
configuration:

Navigate to Tools
> Setup

.BrightSign Unit
Select the  option under .BrightWall Group Networked with the BrightSign Network
Use the  dropdown list to select the BrightWall group created in steps 5 and 6.BrightWall Group
Click the  button to add a new BrightWall to the BrightWall group. Enter a  and click .Add BrightWall BrightWall name OK
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Use the  dropdown list to specify the section of the BrightWall to which the player belongs. Screens areScreen Number
numbered by row, starting from the top-left section of the BrightWall (the example diagram to the right shows the numbering of a
4x3 BrightWall).

Enter the rest of the player configuration settings as desired and set up the player—see the Brigh
 page for more details.tSign Network Setup

Repeat steps  through  to set up every player in the BrightWall—make sure to use the same 7a 7f Bright
 and  for all players in the BrightWall.Wall Group BrightWall Name

Navigate to the  tab.Publish > BrightSign Network

Select the  option.BrightWall Presentations

Under , select the BrightWall group you created in steps 5 and 6.Select BrightWall Group to Schedule

Add one or more BrightWall presentations to the schedule—see the publishing section for more details onBrightSign Network 
scheduling.

Click . Make sure all the players in the BrightWall are powered up and connected to the Internet. Allow time for thePublish schedule
players to download the content, reboot, and synchronize playback.

Adding a New BrightWall to the Group

Use the  option during unit setup to add additional BrightWall(s) to the BrightWall group. A new BrightWall will use the sameAdd BrightWall
configuration and be scheduled with the same presentations as other BrightWall(s) in the group.

Using Configuration Files

Each BrightWall presentation within a BrightWall group must use the same configuration file. If you want to create additional BrightWall
presentations with different configuration files, you will need to create additional BrightWall groups in the tab.Manage > Status 

Retrieving Configuration Files from BSN

If you don’t have the original configuration file (for example, if the user who created the original configuration file is on a different PC), you will
need to retrieve it from BSN:

Navigate to the tab.Manage > Presentations 
Expand the  section.BrightWall Configurations
Right-click the original configuration file and select  to save the file to your hard drive.Download
When creating a new BrightWall presentation, use the  button to locate and select this configuration file.Browse

Publishing Presentations

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

After you create and save a presentation, you’re ready to publish it to your BrightSign player or players. You can use one of the following methods
to publish a presentation:

Local Storage

BrightSign Network

Simple File Network

Local File Network

The method you use to publish will depend on several factors, such as whether your player is networked, what kind of network you have access
to, and how many players you have. 

 

 

Local Storage

Note
 You can use any of the above methods to publish a BrightWall presentation as well. See the  pagePublishing a BrightWall Presentation
for more details.
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Adding Presentations to Your Schedule

Schedule Interrupts

Debugging

Publishing Options

Logging

Firmware Updates

Publishing the Scheduled Presentation(s)

Publishing a presentation using Local Storage lets you copy your presentations to an SD card or USB flash drive. When you want to update your
scheduled presentations, you must save the updated content on the SD card or USB flash drive and insert it into your BrightSign player.

Unless you are updating content, an SD card or flash drive should always remain connected to the BrightSign player. However, if your BrightSign
player has a USB port, we recommend that you create setup files with an SD card, leave it in the player permanently as internal storage, and use
a USB flash drive whenever you need to update content. You can publish updated content to the USB flash drive, insert it into the player to
update the SD card, and then remove the flash drive.

 To publish via Local Storage, complete the following steps:

Save the presentations you want to publish by clicking > . You will also be prompted to save a presentation if there areFile Save… As
unsaved changes to the presentation when you switch to the  tab.Publish
Click the tab.Publish 
Click (below the tab).Local Storage Publish 
Choose whether you want to publish  or .Presentations BrightWall™ Presentations
Click under to navigate to and select the folder where your presentations are stored.Browse Presentations 

Adding Presentations to Your Schedule

Follow these steps to add presentations to the player schedule:

Select a presentation from the list in the section.Presentations 
Drag the presentation to a time slot during which you want it to play.

Click and drag the selection handles to adjust playing time within one day.

 

If you want the presentation to be a recurring event, double-click the presentation timeframe in the
calendar. In the  window, set the following parameters:Schedule Presentation

Presentation: Specify which presentation you want to use in this schedule block.

Active all day, every day: Check this box if you want the presentation to play at all times
(i.e. without day parting).

Event time: Specify a timeframe during the day when you want the presentation to play:

Start: Use the dropdown list to select a time when the presentation should begin

End: Use the dropdown list to select a time when the presentation should end.

Recurring Event: Check this box to have the presentation recur during specified days. If
you don't check this box, the  will only apply to the single day selected in theEvent time
schedule.

Recurring pattern: Specify the frequency of the recurrence.

Daily: Specify , , or forEvery day Every weekday Every weekend 
playback.

Tip
This  provides an overview of publishing via local storage. tutorial video

Note
Alternatively, you can schedule a presentation by double-clicking a blank area on the schedule to open the   winSchedule Presentation
dow.

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
http://brightsignbiz.s3.amazonaws.com/videos/step-by-step/Training%203.4.2%20Publish%20to%20Memory%20Card.mp4?custom=true&width=520&height=330


Weekly: Check the boxes corresponding to the individual days of the
week when you want the presentation to play.

Range of recurrence: Use this option to limit the recurrence of the scheduled
presentation.

Start: Specify the start date of the scheduled recurrence. This date
defaults to the currently selected date in the schedule.

End: Select  to have the presentation recur indefinitely, or select No end E
 and specify the end date of the scheduled recurrence.nd by

Schedule Interrupts

You can create a day-parted schedule by scheduling presentations in separate time slots of a single
day (or a set of recurring days). Later on, you may need to schedule a new presentation in an
occupied time slot. This is where are useful.schedule interrupts 

If you would like to interrupt a scheduled presentation with another presentation, drag and drop the 
new presentation into an occupied time slot (you can also schedule an overlap in the Schedule

window). A  window will appear, providing the following options:Presentation Schedule Conflict

Keep existing events, cancel new event: Cancels the new schedule presentation action.

Keep existing events, adjust new event: Opens the  window,Schedule Presentation
allowing you to schedule the new presentation in an empty time slot. If you schedule the
presentation in an occupied time slot, the  window will appear again.Schedule Conflict
Remove existing events, use new event: Completely removes the presentation currently
occupying the time slot.

Interrupt existing events with new event: Schedules an interrupt in the presentation
currently occupying the time slot. The date field will be split into two columns: The left column shows the primary scheduled presentation
in blue; the right column shows the interrupting presentation in green. Primary scheduled presentations can be interrupted with multiple
presentations, but interrupting presentations cannot overlap with each other.

Debugging

Under , you may optionally enable the following:Debugging

Enable : The autorun script will output debugging information related to the presentation to the RS-232 serial port (asserial debugging
well as over Telnet and SSH if these features are enabled).

Enable system log debugging: The autorun script will output debugging information related to the presentation to the  tab in the Log Dia
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.gnostic Web Server

Publishing Options

Select among the following publishing options:

Standalone Unit: Publishes the scheduled presentation(s) to the player using an SD card.

Specify Password:(Optional) Click this button to set
up, change, or remove password protection for USB
content updates. The password protection feature
ensures that a player cannot be updated with the Pu

option unless the correctblish for USB update 
password is supplied.

Keep Password: Leaves the current content
update password for the player unchanged.

Set New Password: Sets a new content
update password for the player. Enter the
new password in the field.

Clear Password: Removes the content
update password. This allows USB updates
to be published to the SD card without restrictions.

Standalone unit with setup: Publishes both the scheduled presentation(s) and player setup files at the same time. When you click the P
 button, the  window will open, prompting you to configure the player for .ublish BrightSign Unit Setup Standalone use

Setup unit for BrightSign Network: Includes player setup files for the BrightSign Network with the scheduled presentation(s). This
option is useful if you want to ensure that a newly set up player will run a presentation even if it cannot initially connect to the BrightSign
Network. Once the player connects to the BrightSign Network, it will update to the current presentation and schedule for its assigned
group. When you click , you will be prompted to .Publish set up the player for the BrightSign Network

Publish for USB update: Publishes the scheduled presentation(s) to a USB flash drive. You can then insert the flash drive into a
BrightSign player to update the SD card on the player. This allows you to update content on a Standalone player without ever needing to
remove the SD card. USB updates only work with players that are configured for Standalone publishing.

Specify Password: Click this button if you are publishing a USB content update to a player or set of players with password protection.
Enter the . You must enter the same upgrade password designated for the player or else the playerUSB Content Update Password
content upgrade will fail. You can choose the password when you  or when you use the set the player up for standalone use Set New

 feature (see step  above).Password  5a

USB update (FW only): Publishes a firmware update file to a USB flash drive. You can use this feature to update the firmware on a
player without ever needing to remove the SD card or publish a new schedule to the player. Use the  buttonSpecify Firmware Update
(described below) to determine the update version.

Logging

Click to enable/disable logs on the player:Specify Logging 

Enable playback logging: Records playback start and end times, zone names, media types, and file names.

Enable event logging: Records timestamps, state names, zone names, event types, and event data.

Enable state logging: Records current and last state names, timestamps, and media types.

Enable diagnostic logging: Records timestamps, firmware and script versions, and the current presentation.

Enable Variable logging: Records the current and default values of all  in the presentation. This log is only generatedUser Variables
when logs are uploaded to custom log handler URL.

Firmware Updates

Click  to include a firmware update file with the published schedule. In the window, locate theSpecify Firmware Update Firmware Update 
section corresponding to your BrightSign model and select one of the following:

Important
A schedule must already be published to the SD card for the USB update to work. Publish an initial schedule via the SD card first; you
can then use the USB update feature for subsequent publishing operations.

Note
If no update password is currently set for the player, entering a phrase in this field will designate it as the new update password.

http://docs.brightsign.biz/display/DOC/Diagnostic+Web+Server
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Production Release: The current official release of BrightSign firmware

Beta Release: The current beta release of BrightSign firmware

Minimum Compatible Release: The minimum firmware version that supports presentations created by your version of BrightAuthor. The
minimum compatible firmware will likely not support all features provided by a contemporary version of BrightAuthor.

Select specific file: Use the button to select a  firmware update file from your hard drive. The other options will downloadBrowse .bsfw
the update file from BrightSign when the presentation schedule is published.

 

You can use the  dropdown menu to determine the behavior of the firmware update:Update type

Standard: The firmware update is applied, the player reboots, and the update file deletes itself from the local storage..bsfw 

Different: The update will only be applied if the version of the update file does not match the current firmware version of the player..bsfw 
The file is not deleted after the update process is completed.

Newer: The update will only be applied if the version of the update file is newer than the current firmware version of the player. The.bsfw 
file is not deleted after the update process is completed.

Save: The firmware update is applied, but the update file is not deleted. The device will only reboot once the storage device.bsfw 
containing the update file is removed.

Publishing the Scheduled Presentation(s)

Once you've created the presentation schedule and configured the publishing options, follow these steps to publish the schedule to your
BrightSign player(s):

Insert an SD card or USB flash drive into your computer.

Under , click . Navigate to and select the drive where your storage device is located. Make sure to select thePublish to Browse  root
 of the SD card or USB flash drive (e.g. "SD:/").folder

Click . When the  window opens, click .Publish Publish complete OK
Update your BrightSign player:

Turn off the BrightSign player by unplugging the power adapter (or Ethernet cable if the player is being powered by PoE).

Insert the storage device into the player.

Turn on the BrightSign unit by reconnecting the power.
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Publishing the Scheduled Presentation(s)

The BrightSign Network allows you to distribute presentations to your BrightSign players over the Internet.

The BrightSign Network requires a subscription, so you must first contact BrightSign to obtain an account name, user name, and password. Once
your BrightSign players are , you can upload your presentations and assign schedules to groups. Your playersset up with the BrightSign Network
will then update their content automatically when they connect to the server.

The BrightSign Network distributes presentations and schedules to groups instead of players. Groups can contain any number of players, and you
can move BrightSign players from one group to another at any point. See for details. To publish with BrightSign Network,Managing Your Network 
complete the following steps:

Sign into BrightSign Network by clicking > .Tools Sign in to BrightSign Network

Note
If an SD card is already in the player and you are updating it via USB, you don’t need to turn off the player. Insert the USB flash drive
into the player, wait until the   message appears on the display, and then remove the flash drive.Update Complete

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
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Open the presentation you wish to publish by selecting > .File Open presentation
Click (in the upper-right portion of the screen) to upload the presentation to the server.:Upload to network 
Click the tab.Publish 
Select (above the calendar).BrightSign Network
Choose whether you want to publish  or .Presentations  BrightWall™ Presentations
Under , use the dropdown list to specify the group to which you want to publish.Selected Group to Schedule

Adding Presentations to Your Schedule

Follow these steps to add presentations to the group schedule:

Select a presentation from the list in the section.Presentations 
Drag the presentation to a time slot during which you want it to play.

Click and drag the selection handles to adjust playing time within one day.

 

If you want the presentation to be a recurring event, double-click the presentation timeframe
in the calendar. In the  window, set the following parameters:Schedule Presentation

Presentation: Specify which presentation you want to use in this schedule block.

Active all day, every day: Check this box if you want the presentation to play at all
times (i.e. without day parting).

Event time: Specify a timeframe during the day when you want the presentation to
play:

Start: Use the dropdown list to select a time when the presentation should
begin

End: Use the dropdown list to select a time when the presentation should
end.

Recurring Event: Check this box to have the presentation recur during specified
days. If you don't check this box, the  will only apply to the single dayEvent time
selected in the schedule.

Recurring pattern: Specify the frequency of the recurrence.

Daily: Specify , , or forEvery day Every weekday Every weekend 
playback.

Weekly: Check the boxes corresponding to the individual days of
the week when you want the presentation to play.

Range of recurrence: Use this option to limit the recurrence of the
scheduled presentation.

Start: Specify the start date of the scheduled recurrence. This date
defaults to the currently selected date in the schedule.

End: Select  to have the presentation recur indefinitely, orNo end
select  and specify the end date of the scheduledEnd by
recurrence.

Schedule Changes

If you drag and drop the new presentation into an occupied time slot (or schedule an overlap in the window), a Schedule Presentation Schedule
 window will appear, providing the following options:Conflict

Keep existing events, cancel new event: Cancels the new schedule presentation action.

Keep existing events, adjust new event: Opens the  window, allowing you to schedule the new presentation inSchedule Presentation
an empty time slot. If you schedule the presentation in an occupied time slot, the  window will appear again.Schedule Conflict
Remove existing events, use new event: Completely removes the presentation currently occupying the time slot.

Note
Alternatively, you can schedule a presentation by double-clicking a blank area on the schedule to open the   winSchedule Presentation
dow.



Debugging

Under , you may optionally enable the following:Debugging

Enable : The autorun script will output debugging information related to the presentation to the RS-232 serial port (asserial debugging
well as over Telnet and SSH if these features are enabled).

Enable system log debugging: The autorun script will output debugging information related to the presentation to the  tab in the Log Dia
.gnostic Web Server

Firmware Updates

Click  to update the group firmware along the schedule. In the window, locate the sectionSpecify Firmware Update Firmware Update 
corresponding to the BrightSign model type in the group and select one of the following:

Production Release: The current official release of BrightSign firmware

Beta Release: The current beta release of BrightSign firmware

Minimum Compatible Release: The minimum firmware version that supports presentations created by your version of BrightAuthor. The
minimum compatible firmware will likely not support all features provided by a contemporary version of BrightAuthor.

Select specific file: Use the button to select a  firmware update file from your hard drive. The other options will use updateBrowse .bsfw
files stored on the BrightSign Network servers.

Publishing the Scheduled Presentation(s)

Once you've created the presentation schedule and configured the publishing options, click . When the  winPublish Schedule Publish Complete
dow appears, click .OK
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Schedule Interrupts
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Firmware Updates

Publishing the Scheduled Presentation(s)

Simple File Networking allows you to distribute presentations to your BrightSign players using a web server. To use this publishing method,

players must be set up for Simple File Networking with the correct URL for web folder.

In BrightAuthor, save the presentation(s) you want to publish by clicking > File Save… As
Click the  tab.Publish
Select the  option(above the Calendar).Simple File Network
Choose whether you want to publish  or .Presentations BrightWall Presentations
Under , click to navigate to and select the folder where your presentations are stored.Presentations Browse 

Adding Presentations to Your Schedule

Follow these steps to add presentations to the player schedule:

Select a presentation from the list in the section.Presentations 
Drag the presentation to a time slot during which you want it to play.

Click and drag the selection handles to adjust playing time within one day.

 

If you want the presentation to be a recurring event, double-click the presentation timeframe
in the calendar. In the  window, set the following parameters:Schedule Presentation

Presentation: Specify which presentation you want to use in this schedule block.

Active all day, every day: Check this box if you want the presentation to play at all
times (i.e. without day parting).

Event time: Specify a timeframe during the day when you want the presentation to
play:

Start: Use the dropdown list to select a time when the presentation should
begin

End: Use the dropdown list to select a time when the presentation should
end.

Recurring Event: Check this box to have the presentation recur during specified
days. If you don't check this box, the  will only apply to the single dayEvent time
selected in the schedule.

Recurring pattern: Specify the frequency of the recurrence.

Daily: Specify , , or forEvery day Every weekday Every weekend 
playback.

Weekly: Check the boxes corresponding to the individual days of
the week when you want the presentation to play.

Range of recurrence: Use this option to limit the recurrence of the
scheduled presentation.

Start: Specify the start date of the scheduled recurrence. This date defaults
to the currently selected date in the schedule.

End: Select  to have the presentation recur indefinitely, or select No end En
 and specify the end date of the scheduled recurrence.d by

Schedule Interrupts

Note
Alternatively, you can schedule a presentation by double-clicking a blank area on the schedule to open the   winSchedule Presentation
dow.



You can create a day-parted schedule by scheduling presentations in separate time slots of a single day (or a set of recurring days). Later on, you
may need to schedule a new presentation in an occupied time slot. This is where are useful.schedule interrupts 

f you would like to interrupt a scheduled presentation with another presentation, drag and drop the new presentation into an occupied time slot 
(you can also schedule an overlap in the window). A  window will appear, providing the followingSchedule Presentation Schedule Conflict
options:

Keep existing events, cancel new event: Cancels the new schedule presentation action.

Keep existing events, adjust new event: Opens the  window, allowing you to schedule the new presentation inSchedule Presentation
an empty time slot. If you schedule the presentation in an occupied time slot, the  window will appear again.Schedule Conflict
Remove existing events, use new event: Completely removes the presentation currently occupying the time slot.

Interrupt existing events with new event: Schedules an interrupt in the presentation currently occupying the time slot. The date field
will be split into two columns: The left column shows the primary scheduled presentation in blue; the right column shows the interrupting
presentation in green. Primary scheduled presentations can be interrupted with multiple presentations, but interrupting presentations
cannot overlap with each other.

Debugging

Under , you may optionally enable the following:Debugging

Enable : The autorun script will output debugging information related to the presentation to the RS-232 serial port (asserial debugging
well as over Telnet and SSH if these features are enabled).

Enable system log debugging: The autorun script will output debugging information related to the presentation to the  tab in the Log Dia
.gnostic Web Server

Simple File Networking Parameters

If you wish to reconfigure some of the device
parameters, click the button.Set Parameters 
These changes will only affect players that
receive the presentation schedule.

URL for the web folder: Specify a new
location from which the player will
download content updates. Do not use
trailing slashes in your URL; some web
servers do not support trailing slashes.



Content Check Frequency: Set how
often you want the player to check your
server for updates.

Simple File Networking
Authentication:(Optional) Enter a User

and to enable digestname password 
authentication between the BrightSign
player and the web server.

Enable basic authentication:
Check this box to have the
player pass credentials to the
web server in unsecured
packets. Use this option only if
it is absolutely required by the
configuration of your web
server. 

Logging: Check the boxes to enable
any of the following:

Enable playback logging:
Records playback start and end
times, zone names, media
types, and file names.

Enable event logging:
Records timestamps, state
names, zone names, event
types, and event data.

Enable state logging: Records current and last state names, timestamps, and media types.

Enable diagnostic logging: Records timestamps, firmware and script versions, and the current presentation.

Enable Variable logging: Records the current and default values of all  in the presentation. This log is onlyUser Variables
generated when logs are uploaded to custom log handler URL.

Upload logs: Check either of the following:

On startup: Uploads log files each time the player is powered on.

At specific time each day: Uploads log files daily at the specified time. Use the dropdown lists to pick a time.

Enable remote snapshot: Check this box to enable the Remote Snapshot feature, which allows you to remotely monitor the contents of
the presentation display.

Remote snapshot every [ ] minutes: Specify how often the player should take a snapshot of the presentation display.

Save up to [ ] images (1 - 100) on local storage: Specify how many JPEG snapshot images can be stored on the local storage of the
player.

JPEG quality level [ ] (0 - 100): Specify the quality level (and thus the file size) of each image file.

Display snapshots in portrait mode: Check this box to have the player rotate the snapshots to portrait mode before saving and
uploading them.

Firmware Updates

Click  to include a firmware update file with the published schedule. In the window, locate theSpecify Firmware Update Firmware Update 
section corresponding to your BrightSign model and select one of the following:

Production Release: The current official release of BrightSign firmware

Beta Release: The current beta release of BrightSign firmware

Minimum Compatible Release: The minimum firmware version that supports presentations created by your version of BrightAuthor. The
minimum compatible firmware will likely not support all features provided by a contemporary version of BrightAuthor.

Select specific file: Use the button to select a  firmware update file from your hard drive. The other options will downloadBrowse .bsfw
the update file from BrightSign when the presentation schedule is published.

Tip
See  if you're havingthis FAQ
trouble getting players to
communicate with your web
server.

Note
The Remote Snapshot feature is not available for the LS422, HD220, or HD1020.

http://support.brightsign.biz/hc/en-us/articles/218067517-Simple-File-Network-troubleshooting
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You can use the  dropdown menu to determine the behavior of the firmware update:Update type

Standard: The firmware update is applied, the player reboots, and the update file deletes itself from the local storage..bsfw 

Different: The update will only be applied if the version of the update file does not match the current firmware version of the player..bsfw 
The file is not deleted after the update process is completed.

Newer: The update will only be applied if the version of the update file is newer than the current firmware version of the player. The.bsfw 
file is not deleted after the update process is completed.

Save: The firmware update is applied, but the update file is not deleted. The device will only reboot once the storage device.bsfw 
containing the update file is removed.

Publishing the Scheduled Presentation(s)

Under , click to navigate to and select the location where you want to store the files.Publish to Browse 

If you have a mapped drive or shortcut that points to your web folder, publish to that location.

If you use FTP to transfer files to your web folder, publish to a folder on your computer and then use FTP software to copy the files to
your web folder.

Click . When the  window opens, click .Publish Publish Complete OK
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Publishing the Scheduled Presentation(s)

Local File Networking allows you to publish presentations to your BrightSign players without requiring a remote server or an Internet connection.
This is convenient if you only have a small number of BrightSign players that are all on the same local network. With Local Networking, BrightSign
players do not poll a remote web server to receive updates. Instead, you select one or more BrightSign players in BrightAuthor and publish
presentations directly to them. Updates will then be sent to the BrightSign player immediately.

Save the presentation you want to publish by clicking > File Save As
Click the  tab.Publish
Click (above the Calendar).Local Network 
Choose whether you want to publish  or .Presentations BrightWall Presentations
Under , click to navigate to and select the folder where your presentations are stored.Presentations Browse 

Adding Presentations to the Schedule

Follow these steps to add presentations to the player schedule:

Select a presentation from the list in the section.Presentations 
Drag the presentation to a time slot during which you want it to play.

Click and drag the selection handles to adjust playing time within one day.

If you want the presentation to be a recurring event, double-click the presentation timeframe
in the calendar. In the  window, set the following parameters:Schedule Presentation

Presentation: Specify which presentation you want to use in this schedule block.

Note
Alternatively, you can schedule a presentation by double-clicking a blank area on the schedule to open the   winSchedule Presentation
dow.

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting


Active all day, every day: Check this box if you want the presentation to play at all
times (i.e. without day parting).

Event time: Specify a timeframe during the day when you want the presentation to
play:

Start: Use the dropdown list to select a time when the presentation should
begin

End: Use the dropdown list to select a time when the presentation should
end.

Recurring Event: Check this box to have the presentation recur during specified
days. If you don't check this box, the  will only apply to the single dayEvent time
selected in the schedule.

Recurring pattern: Specify the frequency of the recurrence.

Daily: Specify , , or forEvery day Every weekday Every weekend 
playback.

Weekly: Check the boxes corresponding to the individual days of
the week when you want the presentation to play.

Range of recurrence: Use this option to limit the recurrence of the
scheduled presentation.

Start: Specify the start date of the scheduled recurrence. This date
defaults to the currently selected date in the schedule.

End: Select  to have the presentation recur indefinitely, orNo end
select  and specify the end date of the scheduledEnd by
recurrence.

Schedule Interrupts

You can create a day-parted schedule by scheduling presentations in separate time slots of a
single day (or a set of recurring days). Later on, you may need to schedule a new
presentation in an occupied time slot. This is where are useful.schedule interrupts 

 If you would like to interrupt a scheduled presentation with another presentation, drag and drop the new presentation into an occupied time slot 
(you can also schedule an overlap in the window). A  window will appear, providing the followingSchedule Presentation Schedule Conflict
options:

Keep existing events, cancel new event: Cancels the new schedule presentation action.

Keep existing events, adjust new event: Opens the  window, allowing you to schedule the new presentation inSchedule Presentation
an empty time slot. If you schedule the presentation in an occupied time slot, the  window will appear again.Schedule Conflict
Remove existing events, use new event: Completely removes the presentation currently occupying the time slot.

Interrupt existing events with new event: Schedules an interrupt in the presentation currently occupying the time slot. The date field
will be split into two columns: The left column shows the primary scheduled presentation in blue; the right column shows the interrupting
presentation in green. Primary scheduled presentations can be interrupted with multiple presentations, but interrupting presentations
cannot overlap with each other.



Debugging

Under , you may optionally enable the following:Debugging

Enable : The autorun script will output debugging information related to the presentation to the RS-232 serial port (asserial debugging
well as over Telnet and SSH if these features are enabled).

Enable system log debugging: The autorun script will output debugging information related to the presentation to the  tab in the Log Dia
.gnostic Web Server

Firmware Updates

Click  to include a firmware update file with the published schedule. In the window, locate theSpecify Firmware Update Firmware Update 
section corresponding to your BrightSign model and select one of the following:

Production Release: The current official release of BrightSign firmware

Beta Release: The current beta release of BrightSign firmware

Minimum Compatible Release: The minimum firmware version that supports presentations created by your version of BrightAuthor. The
minimum compatible firmware will likely not support all features provided by a contemporary version of BrightAuthor.

Select specific file: Use the button to select a  firmware update file from your hard drive. The other options will downloadBrowse .bsfw
the update file from BrightSign when the presentation schedule is published.

 

You can use the  dropdown menu to determine the behavior of the firmware update:Update type

Standard: The firmware update is applied, the player reboots, and the update file deletes itself from the local storage..bsfw 

Different: The update will only be applied if the version of the update file does not match the current firmware version of the player..bsfw 
The file is not deleted after the update process is completed.

Newer: The update will only be applied if the version of the update file is newer than the current firmware version of the player. The.bsfw 
file is not deleted after the update process is completed.

Save: The firmware update is applied, but the update file is not deleted. The device will only reboot once the storage device.bsfw 
containing the update file is removed.

Publishing the Scheduled Presentation(s)

Under , select a BrightSign player. You can publish to multiple players at once by holding down the  key while clicking each player.Publish Ctrl

If Bonjour is enabled in BrightAuthor: The player should appear in the list automatically. If the player does not appear, ensurePublish 

http://docs.brightsign.biz/display/DOC/Diagnostic+Web+Server
http://docs.brightsign.biz/display/DOC/Diagnostic+Web+Server


1.  

2.  

3.  

that it is set up for Local File Networking and that it contains an SD card or USB flash drive. Power cycle the unit, wait a minute, and click
 to refresh the list. If you're still having trouble, see the  for further troubleshooting steps.Bonjour FAQ

If Bonjour is disabled in BrightAuthor: You will need to add the player manually. Click  to open the window. Enter IPAdd BrightSign Unit 
address of the new BrightSign unit, and click . The player will be added to the list permanently (unless the player IP addressOK Publish 
changes).

 

Select one of the following publishing options:

New unit: The  window will open when you publish the presentation schedule, allowing you to configure (orBrightSign Unit Setup
reconfigure) device properties associated with the player(s). See the  page for more details.Local File Network Setup

Networked units: The presentation schedule will be published without modifying the device properties associated with the player(s).

Click . When the  window opens, click .Publish Publish Complete OK
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To publish a BrightWall™ presentation, navigate to the Publish tab, choose your desired publishing option (BrightSign Network, Standalone,
etc.), and select BrightWall™ Presentations in the top left. Note that BrightWall presentations and standard presentations cannot be placed on
the same schedule.

Adding BrightWall Presentations to Your Schedule

Follow these steps to add BrightWall presentations to the player schedule:

Select a BrightWall presentation from the list in the  section.Presentations 
Drag the BrightWall presentation to a time slot during which you want it to play.

Click and drag the selection handles to adjust playing time within one day.

 

If you want the BrightWall presentation to be a recurring event, double-click the presentation timeframe in the calendar. In the Schedule
 window, set the following parameters:Presentation

Presentation: Specify which BrightWall presentation you want to use in this
schedule block.

Active all day, every day: Check this box if you want the BrightWall presentation to
play at all times (i.e. without day parting).

Event time: Specify a timeframe during the day when you want the
BrightWall presentation to play:

Start: Use the dropdown list to select a time when the
BrightWall presentation should begin

End: Use the dropdown list to select a time when the
BrightWall presentation should end.

Recurring Event: Check this box to have the BrightWall presentation recur during
specified days. If you don't check this box, the   will only apply to theEvent time
single day selected in the schedule.

Recurring pattern: Specify the frequency of the recurrence.

Daily: Specify  ,  , or  forEvery day Every weekday Every weekend 
playback.

http://support.brightsign.biz/entries/36211214-How-do-I-get-Bonjour-for-BrightAuthor-
http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
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Weekly: Check the boxes corresponding to the individual days of
the week when you want the BrightWall presentation to play.

Range of recurrence: Use this option to limit the recurrence of the
scheduled presentation.

Start: Specify the start date of the scheduled recurrence. This date
defaults to the currently selected date in the schedule.

End: Select   to have the presentation recur indefinitely, orNo end
select   and specify the end date of the scheduledEnd by
recurrence.

Schedule Interrupts

You can create a day-parted schedule by scheduling BrightWall presentations in separate
time slots of a single day (or a set of recurring days). Later on, you may need to schedule a
new BrightWall presentation in an occupied time slot. This is where  areschedule interrupts 
useful.

If you would like to interrupt a scheduled BrightWall presentation with another presentation, 
drag and drop the new BrightWall presentation into an occupied time slot (you can also
schedule an overlap in the  window). A   windowSchedule Presentation  Schedule Conflict
will appear, providing the following options:

Keep existing events, cancel new event: Cancels the new schedule presentation
action.

Keep existing events, adjust new event: Opens the   windoSchedule Presentation
w, allowing you to schedule the new BrightWall presentation in an empty time slot. If
you schedule the BrightWall presentation in an occupied time slot, the Schedule

 window will appear again.Conflict
Remove existing events, use new event: Completely removes the
BrightWall presentation currently occupying the time slot.

Interrupt existing events with new event: Schedules an interrupt in the
BrightWall presentation currently occupying the time slot. The date field will be split into two columns: The left column shows the primary
scheduled presentation in blue; the right column shows the interrupting presentation in green. Primary scheduled presentations can be
interrupted with multiple presentations, but interrupting presentations cannot overlap with each other.

Publishing the Scheduled BrightWall Presentation(s)

 

Local Storage

Once you have finished scheduling your BrightWall presentation(s), click the button to bring up the  window:Publish Publish BrightWall

Publish each screen in a subfolder of a parent folder: The project and media files for each screen will be published in separate
subfolders of the specified parent folder. Use this option if you don’t want to publish to the SD cards of all the BrightWall players while in
BrightAuthor. This option is also useful if you’d like the entire BrightWall presentation contained in a package that can be easily
transported between directories, computers, etc.

Publish each screen individually: You will be given a separate prompt for publishing the project files of each screen. Use this option if
you want to immediately set up the SD cards for players in the video wall.

BrightSign Network

Select a BSN BrightWall Group using the dropdown menu under . The BrightWall configuration fileSelect BrightWall Group to Schedule
assigned to the group determines which presentations are available in the  list: A BrightWall presentation will notBrightWall Presentations
appear in this list if it uses a different configuration file from the group.

 If you haven’t created a BrightWall Group yet, navigate to the  tab to create one. Once you’ve created a BrightWall Group,Manage > Status
return to the  tab and click  to refresh the dropdown list. See the  Publish > BrightSign Network Creating a BrightWall on the BrightSign Network
page for a complete outline of the BSN BrightWall process.

Once you’ve selected a BrightWall Group, click  to assign the schedule to the BrightWall Group.Publish Schedule

Local Network
Once you have finished scheduling your BrightWall presentation(s), click the button to bring up the  window:Publish Publish BrightWall

Select a networked player next to each . Make sure the specified players correspond to the correct screen-locationScreen Name
numbers in the video wall. The screen-location numbers are shown in the screen layout window of the BrightWall presentation.

Click  to refresh the dropdown lists of players currently active on the local network.Refresh
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Click to add new networked players to the dropdown lists of players on the local network.Add 
Once all of the target players have been specified, click  to publish the video wall.\Publish

 

Simple File Network

Once you have finished scheduling your BrightWall presentation(s), click the button to bring up the  window:Publish Publish BrightWall

Publish each screen in a subfolder of a parent folder: The project and media files for each screen will be published in separate
subfolders of the specified parent folder. You will then need to upload the parent file to your file server.

Editing Zones

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

This section describes how to edit zone properties. Follow these steps to open the menu for a zone:Zone Properties 

Open a presentation project by clicking > .File Open Presentation
Click the tab and select .Edit Playlist
Under in the upper-left portion of the screen, select the zone you wish to edit.Zone 
Click . Different options will appear depending on the type of zone that is selected (see the sub-pages for details).Zone Properties
Repeat steps 2 – 4 for each zone you want to edit in your presentation.
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Video or Images Zones

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

Use the   window of a Video or Images Zone to edit the following:Zone Properties

View mode: Determines how videos will be scaled to fit in the zone. This option has no effect if the video and the zone are the same
size.

Scale to fit: Scales the video to fill the zone without maintaining the aspect ratio. The video may appear stretched.

Letterboxed and centered: Centers the video and adds black borders on the top and bottom. The aspect ratio is maintained.

Fill screen and centered: Centers the video and fills the zone. The aspect ratio is maintained, so the video may be cropped if
required.

Audio Output: Configure audio outputs for the zone. 

Note
The  and   options will not remove letterboxing if it's part of the video file.Scale to fit  Fill screen and centered
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Analog Stereo: Check this box to enable audio output via the 3.5mm audio connector (or USB Type C connector on the LS423).

HDMI: Check this box to enable audio output via the HDMI connector. 

Pass through: Supplies the un-decoded audio signal through the HDMI connector. Use this option if the zone audio (for
example, AC3 Dolby Digital) is being decoded on an external device.

Stereo: Supplies the decoded audio signal through the HDMI connector.

SPDIF: Check this box to enable audio output via SPDIF.

Pass through: Supplies the un-decoded audio signal through the SPDIF connector. Use this option if the zone audio
(for example, AC3 Dolby Digital) is being decoded on an external device.

Stereo: Supplies the decoded audio signal through the SPDIF connector.

Audio Mixing: Choose the mixing of the audio output:

Stereo: Outputs both left and right audio signals.

Left: Outputs the left audio signal only.

Right: Outputs the right audio signal only.

Image mode: Use the dropdown list to specify a setting for images.

Center image: Centers the image without scaling. This may result in cropping if the image is too large.

Scale to fit: Scales the image to fit the zone. The image is displayed as large as possible while keeping the correct aspect ratio.

Scale to fill and crop: Scales the image to completely fill the zone while maintaining the aspect ratio.

Scale to fill: Scales the image to fill the zone without maintaining the aspect ratio.

Initial volume (Audio): Sets the initial volume for audio files (0-100).

Initial volume (Video): Sets the initial volume for video files (0-100).

Minimum Volume: Sets the minimum volume for the zone (0-100).

Maximum Volume: Sets the maximum volume for the zone (0-100).

Video Only Zones

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

Use the  window to edit settings for a Video Only zone.Zone Properties 

View mode: Determines how videos will be scaled to fit in the zone. This option has no effect if the video and the zone are the same
size.

Scale to fit: Scales the video to fill the zone without maintaining the aspect ratio. The video may appear stretched.

Letterboxed and centered: Centers the video and adds black borders on the top and bottom. The aspect ratio is maintained.

Fill screen and centered: Centers the video and fills the zone. The aspect ratio is maintained, so the video may be cropped if
required.

Note
The  and and  outputs are only available on certain player models.Analog Stereo SPDIF

Note
The  setting will be overridden by other volume settings in a presentation, including the   setting for theMaximum Volume  Initial Volume
zone and volume commands attached to events or states.

Note
The  and   options will not remove letterboxing if it's part of the video file.Scale to fit  Fill screen and centered
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Audio Output: Configure audio outputs for the zone.

Analog Stereo: Check this box to enable audio output via the 3.5mm audio connector (or USB Type C connector on the LS423).

HDMI: Check this box to enable audio output via the HDMI connector. 

Pass through: Supplies the un-decoded audio signal through the HDMI connector. Use this option if the zone audio (for
example, AC3 Dolby Digital) is being decoded on an external device.

Stereo: Supplies the decoded audio signal through the HDMI connector.

SPDIF: Check this box to enable audio output via SPDIF.

Pass through: Supplies the un-decoded audio signal through the SPDIF connector. Use this option if the zone audio
(for example, AC3 Dolby Digital) is being decoded on an external device.

Stereo: Supplies the decoded audio signal through the SPDIF connector.

Audio Mixing: Choose the mixing of the audio output:

Stereo: Outputs both left and right audio signals.

Left: Outputs the left audio signal only.

Right: Outputs the right audio signal only.

Initial volume (Audio): Sets the initial volume for audio files (0-100).

Initial volume (Video): Sets the initial volume for video files (0-100).

Minimum Volume: Sets the minimum volume for the zone (0-100).

Maximum Volume: Sets the maximum volume for the zone (0-100).

Images Zones
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Version 4.4
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Use the  dropdown list to determine how images will be displayed in the zone:Image Mode

Center image: Centers the image without scaling. This may result in cropping if the image is too large.

Scale to fit: Scales the image to fit the zone. The image is displayed as large as possible while keeping the correct aspect ratio.

Scale to fill and crop: Scales the image to completely fill the zone while maintaining the aspect ratio.

Scale to fill: Scales the image to fill the zone without maintaining the aspect ratio.

Audio Only Zones
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Previous Versions 

Use the   window of an Audio Only zone to edit the following:Zone Properties

Audio Output: Configure audio outputs for the zone.

Analog Stereo: Check this box to enable audio output via the 3.5mm audio connector (or USB Type C connector on the LS423).

HDMI: Check this box to enable audio output via the HDMI connector. 

Pass through: Supplies the un-decoded audio signal through the HDMI connector. Use this option if the zone audio (for
example, AC3 Dolby Digital) is being decoded on an external device.

Stereo: Supplies the decoded audio signal through the HDMI connector.

SPDIF: Check this box to enable audio output via SPDIF.

Pass through: Supplies the un-decoded audio signal through the SPDIF connector. Use this option if the zone audio
(for example, AC3 Dolby Digital) is being decoded on an external device.

Note
The  and and  outputs are only available on certain player models.Analog Stereo SPDIF

Note
The  setting will be overridden by other volume settings in a presentation, including the   setting for theMaximum Volume  Initial Volume
zone and volume commands attached to events or states.

Note
The  and and  outputs are only available on certain player models.Analog Stereo SPDIF
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Stereo: Supplies the decoded audio signal through the SPDIF connector.

Audio Mixing: Choose the mixing of the audio output:

Stereo: Outputs both left and right audio signals.

Left: Outputs the left audio signal only.

Right: Outputs the right audio signal only.

Initial Volume: Set the initial volume for audio files (0-100).

Minimum Volume: Sets the minimum volume for audio files (0-100).

Maximum Volume: Sets the maximum volume for audio files (0-100).

Enhanced Audio Zones

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

Enhanced Audio zones provide similar functionality Audio Only zones, but allow cross-fading between audio files in the playlist: Fading occurs
from silence at the beginning of the audio playlist and to silence at the end of the audio playlist, while cross-fading occurs between audio files.

Use the   window of an Enhanced Audio zone to edit the following:Zone Properties

Audio Output: Configure audio outputs for the zone.

Analog Stereo: Check this box to enable audio output via the 3.5mm audio connector (or USB Type C connector on the LS423).

HDMI: Check this box to enable audio output via the HDMI connector. 

Pass through: Supplies the un-decoded audio signal through the HDMI connector. Use this option if the zone audio (for
example, AC3 Dolby Digital) is being decoded on an external device.

Stereo: Supplies the decoded audio signal through the HDMI connector.

SPDIF: Check this box to enable audio output via SPDIF.

Pass through: Supplies the un-decoded audio signal through the SPDIF connector. Use this option if the zone audio
(for example, AC3 Dolby Digital) is being decoded on an external device.

Stereo: Supplies the decoded audio signal through the SPDIF connector.

Note
The Maximum Volume setting will be overridden by other volume settings in a presentation, including the Initial Volume setting for the
zone and volume commands attached to events or states.

Important
Cross-fading will not work between audio tracks if they have different sampling rates (for example, if the first file is sampled at 48kHz
and the second is sampled at 44kHz). 

Note
The  and and  outputs are only available on certain player models.Analog Stereo SPDIF
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Audio Mixing: Choose the mixing of the audio output:

Stereo: Outputs both left and right audio signals.

Left: Outputs the left audio signal only.

Right: Outputs the right audio signal only.

Initial Volume: Set the initial volume for audio files (0-100).

Minimum Volume: Sets the minimum volume for audio files (0-100).

Maximum Volume: Sets the maximum volume for audio files (0-100).

Fade(in seconds): Sets the duration of cross-fading between audio files, as well as the fade in and fade out durations at the beginning
and ending of a playlist.

 

Ticker Zones
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Previous Versions 

Use the  window of a Ticker zone to edit the following:Zone Properties

Number of lines: Set the number of text lines in the Ticker zone.

Time to display each line: Set how long each line displays in the Ticker zone (in seconds).

Rotation: Use the dropdown list to select the rotation of text in the Ticker zone.

Alignment: Use the dropdown list to set whether text is left aligned, right aligned, or centered in the Ticker zone.

Text appearance: Specify how the text will appear on screen:

Animated: Text appears on screen from left to right (similar to a Teletype-style ticker).

Static Text: Lines of text appear without any animation.

Scrolling: Text scrolls across the screen (similar to a news or stock ticker). This option is only available for 4Kx42, XDx32,
XDx30, and HDx22 models. If this option is selected, the  parameter will be limited to 1 and the Number of Lines Time to

 parameter will have no effect. Display Each Line

Note
The Maximum Volume setting will be overridden by other volume settings in a presentation, including the Initial Volume setting for the
zone and volume commands attached to events or states.

Note
If you’re using a right-to-left language (such as Hebrew or Arabic) in your ticker zone, the right/left alignment settings will be inverted.
For example, setting a ticker zone with an Arabic RSS feed to “Right aligned” will actually align the text to the left side of the zone.

Note
The text can scroll from right to left, as well as left to right with firmware versions 6.1.37 and later: This scrolling
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Scroll speed:(Scrolling text only) Use the slider to set the scroll speed to 100%, 200%, 300%, or 400% of normal.

Foreground text color: Click  to select a color for the text in the Ticker zone.Choose
Background text color: Click  to select a color for the text background in the Ticker zone.Choose
Transparency: Use the slider to set the transparency of the text-background color: 0% is fully opaque, while 100% is fully transparent.

Font: Click  to select a font for text in the Ticker zone. You can use any TrueType font. Click  to reset theBrowse Reset to System Font
font.

Advanced

Click the  arrow to reveal the following options:Advanced

Background bitmap: Click  to navigate to and select a file for a background image.Browse
Stretch to Fit: Select  if you want to stretch the image to fill the zone. Otherwise, select .Yes No

Safe text region: Define the dimensions of the text region in the zone. If this region is not defined, the text will be displayed to the edge
of the zone.

X: The horizontal coordinate (in pixels) of the top-left corner of the safe text region.

Y: The vertical coordinate (in pixels) of the top-left corner of the safe text region.

Width: The width of the safe text region (in pixels).

Height: The height of the safe text region (in pixels).

 

Clock Zones
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Use the   window of a Ticker zone to edit the following:Zone Proprties

Rotation: Use the dropdown list to select the angle of text rotation in the Clock zone.

Foreground text color: Click  to select a color for the text in the Clock zone.Choose
Background text color: Click  to select a color for the text background in the Clock zone.Choose
Transparency: Use the slider to set the transparency of the text-background color: 0% is fully opaque, while 100% is fully transparent.

Font: Click  to select a font for text in the Clock zone. You can use any TrueType font. Click  to reset theBrowse Reset to System Font
font.

Advanced

Click the  arrow to reveal the following options:Advanced

Background bitmap: Click  to navigate to and select a file for a background image.Browse
Stretch to Fit: Select  if you want to stretch the image to fill the zone. Otherwise, select .Yes No

Safe text region: Define the dimensions of the text region in the zone. If this region is not defined, the time/date text will be displayed to
the edge of the zone.

X: The horizontal coordinate (in pixels) of the top-left corner of the safe text region.

Y: The vertical coordinate (in pixels) of the top-left corner of the safe text region.

Width: The width of the safe text region (in pixels).

Height: The height of the safe text region (in pixels).

 

direction depends on the language of the first text item used in the Ticker zone (e.g. Spanish text will set the ticker to
right-to-left, while Arabic text will set the ticker to left-to-right). 
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Background Image Zones
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You cannot edit the for a Background Image zone. If you only want a background color (instead of an image), do not add aZone Properties 
Background Image zone. Instead, change the background screen color in the tab.  File > Presentation Properties > Main 

Presentation Properties
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You can use the  window to edit a range properties for the current presentation. To edit presentation properties, open aPresentation Properties
presentation project and navigate to > .File Presentation Properties

Main
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The tab contains general presentation settings:Main 

Connector type: Use the dropdown list to indicate the type of connector you are using for your display.

Screen resolution: Use the dropdown list to set a resolution supported by your display.

Force Resolution: Check this box to have the player output the selected  even if the display reports over HDMI/VGAScreen resolution
that it does not support this resolution. If this box is unchecked, the player will attempt to use the selected  first, but willScreen resolution
then fall back to the highest resolution supported by the display if it is unsupported.

Enable 4.2.0 10-bit output:(XTx42, 4Kx42 models only) Check this box to output a 4.2.0 10-bit 4Kp60 or 4Kp50 video signal to the
connected display. See the  for more details on supported 4K color spaces and bit depths.video encoding FAQ

Background screen color: Click  to select a background color for the presentation. This color will show through if there's noChoose
content on an area of the screen, or if the content has some level of transparency (and is not located on top of other content).
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Language: Use the dropdown list to select a language for your presentation. This option affects the time/date display of Clock zones
only, and can be customized in the  tab.Edit > Preferences > Clock
RF channel scan file: Choose an RF channel scan XML file to associate with the presentation. All  states in the presentation willRF In
use this channel scan file. If you specify a different channel scan file in an RF In state, the RF channel scan file in this tab will change as
well.

Delay schedule change until current media item completes playback: Check this box to have a player wait until a media item
completes playback to switch to a new scheduled presentation. For multi-zone presentations, the first media item to complete playback,
no matter the zone, will trigger the scheduled presentation change. If this box is unchecked, a player will switch from one scheduled
presentation to another at the specified time, without taking into account where playback is in the current presentation.

 

I/O
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Many BrightSign models feature a DA15 GPIO port for device communication and interactive input/output. Select or for each GPIOInput Output 
port to indicate whether the port should be used to receive or send information.

 

Note
A player can only contain a single RF channel manifest at any one time. Playing the presentation associated with the RF channel scan
file will overwrite any previous RF channel configuration on the player. Furthermore, if you use a   state to create a new RFTuner Scan
channel manifest while the presentation is running, the RF channel manifest specified in   will be overwritten.Presentation Properties
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Interactive
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ON THIS PAGE

Serial

UDP

Synchronization

Touch

Use the  tab to configure settings for serial, USB, and UDP communications.Interactive
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Serial

Use this section to configure serial port communications:

Port: Select a serial port to configure. Most standard RS-232 serial devices enumerate on port 0. If you are connecting a USB-serial
device (such as a GPS receiver), it will enumerate on port 2.

GPS Receiver: Check this box if the port is being used to connect a USB-serial GPS device to the player.

Baud rate: Set the baud rate for serial communications on the port.

Data bits: Set the number of data bits.

Parity: Set the parity.

Stop bits: Select the number of stop bits.

Protocol: Determine whether the serial data is formatted as  or .Binary ASCII
Send EOL: Select the end-of-line character when sending data to a serial device.

Receive EOL. Select the end-of-line character when receiving data from a serial device.

Invert Signals: Check this box to invert the send pin and receive pin of the serial port.

UDP

Use this section to configure UDP communications:

UDP Destination Address: Specify where UDP commands generated by the presentation should be sent:

Specific IP Address: Enter a single destination IP address in dotted quad form.

All devices on the local subnet: Select this option to broadcast UDP messages to all devices on the local subnet.

UDP Destination Port : Specify the destination port for UDP messages generated by the presentation.

UDP Receiver Port: Specify the port used by the player to receive UDP messages (for triggering UDP Input events on the player).

Synchronization

Check the Enable enhanced synchronization box to use a player synchronization scheme similar to the BrightWall™ feature. When this feature
is enabled, interactive presentations using Synchronize events can be easily linked by a master/slave scheme: The presentation sending a Synch

 ronize command acts as the master, while the presentation(s) using Synchronize events act as slaves. Synchronize events associated with slave
presentations will trigger within a few milliseconds of the Synchronize command associated with the master presentation.

Master: Select this option to have the presentation send Synchronize commands. A master presentation cannot contain Synchronize
events (i.e. you cannot chain one master presentation to another).

Slave: Select this option to have the presentation receive Synchronize commands (via Synchronize events).

Domain: Enter a domain number between 0 and 127. This number needs to be unique for each set of master/slave presentations on the
local network. This will ensure that multiple groups of synchronized presentations can operate on the same local network without
synchronization messages interfering with each other.

Touch

Use this section to configure Rectangular Touch events:

Cursor: Select a mouse display option for Rectangular Touch events:

Always hide cursor: The mouse cursor will never appear with Rectangular Touch events.

Always display cursor: The mouse cursor will always appear with Rectangular Touch events

Auto display cursor: The mouse cursor will be present only if there is more than one touch region on the screen.

Flip coordinates: Check this box to reverse the coordinates of the touchscreen input.

Buttons
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Use the dropdown list to select the type of button panel (BP200 or BP900) you wish to configure. The A, B, and C letters specifyButton Panel 
which device is enumerated first; the B and C letters are only applicable if you are connecting more than one BP device of the same model
number to the player.

Choose one of the following:
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Automatically configure which buttons are enabled: Only buttons that are configured with BP200/BP900 events in the presentation
will be enabled. All other buttons will not light up or react to button presses

Specify which buttons are enabled: Only the specified buttons will be enabled regardless of whether there are BP200/BP900 events in
the presentation that are configured to use them. If this option is selected, a BP200/BP900 event set to the option will onlyAny Button 
react to button numbers that have been enabled.

 

Audio
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Set any of the following:

Audio: Set the  and  for the audio output (0 – 100).Minimum Volume Maximum Volume
HDMI: Set the  and  for the HDMI output (0 – 100).Minimum Volume Maximum Volume
SPDIF: Set the and for the SPDIF output (0 – 100).Minimum Volume Maximum Volume 

 

Media List

Note
The settings for , , and  will be overridden by other volume settings in a presentation, includingMaximum Volume Audio HDMI SPDIF
the  setting for a zone and volume commands attached to events or states.Initial Volume
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These settings pertain to Images List, Audio List, and Video List states:

Return to start after inactivity: Check the  box to have Media List states play from the beginning upon reentry after a designatedYes
period of inactivity. In this case, "inactivity" is defined as any time not spent within the Media List state.

Inactivity timeout (seconds): Specify the period of inactivity before Media List states restart. If the presentation spends longer than this
amount of time outside the Media List, it will play from the beginning of the list upon reentry.

 

 

Autorun
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If you would like to specify a different autorun file for the presentation, click . Click to locate and select theSelect custom Autorun Browse 
autorun file.

Click  to add a custom script to your BrightAuthor presentation. Script plugins are custom pieces of BrightScript code thatAdd Script Plugin 
extend the functionality of BrightAuthor. Please see the  tech note for more information.BrightAuthor Plugins and Parsers

 

Note
Because you must edit custom autoruns every time the firmware version changes, we recommend using script plugins (which are
mostly immune to changes in the system software) for advanced presentation development.
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Image Cache

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

The Image Cache tab displays a list of all image files in your presentation. Selecting an image will preload it into player memory–it will then load
Note that the  space is displayed below–you cannot exceed the allowed space withand display much faster during playback.  Available cache

cached images.

You can preload up to 16MB of images. If an image is compressed (e.g. .jpeg, .png), then it will use more memory than its reported file size in
Windows/Mac, and BrightAuthor will show this larger file size when you add it to the Image Cache list. Since Bitmaps (.bmp) are not compressed,
the reported file size of a Bitmap image accurately represents how much memory it will use.

Important
Cached images are always displayed at their full resolution–they cannot be scaled up or down. Make sure the size of the image
matches the size of the zone.
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Variables

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

ON THIS PAGE

Device Web Page Display

User Variables

Adding User Variables 

Integrating User Variables with Commands

Use this tab to configure the device web page, enable Media Counters, and create User Variables.

Device Web Page Display

The device web page allows you to view and edit User Variables over your local network. In order to display a standard or custom device web
page, you must first enable the  during player setup.Local Web Server

No device web page: Choose this option if you would like to enable the Local Web Server but do not want the User Variables webpage
to be accessible.

Standard device web page: Choose this option to enable the default device web page, which lists all User Variables and their
default/current values on a sparsely formatted page.

Custom device web page: Choose this option to use a device web page with custom appearance, formatting, and functionality. See the 
 tech note for more information.Creating a Custom Device Web Page

Alphabetize variable names: Check this box to list variables on the Device Web Page alphabetically, rather than by order of creation.

User Variables

User Variables are customizable values that can be used in ,  states, and . When used in Live Text, Usercommands Live Text Conditional Targets
Variables display the current value of the variable. The value can also be changed during a presentation using the Set Variable or Reset Variable
commands.

Automatically create media counter variables: Check this box to create Media Counters for all media files in the presentation. Media
Counters record how many times a file has played in a presentation. They can be displayed in  or extracted from the BrightSignLive Text
player via USB. For details on retrieving Media Counters via USB, see the   page.Using Advanced Tools

Reset variables to their default value on presentation start: Check this box to reset all User Variables to their default values
whenever the presentation begins. If this box is unchecked, User Variable values will be preserved on the SD card after the device
reboots, the presentation is switched, etc.

Update frequency for networked variables: Use the dropdown list to determine how often networked User Variables should be
refreshed by  that are assigned to the presentation.Data Feeds

Adding User Variables 

Click to add a new User Variable to your presentation. Then, specify the following:Add Variable 

Name: Enter a unique name for the User Variable.

Default Value: Specify an initial value for the User Variable. Whenever a User Variable is reset (via the Reset Variable ), it willcommand
return to this default value.

Access: Select to make the User Variable accessible to other presentations scheduled on the player. If two presentations use aShared 
variable with the same name, the value of the variable with the attribute will be used for the variable with the  attribute.Shared Private
Type: Select a User Variable type: 

Local: Local variables can be changed with the Set Variable/Reset Variable  or via the . They cancommands Local Web Server
also be set with properly formatted .serial, UDP, and Plugin Message commands

Note
Setting a new   and republishing the presentation will not set the value of that variable to the new default value.Default Value
Instead, the variable will retain whatever value it had before the publish operation. To set variables to their new default values,
you will need to check the   box before publishing theReset variables to their default value on presentation start
presentation. To set a single variable to its new default value, use the   command.Reset Variable
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Networked: Networked variables are set and modified using  (RSS, Live Data, or Dynamic Playlists). To create aData Feeds
networked User Variable, you must first specify the Data Feed it will be linked to. Select the desired Data Feed from the
dropdown list and click  to ensure the link is operational and has correct RSS formatting.Validate

SystemVariable: System variables are not determined by the user, but by independent system parameters, such as
firmware/autorun version number, IP address, RF channel count, and various types of EDID (extended display identification
data) information received from the display over HDMI. 

To delete a User Variable, click the  beside the appropriate variable. You can also use the  button to delete allX Delete Unused User Variables
user variables that are not currently in use by Live Text states, commands, events, conditional targets, etc.

Integrating User Variables with Commands

User Variables can be used to dynamically set the parameters of many commands: Set Volume, Increment Volume, Decrement Volume, Send
UDP, Serial-send string (EOL), Serial-send string (no EOL), Serial-send byte, Serial-send bytes (comma separated), Synchronize, Send Zone
Message, Link Zones, GPIO On, GPIO Off, GPIO Set State, BrightControl – Send Ascii String, BrightControl – Philips Set Volume, and Pause.

For example, if you add a Set Volume command to your presentation and use a static value like 50, the volume will always be set to 50 when the
command occurs. If you use a User Variable instead, the volume will be set to the current value of the variable, which could be any value based
on   and any number of other factors.Set Variable commands

To utilize a User Variable in a command, first add the command (see the   page for details). Then, in the  field, enter theCommands Parameters
name of the variable between two sets of dollar signs (e.g. “$$variable1$$”). BrightAuthor will not recognize the variable without these dollar
signs.

 

Data Feeds

BrightAuthor Version 4.6

Note
Every RSS entry has a <title> value and a <description> value: use the <title> value to designate the name of the User
Variable being modified; use the <description> value to change the value of the User Variable.

Note
Displays will often lack a complete set of EDID parameters. Make sure to test the EDID values of a certain display
model before using them in a presentation.
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Use this tab to create and edit data feeds, which you can use to populate , , and   states. Data feedsLive Text RSS Media RSS / Dynamic Playlist
can also be used to generate .Networked User Variables

Adding Data Feeds

To add a new data feed, click and specify the following:Add Live Data Feed 

Feed Name: Specify a name for the data feed. You will be
able to locate the data feed by this name when you are
creating a Live Text element, specifying an RSS, MRSS, or
Dynamic Playlist feed state, or creating a Networked User

.Variable

Feed Specification: A data feed can originate from one of
several sources. Select one of the following:

Url: If you have an RSS or MRSS feed hosted on a
third-party server, enter the web address of the
feed into this field. If you want the presentation to
retrieve a feed from an RSS file on the SD.xml 
card, use the “ ” URL format (e.g. “file:///path file:///fil

”).ename.xml

Live Data Feed: If you have a BrightSign Network
subscription, you can host RSS feeds on the BSN
servers using the Live Data Feed feature. See the 

 for more information.Live Text FAQ

Live Media Feed: If you have a BrightSign
Network subscription, you can host MRSS feeds
on the BSN servers using the Live Media Feed
feature.

Dynamic Playlist: If you have a BrightSign
Network subscription, you can use Dynamic

 as media feeds.Playlists

Tagged Playlist: If you have a BrightSign Network
subscription, you can use  asTagged Playlists
media feeds.

Match Player Tags: Check this box to
match  in the Tagged Playlistmedia tags
against  for players that areplayer tags
assigned this presentation: When this box is checked, a player must have the same tag name and value as a media file
in the Tagged Playlist; otherwise, that media file will not be played. 

Refresh: Click this button to update the content of the , , and  dropdown lists.Live Data Feed Live Media Feed Dynamic Playlist
Data feed content usage: Determine how you wish to utilize the data downloaded from the feed:

Text: The feed will be displayed as text in a Ticker zone or Live Text feed.

MRSS Feed: The feed will be used to download and play media in a Media RSS or Live Text state.

Support 4K images: Check this box if you wish to use the MRSS feed to download and display 4K images. This feature
is only supported on 4Kx42 players. Displaying 4K images will use the 4K video decoder on the device (i.e. you cannot
display a 4K image and a 4K video at the same time).

Content for Image List, Video List, Audio List, or Play File: The player will download and store media files specified in the
Data Feed. You can then play back the media files using a Media List or Play File state. Each media file must be specified as a
download URL in a <description> field of the RSS feed. Note that this mechanism is not compatible with the download and
playback features of MRSS feeds and Dynamic Playlists.

Validate: Click this button to ping the feed you specified in the Url, Live Data Feed, Live Media Feed, or Dynamic Playlist field. Use
this feature to check whether you entered the URL correctly, or whether the selected BSN feed still exists.

Update Interval: Specify how often you want the player to check the feed URL to determine if there are any updates.

Plugin Script:  Use the dropdown list to select a plugin script–you can add plugin scripts to your presentation using the Add Parser
button (see below).Plugin 

Important
If the amount of time it takes to cycle through all the entries in the Data Feed is longer than the  , the presentation willUpdate Interval
never display all items in the feed. Make sure to specify an   that is long enough to display the entire feed.Update Interval
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Optimize Feed Updates: Check this box to have the player make an HTTP HEAD request before retrieving the contents of a feed
(unless it's the first time a feed is downloaded). This option will reduce network traffic related to feed downloads as long as the feed host
has implemented the HTTP header functionality. 

If the   value has changed, or the server does not respond to the HTTP HEAD request, the player will make anLast-Modified
HTTP GET request to download the feed.

If the   value in the HTTP header has not changed since the last time the player checked in, the player will notLast-Modified
attempt to download the feed. 

Automatically generate User Variables from Data Feed: You can use Data Feeds to populate a set of User Variables for HTML5
pages. The User Variables can then be retrieved using JavaScript. Use the  tag of the Data Feed to specify the Name<title>  of a

variable and the  tag to specify its default value.<description>

Access: Select  to make the User Variable accessible to other presentations scheduled on the player. If twoShared 
presentations use a variable with the same name, the value of the variable with the  attribute will be used for the variableShared 
with the   attribute.Private

Adding a Parser Plugin

This is an advanced feature: You may optionally choose to have an RSS or MRSS feed parsed by  . This occurs after thecustom BrightScript code
feed is retrieved from the network and before it is provided to Live Text states, Media RSS Feed states, and other presentation features.

Click the  button to add a parser plugin to your presentation.Add Parser Plugin 

Parser Script: Click   to locate and select the BrightScript ( ) parser file.Browse .brs  

Feed Parser: Enter the name of the feed-parser function in the script.

User Agent String: Enter the name of the parser function for user-agent strings.

User Variable Parser: Enter the name of the user-variable parser function in the script.

 

HTML Sites
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Use this tab to add HTML5 sites to your presentation. You must add sites in this tab before you can include HTML5 states in the playlist.

Adding an HTML Site

To add an HTML5 site, click Add HTML Site and specify the following:

HTML site name: Enter a name for the HTML5 site.

Local Content: Select this option to display HTML5 content using files located on the local storage of your computer. Click the  bBrowse
utton to locate the  file that you wish to display..html

URL: Select this option if you wish to play an HTML5 page from a web address.

Query string (optional): Enter a query string to be appended to the site URL using the following format: "http://www.example.com/over/t
". You can specify the query spring as either a static value or a . To utilize a User Variable, enter thehere?my_query_string User Variable

name of the variable between two sets of dollar signs (e.g. “$$variable1$$”). BrightAuthor will not recognize the variable without these
dollar signs.

Note
The player ignores milliseconds when comparing the  values.Last-Modified

Important
If you want to use the application cache for HTML5 sites (which allows the player to cache remote HTML content on the local storage),
you will need to enable the Limit storage space by function option in Edit > Preferences > Storage. HTML5 sites must be
configured properly for caching to work.
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Settings

Enable Javascript console: Check this box to enable the JavaScript console for HTML sites. To access the JavaScript console while
the player is running, open a web browser on a device connected to the same local network as the player. Then, enter the IP address of
the player, followed by port number 2999 (for example, “ ”). You will be able to inspect any page added to the http://10.1.0.154:2999 HTML

tab, not just those currently running.Sites 

Switch Presentations
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Use this tab to publish additional presentations to the SD card along with the primary presentation. You can use the Switch to Presentation comm
 to switch to another presentation while a presentation is running.and

 

Note
You must use a WebKit-based browser (e.g. Chrome, Safari) to access the JavaScript console.
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Use this tab to publish additional files to the SD card along with the presentation. This feature is useful if you frequently publish files that are not
used in the presentation itself (for example, a media file being played by a custom script) and you want to automate the process of publishing both
presentation files and custom files.

 

UDP
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This tab provides an easy way to keep track of all UDP events within an interactive presentation. You can also edit the and change the Label Sho
 option within individual .w in BrightSign App UDP Input events

 

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting


Editing Preferences

BrightAuthor Version 4.6

Version 4.4

Previous Versions 

ON THIS PAGE

Video

Images

Interactive

Clock

Live Text 

Networking 

UI

Content

Publishing

Save Properties

Content Update Password Cleared Warning

Transitions

New BrightSign Presentation Initial Folder

Backups

Storage 

Whenever you create a new project, various presentation properties will be set using the default settings. If you often use the same set of
properties, you can save time by changing the default settings to what you use most often. To edit default settings, navigate to Edit >
Preferences on the menu bar.

Changing default settings in the Video, Images, Interactive, Clock, and Live Text tabs does not adjust values in the current project. The
Networking, UI, Backups, and Storage tabs are related to other aspects of the publishing process, and will therefore apply to the current
presentation as well. 

VIDEO

 The Video tab allows you to specify default settings for video states.

Volume: Specify a default value between 0 and 100.

Live video – time on screen: Set a default period for live videos to remain on screen (in seconds).

IMAGES

The  tab allows you to specify default settings for image states.Images
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Slide transition: Use the dropdown list to set an effect for image transitions.

Slide delay interval: Set how long each image displays (in seconds).

INTERACTIVE

Use the  tab to set a default timeout period for media files (in seconds).Interactive

CLOCK

Use the dropdown list to link the date and time format to a language. This option affects the date/time display in Clock zones. To customize the
format, click  to open the  window.Customize Clock Localization

Date: Use the  field to customize the date format on the player (refer to the chart of terms for different abbreviation styles). Use the Edit P
 button to see an example of how the date format will look. You can also customize how months and days are displayed inreview date

both and  form.Short Long
Time: Use the  field to customize how time is displayed on the player (refer to the chart of terms for different measurements). Use theEdit

 button to see an example of how the time format will look. You can also customize how the AM and PM abbreviations arePreview time
formatted.

LIVE TEXT 

Use the tab to edit default preferences for text fields in Live Text states:Live Text 

Alignment: Use the dropdown list to set whether the text is left aligned, right aligned, or centered.

Foreground text color: Click to select a color for the text.Choose 
Background text color: Check this box to include a background color for text fields. Click and set a default color for theChoose 
backgrounds.

Transparency: Drag the bar to set the transparency for the background text color.

Font: Click  to locate and select a font for the text. You can use any TrueType font. Click  to reset the fontBrowse Reset to System Font
to the default.

Font size: Select  to fit the text to the height of the text field, or select to enter a value for the font size (1 -Automatic Fixed point size 
500).

 

Note
A BrightSign Network account can only have one date/time format setting: Changing the date/time format for one presentation, and then
uploading it to the BrightSign Network, will change the date/time format for all presentations on your account. Similarly, a standalone
player can only have one date/time format, even if there are multiple presentations scheduled on the player.

Note
Transparency does not appear in the Live Text image preview or in Presentation Preview. You will need to publish the presentation to a
BrightSign player to view the level of transparency.



NETWORKING 

The  tab allows you to enable and disable networking options in BrightAuthor.Networking

Enable BrightSign Network: Check this box to enable BSN features in the ,  and  tabs, as well as the Create Publish Manage BrightSig
 window.n Unit Setup

Enable BrightSign Local Networking: Check this box to enable Local File Networking (LFN) options in the  and tabs,Publish Manage 
well as the  window..BrightSign Unit Setup

Enable Bonjour: Check this box to enable Bonjour. BrightAuthor uses Bonjour to detect LFN players on the local network; if
Bonjour is disabled, you will need to enter the IP address of each LFN player manually to publish to it and manage it. See this

to learn more about installing Bonjour for Windows.FAQ 

Enable Simple File Networking: Check this box to enable Simple File Networking (SFN) options in the  tab and Publish BrightSign
 window.Unit Setup

Use Proxy Server: Check this box if BrightAuthor needs to communicate through a proxy server to reach the Internet. Enter the Address
and  of the proxy server. If the proxy server requires authentication, you will be prompted to enter login credentials. If the proxy usesPort
a Windows domain for authentication, you will also need to specify a domain name.

UI

The  tab allows you to edit various options related to the BrightAuthor playlist UI.UI

Content

Show Image File Resize dialog?: Displays a dialog box whenever you add an image that is larger than the maximum image size
allowed by the player model. It will give you the option to either cancel the action or create a downscaled copy of the image to use in the
playlist.

Resize image files for BrightSign: Automatically creates a downscaled copy whenever the original size of the added image is too large.

Publishing

Show file overwrite dialog?: Displays a dialog box asking whether you want to overwrite preexisting files when publishing a
presentation.

Copy and replace duplicate files when publishing locally?: Overwrites media files with the same name when publishing locally.

Show Save Schedule dialog?: Displays a dialog box when you exit the  tab, asking if you would like to save the schedule as aPublish
separate file. You can then use this schedule file with any presentation by navigating to  while in the  tab.Schedule > Open Publish
Show read/write file system warnings dialog?: Displays a warning whenever you attempt to publish to a file system that is not fully
supported.

Show read only file system warnings dialog?: Displays a warning whenever you attempt to publish to a file system that does not allow
file writes on the BrightSign player. Player logs and network updates are not supported on read-only file systems.

Save Properties

Show Save Properties dialog: Displays a dialog box whenever you exit the  window having made changes toPresentation Properties
the settings. The dialog box will ask you whether you want to apply the new settings to the current presentation or to all future
presentations in addition to current presentation.

Content Update Password Cleared Warning

Show Content Update Password Cleared Warning dialog: Displays a dialog box whenever you publish a content update that will clear
the .Content Update Password

Transitions

Display Mode: Determine how BrightAuthor draws event connections between states in the interactive playlist area:

Automatic: Displays either a line or a label, depending on the current playlist layout.

Always display line: Displays event lines between states.

Always display label: Displays numbered event labels that show connections between states.

Label Location: Determine where numbered event labels are located:

Bottom: Numbered event labels are located below states.

Right: Numbered event labels are located to the right of states.
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New BrightSign Presentation Initial Folder

This option refers to the  save destination folder in the  window. Select one of the following:Where New Project

Last Folder Used: The destination defaults to the last folder used to save a presentation project.

My Documents: The destination defaults to the  folder.My Documents

BACKUPS

The tab allows you to configure automated backup saves for projects (in case BrightAuthor closes without saving the presentationBackups 
project).

Automatically backup BrightAuthor presentation files: Check this box to enable automated saving of BrightAuthor presentation files.
Specify how often you want backup saves to occur.

Backup a maximum of this number of backups: Specify how many backup copies of a single presentation can exist. Once this limit is
reached, BrightAuthor will begin overwriting backup copies, beginning with the oldest file.

STORAGE 

Checking the  box allows you to divide the presentation storage device (SD card, USB drive, etc.) into differentLimit storage space by function
segments. You can then allot maximum sizes to those segments to ensure that a certain type of data does not take up too much space on the
storage device.

Note that, if you select , it is possible to specify a combined set of segments that is larger or smaller than the absolute sizeSpecify absolute size
of your storage device. If you select , you will need to ensure that the percentages add up to 100% (which is equivalent toSpecify percentages
the absolute size of the storage device).

The segment types are specified as follows:

Published data: The maximum size allotted to all presentation and content files that are written to the storage device during the publish
process. This includes audio, video, images, text, and HTML content files.

Dynamic data: The maximum size of all dynamic content, including Dynamic Playlists and MRSS feeds. When this segment runs out of
space, dynamic content files will be deleted to create space, starting with the oldest files first.

HTML data: The maximum size of the HTML application cache.

HTML local storage: The maximum size of all JavaScript variables and data.

HTML IndexedDB: The maximum amount of storage allocated to the IndexedDB web database application.

Advanced Features
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This section outlines advanced features offered by BrightAuthor.

IMPORTING AND EXPORTING

There are three types of import/export actions available from the   menu: Export Presentation, Import/Export User Variables, and Import/ExportFile
User Events.

Export Presentation

Exporting a BrightAuthor presentation makes it easier to transfer that project between different PCs and versions of BrightAuthor. Navigate to File
 and select a folder for export. All relevant presentation files, including media files and user defined events, will be placed in the target> Export…

folder. You can open the project by double-clicking the  file that was exported..bpf 

Import/Export User Variables

You can transfer the   set of one presentation to another. This saves time when you are creating multiple presentations that use theUser Variable
same set of User Variables. The User Variable set is exported as a   file, which is also an editable XML document..buv

Note that importing networked User Variables to a new presentation does not import the Data Feeds to which those variables are linked. If you
import networked User Variables, you will need to recreate the associated feeds in the   tab and reassignPresentation Properties > Data Feeds
them to the variables.

Import/Export User Events

These actions allow you to transfer   between presentations. This is useful when creating multiple presentations that useUser Defined Events
many of the same or similar events.

PRESENTATION TREE VIEW

The Presentation Tree View feature allows you to view a presentation as a set of expandable/collapsible zones, states, events, and commands.
You can use this feature to easily navigate all state information in a presentation without double-clicking numerous icons and navigating through
tabs. You can access this feature by navigating to  . File > View Presentation Tree

RF CHANNEL SCANNING 

Before you can use the   state to display live video, you will first need to perform a channel scan. You can perform a channel scan either asRF In
an independent action (similar to setting up a player) or as a state in an interactive presentation. The user interface for the   window isScan Setup
the same for both methods. See the   page for more information about using channel scanning in an interactive presentation.Tuner Scan

Follow these steps to perform a channel scan as an independent action:

Navigate to  .Tools > Setup RF Channel Scan
Channel Map: Select QAM, ATSC, or ATSC and QAM (consult your service provider for details).

Modulation Type: Select QAM 64, QAM 256, or QAM 64 and QAM 256 (consult your service provider for details).

First RF Channel (optional): You can choose to limit the range of the channel scan by selecting the first channel to scan.

Last RF Channel (optional): You can choose to limit the range of the channel scan by selecting the last channel to scan.

Click OK and write the channel scan settings to an SD card or USB drive.

Power off your BrightSign XD1230.
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Insert the SD card or USB drive into the player and power it back on. The progress of the channel scan will be displayed on screen.

Once the scan is complete, the channel settings will be written to the internal registry of the player (i.e. the non-removable storage). You
can now use the RF In state to tune to any virtual channels that were detected in the channel scan.

Publishing Channel Scan Results 

If you are connecting multiple XD1230 players to the same cable source, you can transfer the results of a channel scan from one player to
another during the setup process.

After performing a channel scan, reinsert the SD card or USB drive into your PC.

In BrightAuthor, navigate to  .Tools > Setup BrightSign Unit
Specify device settings as desired (see the  for more details).Setting up BrightSign Players

Under  , click browse and locate the “ScannedChannels.xml” file in the SD card or USB drive directory.RF Channel Scan Data (optional)
Click  .Open
Publish the setup files to the player. The player will now have the same channel configuration as the original XD1230.

 

Managing Your Network
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You can use the BrightAuthor  tab to manage players on your BrightSign Network account, as well as the players on your local network.Manage
The  window (accessible by navigating to ) offers additional player management options.Advanced Tools Tools > Advanced

If you don't see BrightSign Network features in the  tab or window, ensure that the BrightSign Network is enabled in Manage Advanced Tools Edi
 and sign in by navigating to > .t > Preferences > Networking Tools Sign in to BrightSign Network

Status
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The Status section allows you to view the statuses of players and groups on your BrightSign Network account.

Each channel takes approximately one second to scan. Specifying  and  will reduce the amount ofFirst RF Channel Last RF Channel
time it takes to perform the scan. You should only use these two options if you are familiar with the channel map of the cable source.
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Groups

You can use groups to distribute presentations to a set of BrightSign players.  a presentation to a group delivers it to all BrightSignPublishing
players within that group. BrightAuthor includes two default groups:  and . However, you can create additional groups as needed:Default LocalTest

To create a group: Click (beneath the  window). Type a name for the group and click .Add Groups Groups OK
To delete a group: Right-click a group and click .Delete
To move a player to a different group: Click the arrow next to the group that contains the player. Then click and drag the player to the
new group.

 

Click the arrow beside a group to view details about players within that group:

Status: A range of colors (green, yellow, red) used to indicate the status of a BrightSign player. Please see this  for more informationFAQ
on what each color means.

Name: The name of the player

Description: The description given to the player

Active : The name of the current presentation being run on the playerPresentation
Last : The last time the player checked in with the BrightSign Network serversconnection
Checks for content every: The interval for synchronizing with the BrightSign Network servers to determine if there is new content to
download. This interval can be modified by right-clicking the player and selecting .Edit

 

Right-click a player to access options associated with it: 

View Remote Snapshots: Opens a window that allows you to view Remote Snapshot images taken by the player. When the window
opens, the latest snapshot will be displayed. Past snapshots are displayed as thumbnails below. Double click a snapshot thumbnail to
view it as a full size image. The number, quality, and frequency of snapshots is determined during the  process.Unit Setup

Refresh: Click this button to get the most up-to-date snapshot(s) from the player.

Date/Time: The timestamp indicating when the snapshot was taken. The timestamp is formatted as follows: yyyy:mm:dd
hh:mm:ss

Serial Number: The serial number of the player taking the snapshot

Model: The model number of the player taking the snapshot

Firmware: The firmware version of the player taking the snapshot

Edit: Opens the  window, which allows you to edit many of the parameters set during the  process, including theEdit Unit Unit Setup
name/description, group, and Remote Snapshot settings.

Tags: Opens the window, which allows you to add tags to the player. You can use player tags to conditionally filter mediaDevice Tags 
in   on a player-by-player basis. See this  in the BSN WebUI documentation for more information about playerTagged Playlists section
tags.

Delete: Removes the player from the BrightSign Network. The player will continue playing content, but it can no longer be updated or
monitored.

Info: Provides details about the player hardware, software, networking, and subscription status.

Download Progress: Displays the progress of the most recent content synchronization action.

Note
The Remote Snapshot feature is not available for the LS422, HD220, or HD1020.
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BrightWall Groups

Use the  section to manage players that are assigned to BrightWall video walls.BrightWall Groups

Note some important differences between BSN BrightWall groups and standard BSN groups:

Each player is part of a BrightWall: It has a  indicating the section of the BrightWall to which it belongs. Screens are numbered byNumber
row, starting from the top-left section of the BrightWall (the example diagram to the right shows the numbering of a 4x3 BrightWall).

Each BrightWall consists of a number of players: The  will only display green if all players in the BrightWall are green, or red if allStatus
players in the BrightWall are red. If the players are a mix of red, green, or yellow, the  will display yellow.Status

Each BrightWall group consists of one or more BrightWall(s): BrightWall(s) within the same BrightWall group use the same Configuration
File. This means that each BrightWall group represents a certain BrightWall configuration (for example, a 3x2 video wall using HDMI, with
a 3% bezel ratio). Like standard BSN groups, BrightWall(s) within the same BrightWall group are assigned the same schedule. 

Note in the diagram below how each BrightWall within a BrightWall group has the same configuration, and how each player can only be assigned
to one BrightWall at a time.

 



Creating a BrightWall Group 

To create a BrightWall group, click  (located below the  window) and enter the following:Add BrightWall Group BrightWall Groups

BrightWall group name: The name of the BrightWall group

BrightWall configuration. The BrightWall Configuration file that will be associated with the BrightWall group. To add a BrightWall
Configuration file to the list, upload a BrightWall presentation that uses the configuration file to the BrightSign Network in the Create >

 tab.BrightWall

Players and BrightWall(s) are added to a BrightWall group during the  process. Unit Setup

 

Presentations
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Presentations

BrightWall Presentations

BrightWall Configurations

The Presentations section allows you to view all presentations, BrightWall presentations, and BrightWall configuration files uploaded to the
BrightSign Network.

Presentations

Click the down arrow next to  to view a list of all presentations uploaded to the BrightSign Network:Presentations

Active: A checkmark will be displayed in this field if the presentation is currently assigned to one or more groups. Use the  button to view
the  list.Current Active Groups
Name: The name of the presentation

Date modified: The last time the presentation was modified in BrightAuthor or uploaded via the BrightSign Network WebUI

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting


Right-click a presentation to perform an action:

Delete: Removes the presentation from your BrightSign Network account. This action cannot be performed if the presentation is currently
assigned to a group.

Download: Downloads the presentation file and assets to the specified folder. You cannot download presentations that were created with
the WebUI.

BrightWall Presentations

Click the down arrow next to   to view a list of all BrightWall presentations uploaded to the BrightSign Network:BrightWall Presentations

Active: A checkmark will be displayed in this field if the BrightWall presentation is currently assigned to one or more BrightWall groups.
Use the  button to view the  list.Current Active BrightWall™ Groups
Name (BrightWall Configuration): The name of the BrightWall presentation, as well as the configuration file used for that presentation

Date modified: The last time the BrightWall presentation was modified in BrightAuthor

Right-click a BrightWall presentation to perform an action:

Delete: Removes the BrightWall presentation from your BrightSign Network account. This action cannot be performed if the BrightWall
presentation is currently assigned to a BrightWall group.

Download: Downloads the BrightWall presentation file, configuration file, and assets to the specified folder.

BrightWall Configurations

Click the button next to   to view a list of all BrightWall Configuration files uploaded to the BrightSign Network:BrightWall Configurations

Active: A checkmark will be displayed in this field if the configuration file is being used for one or more BrightWall presentations. Use the
 button to view the  list.Current Active BrightWall™ Groups
Name: The name of the BrightWall Configuration file

Creation date: The date that the BrightWall Configuration file was created in BrightAuthor

Right-click a configuration file to perform an action:

Delete: Removes the BrightWall Configuration file from your BrightSign Network account. This action cannot be performed if a BrightWall
presentation that uses the configuration file is currently assigned to a BrightWall group.

Download: Downloads the BrightWall Configuration file to the specified folder. 

Library
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The  section allows you to see all content files (images, audio, video) that have been uploaded to your BrightSign Network account. FilesLibrary
with a green check mark are currently active. You can perform any of the following actions:

Switch between thumbnail and list views: Click the icons in the upper-right portion of the screen.

Refresh the library: Click the   button in the upper-right portion of the screen.Refresh
View item info: Right-click a file and click . Here you can view the file size, type, date modified, and date uploaded, as well as allInfo
presentations and all Dynamic Playlists using the file.

Delete an item: Right-click a file and click . Keep in mind that you can only delete files that aren’t currently active.Delete
Edit Media Tags: Right-click a file and click  to add or remove media tags from that media item. You can switch betweenEdit Tags 
editing   and  tags:System User 

System tags have values that are defined by the BrightSign Network (such as the media file size and upload date); you cannot
edit the title or value of these tags.

User tags have customizable titles and text values. 

Copy Media Tags: Right-click a file and click  . Select one or more target media files for copying and click  . This will copyCopy Tags Save
all tags that are associated with the original file; it will also overwrite any tags associated with the target media file(s).

 

Note
Currently, the only way to upload a BrightWall Configuration file to BSN is to upload a BrightWall presentation that uses the
configuration file.

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting


Live Data Feed
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The  tab allows you to view all Live Data Feeds on your BrightSign Network account, as well as the presentations that containLive Data Feed
Live Data Feeds and the time/date when they were last modified. Live Data Feeds with a green checkmark are currently part of a presentation.
You can perform any of the following actions:

Delete a feed: Right-click a Live Data Feed and select .Delete
Download a feed: Right-click a Live Data Feed and select . Choose a save destination for the data-feed file and click Download .xml Sav

.e
View info: Right-click a Live Data Feed and select . A window will display when the Live Data Feed was last modified, along with a listInfo
of all presentations that contain the Live Data Feed.

Sort the list: Click the column you want to use as the sort criteria. For example, click the  column to sort by name, then click it againName
to switch between ascending and descending order.

Refresh the list: Click the button in the upper-right portion of the screen.Refresh 
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Dynamic Playlist
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The  tab allows you to view all Dynamic Playlists on your BrightSign Network account, as well as the presentations that containDynamic Playlist
Dynamic Playlists and the time/date when they were last modified. Dynamic Playlists with a green checkmark are currently part of a presentation.
You can perform any of the following actions:

Delete a playlist: Right-click a Dynamic Playlist and then select .Delete
View info: Right-click a Dynamic Playlist and then click . A window will display when the Dynamic Playlist was last modified, alongInfo
with a list of all presentations that contain the Dynamic Playlist.

Sort the list: Click the column you want to use as the sort criteria. For example, click the  column to sort by name, then click it againName
to switch between ascending and descending order.

Refresh the list: Click the  button in the upper-right portion of the screen.Refresh
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HTML Site
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The  section allows you to view all HTML sites that have been uploaded to your BrightSign Network account, as well as the HTML Site
presentations that contain the sites and the time/date when they were last modified. HTML sites with a green checkmark are currently part of a
presentation. You can perform any of the following actions:

Delete a site: Right-click an HTML site and select .Delete
View site info: Right-click an HTML site and select . A window will display when the site was last modified, as well as a list of allInfo
presentations that contain the site.

Sort the list: Click the column you want to use as the sort criteria. For example, click the  column to sort by name, then click it againName
to switch between ascending and descending order.

Refresh the list: Click the  button in the upper-right portion of the screen.Refresh

 

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
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Local Network
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The section allows you to perform a number of remote operations on players located on your local network. If Bonjour has beenLocal Network 
installed on your PC and enabled in the  tab, then players set up for Local File Networking will be discoveredEdit > Preferences > Networking
automatically (see  for more details). If Bonjour is not enabled, you can populate the list of players by clicking the  buttonthis FAQ Add BrightSign
in the bottom left and entering the IP address of the player.

 

To perform an operation, select a player from the list (or select multiple players by holding down ) and right-click the selection:Shift

View Remote Snapshots: Opens a window that allows you to view Remote Snapshot images taken by the player. When the window
opens, the latest snapshot will be displayed. Past snapshots are displayed as thumbnails below. Double click a snapshot thumbnail to
view it as a full size image. The number, quality, and frequency of snapshots is determined during the  process.Unit Setup

Refresh: Click this button to get the most up-to-date snapshot(s) from the player.

Date/Time: The timestamp indicating when the snapshot was taken. The timestamp is formatted as follows: yyyy:mm:dd hh:mm:ss

Serial Number: The serial number of the player taking the snapshot.

Model: The model number of the player taking the snapshot.

Firmware: The firmware version of the player taking the snapshot.

Remove Unit(s): Removes one or more players from the Local Network list. This action only affects the BrightAuthor UI; it does not
change the settings of players in any way.

Show All Units: Adds back all players that have been removed from the list using the  command.Remove Unit(s)
Info: Displays information about the selected player, including the  (i.e. serial number), , , ,Unit ID IP address Model Firmware version

Note
If you do not know the IP address of your player, you can obtain it by powering up the player without an SD card inserted: The IP
address, along with other information about the unit, will be displayed on screen once the unit boots.

Note
The Remote Snapshot feature is not available for the LS422, HD220, or HD1020.

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
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1.  

2.  

3.  

4.  

and .Autorun version
Specify User Name / Password: Attempts to access the player to obtain further information about it. This action should be used when
the player  is listed as "Access to [player IP address] denied".Name
Access Diagnostic Web Server: Opens a web browser window or tab to access the player .Diagnostic Web Server

Access Device Web Page: Opens a web browser window or tab to access the player Device Web Page (i.e. ). Local Web Server

 

Using Advanced Tools
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Setup USB Drive

Update Autorun

Unit Control

Advanced tools (accessible by navigating to Tools > Advanced) let you remotely control units on your BrightSign Network account or set up a
USB flash drive to retrieve device data and perform device actions. The Advanced Tools window is divided into three tabs: the Setup USB Drive
tab, as well as the Update Autorun and Unit Control tabs, which are only available if you have a BrightSign Network account.

Setup USB Drive

The tab allows you to configure a USB flash drive to extract data or perform specified actions (e.g. reboot the player) on aSetup USB Drive 
BrightSign player. The following checkboxes determine what actions will occur when the USB flash drive is inserted into the player:

Copy variables database: Extracts the data for all  and Media Counters.User Variables

Copy log files: Extracts all log files.

Delete log files: Deletes all log files on the BrightSign player.

Reset Variables: Resets all  to their default values.User Variables

Reboot: Reboots the BrightSign player.

Display status on screen during data capture: Displays the status of the above actions on the display while the USB flash drive is
inserted into the BrightSign player.

 

Once you've selected the desired USB actions, follow these steps to carry them out:

Click  and navigate to the location of the USB flash drive on your computer. Click .Setup drive OK
When the  window opens, click .Setup Complete OK
Remove the USB flash drive from your computer and insert it in the player.

If you are extracting data from the player, reinsert the USB flash drive into your computer to retrieve the data.

Update Autorun

Use the  tab to update the Autorun on players linked to your BrightSign Network account. Check the boxes corresponding to theUpdate Autorun
groups you wish to update. Then click  to update the Autorun version for players in the group(s).Update now

See this FAQ to learn how to distribute custom Autorun scripts using the BrightSign Network.

Note
You can retrieve data from multiple players using a single USB flash drive. The filename of each variable, media counter, and log
record will include the serial number of the applicable player, so the number of unique player records you can put on a USB flash drive
is limited only by storage space.

http://docs.brightsign.biz/display/DOC/Diagnostic+Web+Server
http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
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a.  

b.  

c.  

d.  

3.  

Unit Control

Use the tab to send commands to players linked to your BrightSign Network account.Unit Control 

In the field, type the serial number of the player you want to control.Serial Number 
Click the dropdown list to select the action you want the player to perform.Action 

Reboot unit: Restarts the player.

Upload logs: Uploads the current log files on the player (based on the Logging settings selected when setting up the unit.). Log
files can then be retrieved in the BrightSign Network WebUI.

Recover – reformat: Puts the player into recovery mode and reformats its storage device.

Recover – don’t reformat: Puts the player into recovery mode and downloads the latest Autorun script to the storage card
without reformatting it.

Click the  button to have the player perform the action the next time it checks in with the BSN servers. Add action

You can add multiple actions to a single player. You can also use the  button to cancel an action before the next check-in.Remove action

 

Using the Diagnostic and Local Web Servers
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The  gives you the ability to perform various system functions—such as rebooting the player, changing display settings,Diagnostic Web Server
and retrieving log files—from a web browser.

The Local Web Server is necessary for Local File Networking. It also gives you access to the User Variables webpage, which allows you to modify
User Variables using a web browser or the BrightSign App. Both features are enabled during the  process.player setup

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
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1.  

2.  

3.  

4.  

5.  

Follow these steps to connect to the Diagnostic Web Server and User Variables webpage using a web browser: Note that your PC or mobile
device must be connected to the same local network as the BrightSign player.

Power off the BrightSign player.

Remove the SD card and USB drive (if applicable).

Power on the player and wait several minutes. The IP address of the player, along with the serial number and firmware version, will
appear on the display.

To access the Diagnostic Web Server, enter the displayed IP address into the address bar of the browser on your PC or mobile device
(for example, “10.0.1.199”). To access the User Variables web page, enter the displayed IP address plus port 8008 (for example,
“10.0.1.199:8008”).

Enter your user name and password (if applicable).

Frequently Asked Questions
BrightAuthor Version 4.6

Version 4.4

Previous Versions 

For additional Frequently Asked Questions, visit the  website.BrightSign Support

Can I use BrightAuthor 4.0 or later with the HD210, HD410, HD810, HD1010, HD1010w, or TD1012?

No, these legacy models are only supported by BrightAuthor versions 3.8 and earlier.

Can I open the autoplay.xml file using BrightAuthor?

No. The autoplay.xml file that is generated when you publish a presentation is a playlist file. This file includes only the information required for
playback on a BrightSign player. It is not the same as a presentation project file.

How do I use a different font?

To use a different font, browse to a folder on your computer that has a true type font (e.g. in a Ticker zone, click , and then click Zone Properties
 beside font). This font will be copied to the SD card when you publish the presentation. You can use your own custom fonts or downloadBrowse

free TrueType fonts from the web.

Can I export a template?

Yes. Although there isn’t a template export option, you can save a presentation project with the desired template layout, and then transfer it to
another computer. You can then open the project in BrightAuthor, and then save the template ( > ).Layout Save Template

Why does BrightAuthor take a long time to process my folder?

If the folder you selected has a large number of images and videos, the Media Library may take a few minutes to update. Please be patient.

Why can’t BrightAuthor locate my files when I try to publish my presentation?

If you copy a presentation project from one computer to another, or move or rename files used in a BrightAuthor project, BrightAuthor cannot
locate the files, and you will receive an error message when you try to publish. To resolve the error, you must remove the files from each zone’s
playlist in the presentation and then add them again.

Why are some of my videos missing thumbnails in the Files tab?

The thumbnails are generated by codecs installed on your computer. You can download codecs to resolve the problem. For example, if you’re
missing thumbnails for your transport streams, you can try downloading a codec such as K-Lite.

What do I do if BrightAuthor crashes while I’m using it?

For any errors or crashes you encounter while using BrightAuthor, please post a description of the problem in the forums (http://support.brightsign
) or send us an email at  and include the following information:.biz/hc/en-us/community/topics support@brightsign.biz

Steps to duplicate the problem (or indicate that you can’t duplicate it)

Any error dialogs you saw, including text in the dialog

The contents of your event log right after the crash. You can find the log in this folder:
C:\Users\Owner\AppData\Local\BrightSign\BrightAuthor\

Look for a subfolder named after the BrightAuthor version number, such as 2.4.0.

A copy of the presentation project where you experienced the problem

http://docs.brightsign.biz/display/BA44/4.4-BrightAuthor
http://support.brightsign.biz/entries/314526-brightsign-user-guides-troubleshooting
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